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ABSTRACT 

Bitemark evidence is routinely accepted in the judicial system, but wi th recent 

Uni ted States court rulings such as Daubert and Kubmo an emphasis has been 

placed o n establishing the validity and reliability o f current scientific techniques. 

The current study compares the reliability o f two popular methods used to 

produce computer-generated bitemark overlays. Images o f twelve dental casts 

were sent to thirty examiners. Examiners were instructed to produce an overlay 

for each cast image based o n the instructions provided for the two techniques. 

After the overlays were submitted, measurements o f the area o f the biting edge 

and the x-y coordinate o f each tooth's position were obtained. The reliability 

assessment o f the measurements was performed using an analysis o f variance and 

calculation o f reliability coefficients. 

The analysis o f variance results showed that the forensic experience level o f the 

examiner and the cast variations all contribute to a significant effect i n the 

variances seen for the area for both techniques. The inter- and mtira-examiner 

reliability coefficients are low. 

The results for the positional measurements showed the forensic experience level 

o f the examiner contributes no significant differences to the variances. The 

differences are seen within the cast variations. The inter- and intra-examiner 
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reliability coefficients are exceptionally high. It was concluded that both 

techniques were reliable methods to produce bitemark overlays to assess tooth 

position. 
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"You can lead a jury to the truth but you can't 
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Chapter One - Introduction 

1.1 F O R E N S I C O D O N T O L O G Y 

F r o m infancy to o ld age, the teeth serve a multitude o f functions. E a c h tooth 

provides a unique contribution from the mechanical digestion o f food to the 

proper phonetic enunciations. In addition to the functionality o f daily routines, 

teeth play a significant role i n the identification o f individuals. M o s t often utilized 

i n a medico-legal context, identifying individuals based upon their dental 

uniqueness is the foundation upon which the discipline o f forensic odontology is 

established. 

Forensic odontology can be thought o f as the interdisciplinary approach between 

dentistry and the criminal and civil justice system. The terms "forensic 

odontology" and "forensic dentistry" are interchangeable. Forensic dentistry 

encompasses a diverse range o f subjects, wh ich include comparative dental 

identification, mass disaster management, human abuse and neglect, dental 

jurisprudence issues, and bitemark analysis (1). The beginriings o f forensic 

dentistry date back nine hundred years to England where K i n g Wi l l i am secured 

the authenticity o f royal documents by affixing to them a piece o f wax that bore 

his bite impression (2). The acceptance o f an individual's dental uniqueness 

continued to prove advantageous throughout the years. In 1775, Paul Revere as a 

silversmith and dentist, constructed a silver and ivory bridge to replace missing 
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Chapter One - Introduction 

teeth for D r . Joseph Warren. It was the distinctive nature and manufacturing o f 

this bridge that ultimately led to the identification o f Warren's body following the 

Battle o f Bunker H i l l (3). Additionally, the unique teeth impressions that are left 

behind after an individual bites an object or person are noted i n several historical 

cases. O n e case involving bitemark testimony was discovered to have taken place 

as far back as 1870. The case o f Ohio v. Robinson involved a murder i n which a 

bitemark was found on the victim's arm (4). Al though compelling bitemark 

evidence was presented and accepted by the judge, the accused was acquitted o f 

the charges due to reasonable doubt brought forth by the defense o f a possible 

alternative perpetrator. However , this case helped forge an introduction to 

forensic dental evidence and the eventual acceptance w id i i n the legal system. 

Today, a variety o f organizations exist that are dedicated to the development and 

advancement o f forensic odontology. In N o r t h America , these include the 

American Academy o f Forensic Sciences ( A A F S ) , which has a prominent 

odontology section, the Amer ican Board o f Forensic Odontology ( A B F O ) , which 

aids i n the development o f g^delines and standards as wel l as oversees voluntary 

certification examinations o f specialty status, and the Amer ican Society o f 

Forensic Odontology ( A S F O ) , whose members include a variety o f professionals 

that engage i n and expand the causes o f forensic dentistry (5). It is through these 

organizations that forensic dentistry continues to thrive and progress as a science. 
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Chapter One - Introduction 

As with any discipline, a continued commitment to improving and advancing the 

domain is critical. This is accomplished through research, evaluation, and critical 

review of current and emerging techniques. With technologies advancing and 

evidentiary laws continually challenged, forensic dentistry is not without 

controversy. The most contentious issue involves human bitemarks. Whether 

the focus is on bitemark detection or dynamics, the methodologies used in 

analysis, or the evidentiary value of an injury, the topic of bitemarks continues to 

fuel heated debates. 

1.2 BITEMARKS 

The term bitemark refers to "a physical alteration in a medium caused by the 

contact of teeth" (6). These marks can be left on objects, food, or skin and 

produced by humans or animals. Widiin the context of this Introduction, the 

term bitemark will refer to a human bitemark left on human skin, as is most often 

the circumstance in actual forensic casework. 

1.2.1 Recognition 

The first step in forensic casework is the recognition of a patterned injury found 

on the skin as a human bitemark. Often the first individual to recognize a 
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Chapter One - Introduction 

patterned injury on a deceased vic t im is an individual other than a forensic 

odontologist, such as a police officer or medical examiner. In the case o f a l iving 

vict im, a sexual assault examiner or emergency r o o m personnel may initially 

recognize the patterned injury. Al though skilled i n their o w n respective 

disciplines, unfortunately without proper teaming i n bitemark recognition many 

bitemarks go undetected each year due to the inability o f the first responders to 

recognize the injury as a bitemark. Proper instruction o f auxiliary personnel and 

greater availability o f forensic dental consultations are, thus, essential i n 

facilitating more accurate and complete recognition o f bite injuries. 

1.2.1.1 Physical Characteristics 

W h e n a hard object contacts a softer object and leaves an impression, this is a 

toolmark. Forensic toolmark analysis includes a vast array o f different 

investigations o f such impressions, such as ballistic matching, tire track 

identification, and the identification o f specific knives to particular crimes. The 

science o f bitemark analysis may be thought o f as another form o f a toolmark 

investigation. In this case, the tooth or teeth act as the harder object and leave 

their corresponding impression on the skin. W h e n an analysis follows this 

approach, levels o f distinguishing characteristics can begin to be documented. 

These characteristics are divided into gross, class, and individual characteristics. 
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Figure 1. A human bitemark 

Chapter One - Introduction 

Figure 1 illustrates a typical human bitemark. According to the ABFO Guidelines 

and Standards (6), the descnption of the prototypical human bitemark is as 

follows: 

"...a circular or oval patterned injury consisting of two opposing (facing) 
symmetrical, U-shaped arches separated at their bases by open spaces, 
holloaing the periphery of the arches, are a series of individual abrasions, 
contusions and/'or lacerations reflecting the si-^e, shape, arrangement and 
distribution of the class characteristics of the contacting surfaces of the human 
dentition." 
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Chapter One - Introduction 

Using this definition as a reference, an explanation of the appearance of 

bitemarks will be described with respect to the different levels of toolmark 

characteristics. 

1.2.1.1.1 Gross Characteristics 

Gross characteristics are used to identify the general source of the tool (7). A 

common example is a footwear impression found in the sand. An initial 

assessment of the gross characteristics could reveal that the impression came 

from a shoe. For example, it is determined to be from a running shoe rather than 

a woman's heel. The scope of the search to find the shoe that made the imprint 

may now be narrowed to all running shoes. Al l other shoes can be excluded as 

the cause. 

This same concept may be applied in bitemark recognition. When first assessing 

a patterned injury the question "Is this a bitemark?" must be answered. In Figure 

2, a typical bitemark will have a circular or elliptical pattern with a diameter of 2.5 

- 4.0 cm, exhibiting several small lacerations (shown by the yellow arrows), and 

often show a central area of bruising (6,7). These are the gross characteristics that 

will support the conclusion that the injury is a bitemark and not from some other 

source. 
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Chapter One - Introduction 

Figure 2. Human bitemark illustrating gross characteristics 

1.2.1.1.2 Class Characteristics 

Class characteristics are measurable features of a toolmark that indicate a 

restricted origin (7). Continuing with the shoe print example, if it can be 

determined that the mark came from a size ten men's Reebok® running shoe, 

then the population of running shoes that could have caused this impression has 

been immediately reduced. This may now redirect the investigation to consider 
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Chapter One - Introduction 

the dimensions, specific tread markings, and distinct features that R e e b o k ® 

places w i l i i i n the sole o f its size ten men's running shoes. 

In bitemark analysis typical class characteristics are the shape, location, number, 

and dimensions o f the teeth (6,7). F o r instance, a human bitemark can be 

distinguished from an animal bitemark based on the placement o f the teeth i n 

each arch and whether the teeth involved follow the normal biological formula 

for the human dentition. The biological formula is defined as teeth per quadrant. 

This translates to two incisors, one canine, two premolars, and three molars i n 

humans. In human bitemarks, the biting edges o f the anterior teeth are the 

port ion o f the dentition most often seen i n the bite injury. Therefore, the focus is 

predominandy o n the incisors and canines wi th the occasional marking o f the 

premolars. Figure 3 depicts a bitemark showing some typical class characteristics. 

The blue circle highlights two cusp marks typically seen i n a maxillary premolar, 

the yellow circle highlights the rectangular tooth mark seen i n maxillary incisors, 

and the green circle highlights the rectangular tooth mark seen i n mandibular 

incisors. 

10 



Chapter One - Introduction 

Figure 3. Human bitemark illustrating class characteristics 

Furthermore, an adult human bitemark would have a measurable difference in 

width when compared to a child's bitemark. The typical inter canine distances for 

adults and children have been published and may be used as references (8). 

1.2.1.1.3 Individual Characteristics 

Individual or accidental characteristics are imperfections or irregularities present 

in the toolrnark that are caused by use, misuse, or damage to the tool (7). The 

worn edge of the sole and a cut or nick in a specific portion of the sole would 

demonstrate individual characteristics that could differentiate John Smith's size 
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Chapter One - Introduction 

ten Reebok® running shoe from all other mnning shoes of the same make and 

size. 

In bitemark analysis, it is these individual characteristics that make it possible to 

distinguish one biter from another. Examples of individual characteristics include 

the specific dimensions, rotations, fractures, attritional wear patterns, and spacing 

of the teeth (6,7). These features form the foundation upon which each person's 

dental uniqueness is based. The more prominent the individual characteristics are 

recorded in a bite injury, the greater the chance of identifying the biter. Figure 4 

illustrates a bitemark with individual characteristics (9). Each coloured arrow 

indicates an area where the teeth are crowded or overlapped resulting in a distinct 

pattern of tooth marks. 
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Chapter One - Introduction 

Figure 4. Simulated bitemark illustrating individual charactenstics 

1 "1 
. 1 1 h 1 

1 

1.2.1.2 Variable Features 

Advocates and opponents of bitemark evidence begin to disagree on the limits of 

the possible evidentiary value of the evidence. Biting is a dynamic process. The 

results of an inflicted bite will depend upon a variety of factors. Three critical 

factors include: a) the biting forces involved, b) location of the bitemark injury, 

and c) the response of human skin to biting injuries. 
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Chapter One - Introduction 

1.2.1.2.1 Biting Forces 

A bitemark results when teeth come together with force upon the skin. The 

degree of force can influence the resulting patterned injury. Research into the 

mechanical forces in biting began in 1974 by Barbenel and Evans, and questions 

on the dynamics of biting remain unanswered. This early study showed that in 

addition to a biting force produced by the teeth, a combined sucking and tongue 

thmsting force also exists which produces a central ecchymosis (10). The 

outcome is also affected by the manner and extent to which the sucking force is 

applied. If the skin is held in place by the contact of the teeth and a sucking 

action is applied afterwards, the injury would appear differendy than if the suction 

had been applied before the bite was made. In either case, a distincdy different 

injury occurs (10). 

In addition to the amount of force and suction applied, the bitemark can give 

clues as to how it was inflicted. A static mark occurs when individual teeth marks 

leave a distinct impression in the skin. In this case, little movement is involved at 

the time of the bite. Conversely, if the teeth appear to have been dragged across 

the skin resulting in scratches or abrasions, this can be classified as a striated 

mark. A striated mark indicates the victim or suspect was moving during the 
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Chapter One - Introduction 

biting. Figure 5 illustrates the difference in appearance between striated and static 

marks. 

Figure 5. Difference between striated (yellow arrows) and static (blue arrows) 
bite injuries. 

Jakobsen and Keiser-Nielson described in depth the implications of how the 

evidence left behind when a bite injury occurs could reveal how the bite was 

originally inflicted. For example, factors such as skin thickness when gripped 

within the teeth, the stretching of the skin's surface, and the position of the body 

may uniquely define a bitemark injury (11). 

Finally, forces from the injury cause changes to occur within the skin as healing 

begins. Leakage of blood cells and serum into the dermal regions can cause 

either bruising or blistering subsequently to occur and this may change the colour 

or distention of the tissue (12). Not only will this affect the appearance of the 
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Chapter One - Introduction 

injury', but also the dimensional changes that may occur as the injury changes with 

time. Soon after a bite is inflicted on the skin, the area will become edematous 

and stiffer than the surrounding tissues (10). This change can lead to a distorted 

appearance and only after the tissues are resorbed over a period of days will this 

effect be reduced. ITierefore, proper evidence collection should include 

immediate photographic documentation and additional documentation of 

changes that occur over consecutive days. 

1.2.1.2.2 Location 

Bitemarks often occur in the most heinous crimes and in almost all anatomical 

locations. Notable trends exist in the location where bitemarks are found. Table 

1 shows the anatomical locations of bitemarks and their frequency of occurrence 

in a representative sample of 101 United States cases (13). 

Table 1. Anatomical distribution of bitemark locations found in 101 U.S. cases 

Anatomical Percentaj re of bites 
Location Females Males 
Abdomen 2.8 0.0 

Arms 13.0 63.6 
Back 7.5 9.1 
Breast 40.0 0.0 

Face or Head 6.6 0.0 
Foot 0.0 0.0 

Genitals 6.6 0.0 
Hands or Fingers 3.8 18.2 

Legs 7.5 0.0 
Neck 6.6 0.0 

Shoulder 0.0 9.1 
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Chapter One - Introduction 

T w o studies note that when a vic t im is found wi th a bitemark, a high probability 

exists that additional bitemarks wi l l also be found (13,14). Pretty and Sweet (13) 

citied over 70% o f bitemark cases that involved injury to the breast also had 

additional bitemarks to the genitalia, neck, face, and head. This evidence 

supports the need for a thorough examination o f the vic t im for multiple injuries. 

Interestingly, proper investigation also searches for injuries on the perpetrator's 

body. Table 1 shows that males are most likely to be bitten o n their arms, hands, 

and shoulders. These wounds usually result from the victim's attempt to fend of f 

the attack. It is believed that a greater number o f defensive bites are actually 

inflicted on aggressors than attack bites on victims, and a call for all suspects to 

be examined immediately upon apprehension for tooth marks is recommended 

(11). 

1.2.1.2.3 Human Skin as a Substrate 

Paramount to the quality o f the bite evidence is the ability o f the underlying skin 

to record the bite injury. Skin is a poor substrate to register an impressed mark 

(15). The highly visco-elastic nature o f skin allows stretching to occur during the 

biting process or when the evidence is collected (16). Furthermore, each 

anatomical location exhibits varying underlying musculature curvature, and 
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adherence o f the skin to the underlying tissue, which can alter the skin's response 

(16,17). 

Research into this challenging issue has been limited because o f the ethical 

concerns wi th the generation o f bitemarks on l iving victims. D e V o r e attempted 

to analyze differences by utilizing a printing mould o f concentric circles and inked 

simulated bitemarks on varying locations o f a volunteer's body while 

photographically documenting the evidence. W h e n the participant changed 

positions and the injuries were re-photographed, the sites showed significant 

differences (18). This same type o f experiment was undertaken within the 

analysis o f an actual case. In this instance, the victim's own skin was used as a 

template as wel l as an anatomically similar volunteer. It was concluded that using 

a substrate similar in consistency and elasticity to the substrate the bitemark was 

found o n is crucial to the successful duplication o f the wound pattern for 

comparison (19). 

1.2.1.3 Forensic Significance of Bitemarks 

Taking into consideration all o f the variables involved i n bitemark analysis, it is 

the individual odontologist and the legal system that determine the forensic 
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significance o f the evidence based upon the quality o f the bitemark, the collection 

o f the evidence, and current evidentiary admissibility standards. 

1.2.1.3.1 Value of Evidence 

E a c h case presents its own unique set o f elements. Indication o f a bitemark 

injury may provide a lead towards other potential evidence. F o r example, it may 

establish a timeline o f repeated abuse (20), link a suspect to a v ic t im or crime 

scene (21,22,23), or even exemplify the violent nature o f an act (24,25). The 

odontologist determines evidential value and then chooses the appropriate 

analysis method. Bitemark evidence may be analyzed with physical, biological, 

and psychological components. 

1.2.1.3.1.1 Physical Evidence 

The recognition o f a patterned injury o n the skin is considered physical evidence 

of a crime. Witr i in a legal context, physical evidence is an example o f 

circumstantial evidence. Physical evidence and its presence not only provides 

useful information to the investigators, but directs the focus o f the investigation 

as well. A s each bitemark is unique i n appearance, a classification system was 

developed by the Northwestern University Dental School i n Chicago, I L to help 
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distinguish the degrees of injury. This classification is shown in Table 2. If more 

than one class of injury is present in the same bitemark, the overall classification 

is based upon the most severe damage recorded. 

Table 2. Northwestern University Dental School's bitemark classification system 

Bitemark Classification Physical Description 

Class I Erythema 
Class II Contusion 
Class III Abrasion 
Class IV Laceration 
Class V Avulsion 

Advancing this classification, Sheasby and MacDonald have attempted to 

establish a classification based upon the probable distortion found in bite injuries 

(26). Primary distortion includes any distortion that may occur at the time of 

biting. This takes into account the dynamics involved at the time of biting and 

also the underlying tissue effects that have been previously discussed. Secondary 

distortion involves the distortion that occurs from the time the bite wTas inflicted 

to the time it had been examined. I lere, variables such as time-related effects, 

postural differences, and photographic distortion may be important 

considerations (26). 
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Physical evidence provides the means to complete comparisons between a 

suspect and the bite injury. T w o specific comparisons, "metric" and "pattern 

association" wi l l be discussed further in a subsequent section. 

1.2.1.3.1.2 Biological Evidence 

The admissibility o f D N A evidence has underscored the importance o f also 

collecting saliva that is deposited during the bite. W i t h sophisticated techniques 

such as the polymerase chain reaction a small amount o f saliva is all that is 

necessary to yield a D N A profile o f a saliva contributor. Salivary evidence can be 

collected from skin, foodstuff, or other objects that may have been bitten at the 

crime scene to identify the biter. Retrieval o f D N A evidence from bitemarks has 

also successfully l inked suspects to their crime scenes (27,28). The double swab 

technique, developed by Sweet, is the preferred technique for the collection o f 

salivary D N A evidence (29). 

1.2.1.3.1.3 Psychological Evidence 

The use o f criminal profiling to attempt to identify violent offenders is widely 

used. The desire to understand motivations behind deviant behaviours is 

applicable to bite attacks. Few researchers have explored the not ion that there 
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are characteristics that are c o m m o n to all biters, and a review o f the literature 

drew attention to the need to investigate this area further (30). L imi ted studies 

were conducted by Walter, a psychologist, who categorizes biters into three 

distinct groups: 1) anger-impulsive biters, 2) sadistic biters, and 3) ego-

cannibalistic biters (31,32). 

Case reports o f convicted offenders who bite include results o f psychological 

testing that show greater tendencies toward oral sadistic behaviours (33). Injury 

assessment has shown that different types o f bites exhibit variations, wh ich may 

provide insight into the biter's state o f mind. Variations may exist as quick or 

haphazard bites as though made i n self-defense. In contrast, a sadist bites his 

victims slowly and intentionally, and renders well-defined tooth marks (34). It 

should be cautioned that an odontologist who begins to testify i n court about the 

psychological nature o f the suspect is opening up the door for criticism by 

commenting upon subject matters beyond their training and expertise'. 

1.2.1.3.2 Collection of Evidence 

A n evidence collection protocol is essential to any crime scene investigation. 

Without a specific protocol, the chance o f introducing error and affecting the 

analysis is high. F o r bitemark casework, the collection o f the physical evidence is 
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the primary focus. T w o studies determined that a significant number o f vic t im 

photographs and suspect exemplars were collected by individuals other than the 

investigating odontologist (35,36). This deviates from the suggested guidelines 

for bitemark evidence collection. 

1.2.1.3.2.1 American Board of Forensic Odontology Guidelines 

Listed i n Table 3 is a compilation o f the A B F O guidelines for v ic t im and suspect 

evidence collection (6). The A B F O recommends these guidelines be used i n 

conjunction with additional methods o f documentation as required. Deviat ion 

from these generally accepted guidelines requires justification and accountability. 
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Table 3. ABFO guidelines for victim and suspect evidence collection 

VICTIM EVIDENCE GUIDELINES SUSPECT EVIDENCE GUIDELINES 
• Photography 

Orientation and close-up photographs should be 
obtained with and without the presence of a scale 
placed adjacent to the bitemark. The scale must be 
positioned within the same plane as the bitemark and 
should include a linear and circular reference to aid in 
eliminating possible distortion. The film resolution 
should be high quality with proper color balance. 
Serial photographs are recommended in living victims. 

• Clinical Examination 
Extraoral examination should include recording hard 
tissue factors that may influence biting dynamics such 
as TMJ and muscle tone. Measurements of maximum 
mouth opening should be obtained. 
Intraoral examination should include documentation 
of tongue size and function, the periodontal condition 
and mobility of the teeth and a full dental history. 

• Salivary Swabbing 
Saliva swabs should be collected in circumstances in 
which the bite site area has not been altered from the 
time when the bite was inflicted. 

• Photography 
Extraoral and intraoral photographs should be taken 
including frontal views, lateral views and occlusal 
views. 

• Impressions 
Impressions of the bite site area should be taken when 
there is sufficient surface detail which may yield 
beneficial information. The material used must meet 
the American Dental Association specifications and 
suitable support should be included for proper support 
and reproducibility of the body site contour. 

• Impressions 
At least two dental impressions should be taken of 
each arch using recommended American Dental 
Association specifications and properly prepared. The 
interocclusal record should be recorded. 

• Tissue Samples 
Tissue samples should be retained if it appears they 
may yield useful information. 

• Study Cast and Bites 
Master casts should be prepared with American Dental 
Associations approved Type II dental stone. 
Additional casts should be fabricated for special 
studies. Sample bites should be made in an 
appropriate material simulating the bite. 

1.2.1.3.2.2 Victim Evidence Collection 

A critical investigation of bite injuries begins with proper photographic 

documentation. A review of forensic photography protocols urges examiners to 

maintain records of the why, where, how, when, and under what circumstances 

24 



Chapter One - Introduction 

the photograph was taken as wel l as an awareness o f the rules, procedures, and 

laws regarding photographic evidence according to the jurisdiction o f the local 

court (37). 

The A B F O recommends that the photographs should be taken by conventional 

film photography, utilizing off-angle lighting and containing a rigid reference scale 

(6). G i v e n that a part o f the analysis is based upon a metric comparison, the 

importance o f a proper reference scale cannot be overstated. The possibility o f 

introducing perspective distortion i n bitemark photographs is extremely high i f a 

proper scale is not used and the angle o f the camera to the substrate is not 

controlled (38). The presence o f a scale is also very important to produce 

enlargements o f the bitemark at known sizes. F o r example, life-size (100%), 

200% or 300%. 

The A B F O developed an L-shaped reference scale that has widespread use i n the 

documentation o f forensic evidence. Figure 6 illustrates the various features that 

make up the A B F O N o . 2 reference scale. These features include the rigid design 

for horizontal and vertical measurements, three circles located i n the corners to 

aid i n rectification o f angular distortion, and the 18% gray areas for proper colour 

matching o f exposure. 
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Figure 6. A B F O N o . 2 reference scale 

A study analyzing the A B F O N o . 2 ruler showed an overall accuracy to + / - 0.01 

m m or 1% for the major centimeter graduations (39). 

Additionally, three considerations are necessary when the scale is placed adjacent 

to the bitemark and then photographed (39): 

"•••(1) the required portion of the bitemark and the entire 
widths of the legs of the scale should be well within the camera's fields of view, 
(2) the film plane should be closely parallel to the plane of the scale and (3) 
the camera should be firmly mounted, not only to facilitate meeting the above 
conditions, but also to avoid any camera movement during exposure and 
between successive exposures." 

Addi t ional photographic studies (40,41) supported these recommendations. 
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In addition to conventional film techniques, odontologists have explored the 

possibilities of using alternative lighting sources. The use of ultraviolet (UV) and 

infrared (IR) light are well accepted in forensic science, and show the most 

promise in the capture of a bitemark image. Wright, in 1998, proposed the use of 

colour, black and white, UV, and IR photography to obtain the most evidentiary' 

value from a bite injury (42,43). I lc concluded that by using these four 

photographic techniques, the injury can be captured in three distinct planes of 

reference: highlighted surface detail (UV), detail below the surface of the skin 

(IR), and detail readily seen with the eye captured in both black and white and 

colour (43). Figure 7 demonstrates the differences obtained using UV and IR 

photographic techniques on the same bitemark injury (43). 

Figure 7. Examples of bitemark photographs using alternative lighting sources 

An impression of the bite site proves useful when there are distinct indentations 

left within the injury or there has been disruption of the skin's surface integrity. 
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The most c o m m o n method to obtain a bite site impression includes a highly 

accurate dental impression material such as v inyl polysiloxane supplemented wi th 

a rigid backing (35). The backing is molded to the surface curvature o f the skin 

and the orientation with respect to the position on the body is noted. This 

impression is used to produce a stone cast o f the bite site for diree-dimensional 

analysis. 

A t this time, an impression o f the victim's teeth may also be obtained i f the bite 

occurred i n a location that is accessible to the victim's mouth. This w i l l be 

helpful i n determining i f the bite was self-inflicted. 

The last i tem o f vic t im evidence is exclusive to the deceased individual. This is 

the excision o f the bite site. Several authors have developed techniques that are 

advocated for the excision and preservation o f excised tissue (44,45). Figure 8 

shows the steps involved i n the collection o f the tissue from one such technique. 
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Figure 8. Excision of a bitemark site 

• 

r 9 
A study by Rothwell examined the distortion of the preserved skin and concluded 

there is significant contraction and expansion in various bitemark specimens (15). 

Although controversial, some odontologists routinely excise the bite injury for 

use in transillumination analysis, histological studies, and tissue preservation. 

1.2.1.3.2.3 Suspect Evidence Collection 

Collection of evidence from a suspect needs to follow established legal guidelines. 

It is usually necessary to acquire a warrant for all procedures, and the procedures 

must be accomplished within a specified timeframe. At issue may be the 

cooperation of the suspect. If so, specific protocols will help expedite the 

process. 
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A thorough dental examination o f the suspect is the first step i n the collection o f 

the evidence (6). In addition, information about any dental treatments that were 

received by the suspect after the alleged bite attack are noted. Photographic 

records are collected and should include: extraoral photographs o f the full frontal 

view o f the face and intraoral photographs to document the front, left, and right 

views o f the teeth, the teeth i n centric occlusion, and the maxillary and 

mandibular occlusal views. 

The clinical examination collects data that is utilized i n the odontologist's 

assessment o f a suspect's ability to bite. Fo r example, data o n the maximum 

vertical opening, Temporomandibular joint function, tongue size, and periodontal 

status is helpful and wi l l tell a great deal about an individual's biting behaviour (6). 

Figure 9 shows the documentation o f a clinical examination o f a suspect. 

30 



Chapter One - Introduction 

Figure 9. Clinical examination of a bitemark suspect 

Collection of the dental impressions from each suspect are critical to the analysis 

and requires highly accurate methods. The ABFO recommends that two 

impressions be taken of each dental arch using impression materials approved by 

the American Dental Association (6). The impressions are used to produce stone 

dental casts, which facilitate comparisons to the injury. Additionally, the suspect 

is asked to bite into dental wax to provide a record of the interocclusal 

relationship (6). Figure 10 illustrates acceptable master dental casts and sample 

wax bite. 
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Figure 10. Suspect's dental cast and sample wax bite 

1.2.1.3.3 Bitemark Evidence in Court 

The goal of evidence collection is the generation of data, which becomes the 

basis for conclusions. An early case involving the use of bitemark evidence to 

convict a suspect occurred in 1906 in England where two men were arrested for 

burglary7. One of the suspects had bitten a piece of cheese at the crime scene and 

this pattern in the cheese matched the tooth marks of one of the suspects (46). 

Although the suspect ultimately confessed, this case was the first to admit 

bitemark evidence into the courtroom. 

1.2.1.3.4 Bitemark Evidence Admissibility Standards 

Acceptance of evidence by the courts requires that standards of admissibility be 

followed. Throughout the years, the court's use of scientific evidence has fallen 
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under scrutiny and specific doctrines against which the evidence is evaluated for 

acceptance have changed. 

Evidentiary challenges have been fought based on the Federal Rules of Evidence 

and the Frye 1, Dauber?, and Kuhmom standards, (47) which are summarized in Table 

4. 

Table 4. United States Scientific Evidence Admissibility Standards 

Frye Standard 
' (1923) 

Expert testimony be supported by scientific principles or evidence 
generally accepted by the relevant scientific or professional 
community. 

Federal Rules of 
Evidence 702 

(1991 Amendment) 

"If scientific, technical, or other specialized knowledge will assist the 
trier of fact to understand the evidence or to determine a fact in 
issue, a witness qualified as an expert by knowledge, skill, experience, 
training, or education, may testify thereto in the form of an opinion 
or otherwise". 

Daubert Standard 
(1993) 

Defines a four-prong test for determining the "evidentiary reliability" of a 
scientific theory or technique: 
1) Whether it "can be (and has been) tested"? 
2) Whether it has been "subjected to peer review and publication"? 
3) What is its "known or potential rate of error"? 
4) Its "widespread acceptance" which "can be an important factor in ruling 
particular evidence admissibility". 

Kuhmo Standard 
(1999) 

A trial judge must determine whether proposed expert testimony that "reflects 
scientific, technical or other specialized knowledge" has a "reliable basis in the 
knowledge and experience of [the relevant] discipline". 

' From Fryev. United States, 293 F. 1013, 1014, D.C. Cir. (1923) 

• From Daubert v. Merrett Dow Pharmaceuticals, 509 U.S. 579 (1993) 

• From Kuhmo Tire Co. v. Carmichael, 526 U.S. 137 (1999) 

33 



Chapter One - Introduction 

M o s t cases involving bitemark evidence have met these standards. A n extensive 

Hsting o f bitemark evidentiary issues may be found i n a collection o f 

comprehensive review articles (48-53). Al though most challenges by the accused 

to bitemark admissibility have been denied, the forensic dental community cannot 

assume that this w i l l always be so. A n adversarial legal system w i l l continue to 

encourage the discrediting or disapproval o f scientific testimony. A primary 

objective o f any discipline subjected to judicial scrutiny should be the active 

research and support o f the foundations and theories that uphold it. Bitemark 

analysis and forensic odontologists continue to try and meet this challenge. 
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1.3 THEORY OF BITEMARK COMPARISONS 

After evidence has been collected and a probative value established, bitemark 

analysis may begin. To understand the different approaches used in analysis the 

theory behind bitemark comparisons will be detailed. This theory is based upon 

the notion of each individual's dental uniqueness. The foundation of bitemark 

analysis lies in the following two premises: 1) each individual's dentition is 

presumed to be unique, and 2) this presumed uniqueness is accurately recorded in 

the characteristics of the injury on the skin (54). 

1.3.1 Uniqueness of the Human Dentition 

Dental uniqueness, especially the morphological and restorative traits and 

characteristics of the teeth, has been acknowledged by the legal community as an 

acceptable means in the positive identification of human remains. The ability to 

compare antemortem and postmortem radiographs of deceased individuals is 

widely accepted. This uniqueness is based upon differences in dental anatomy, 

restorative work, pathological conditions, and other distinguishing features that 

are distinctive to each dentition. 
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Though rarely contested for comparative identification, this uniqueness is not 

transferable to bitemark comparisons. The qualities that are represented in a 

bitemark show the three-dimensional characteristics o f the teeth. These 

characteristics may be able to include or exclude an individual as having been the 

cause o f a bite but authors caution odontologists i n making a positive 

identification o f an individual wi th the same degree o f certainty as a comparative 

identification o f found remains until further study o f the uniqueness o f the 

arrangement o f the anterior teeth is completed (55). 

Several researchers have attempted to establish statistical evidence o f the 

uniqueness o f the dentition. These studies have included examining the 

frequency o f dental characteristics i n a population o f dental casts (56), the dental 

uniqueness o f bitemarks found i n monozygotic twins (57), and an analysis o f 

sample test bites collected across the Uni ted States (58). Bu t the studies provided 

limited preliminary results based upon the population samples. Further research 

is needed to extrapolate the generalization o f anterior dental uniqueness among 

all individuals. 

Despite the lack o f solid statistical support, dental uniqueness is still generally 

accepted in bitemark analysis. M o s t dentists anecdotally report never seeing two 

patients that exhibit the same anterior dental pattern during long clinical careers. 
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However, there are case reports that caution against the reliance upon single 

unique features to establish a bitemark identification. One case involved two 

suspects whose dental characteristics appeared dissimilar i n the beginning, but 

only after the comparisons were applied to the bitemark did the similarities 

become apparent (59). Other authors contend that in an attack involving a 

limited number o f people whose names are known, identification may be based 

on a single unique feature. However , in an open population o f suspects, a single 

feature may not be extraordinary enough to establish an identification o f the biter 

(60,61). 

O p i n i o n o n the uniqueness o f the human dentition wi l l continue to fuel debate. 

Odontologists should be familiar wi th its shortcomings. Bowers echoed this 

sentiment i n a web-based essay describing arguments behind the individuality o f 

human teeth (55): 

"Individual dental characteristics are reported to be features that are unique to 
an individual variation within a defined group. The presence of worn, 

fractured or restored teeth is valued as unique features. If a bitemark 
possesses the reflection of such a feature(s), the degree of confidence in a match 
increases. The odontological literature is silent regarding the frequency of these 
traits. It is actually counter-intuitive to assume enamel chips, fractures, and 
dental restorations are ALWAYS inherently unique. The shape of the 
human teeth is quite constant in nature and their changes over time are based 
on common events. The chance of more than one person having a crooked 

front tooth is quite large. That is why orthodontists have such large 
practices." 

38 



Chapter One - Introduction 

1.3.2 Comparison Methods 

Bitemark analysis is a complex process that can take on several forms. The 

ABFO surveyed the most popular analytical methods and presented these in the 

ABFO Bitemark Guidelines and Standards (6). These procedures are listed in 

Table 5. 

Table 5. ABFO guidelines for bitemark analysis 

Methods of Comparing Bitemark Evidence 

Generation of Overlays 
1. Acetate tracing directly from models of suspect 
2. Acetate tracing indirect from photocopy of model with scale 
3. X-ray film overlay created from Radiopaque material applied to the wax bite 
4. Life-sized or greater photos of model printed on acetate film 

Test Bite Media 
1. Wax exemplars (aluwax, baseplate wax, etc.) 
2. Styrofoam 
3. Volunteer's skin 
4. Alternative methods (fruit, clay, etc.) 

Comparison Techniques 
1. Acetate tracings to life-size photos of wound 
2. Working study model of teeth to life-size photo of wound 
3. Working study model of impression of wound or to actual victim 
4. Acetate overlays of teeth compared to greater than life-size photo of wound 

Technical Aids Employed for Analysis 
Transillumination of tissue, Computer enhancement and/or digitization of mark or 
teeth, Stereomicroscopy, Scanning Electron Microscopy, Videotape, Caliper utilization 
for measurement 

In a critical review of the scientific basis for bitemark analysis, attention was 

directed to the variety of techniques found in the literature (16). Occasions in 
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which competing expert witnesses utilize identical techniques are rare and, 

therefore, the weight of the evidence may shift to the techniques rather than the 

experts' conclusions. Most methods that are used incorporate both metric and 

non-metric components. Metric analysis is a comparison using the physical 

measurements of class and individual characteristics located within the bitemark 

and the suspect's teeth. Non-metric analysis, or pattern association, is the 

associative comparison of the class and individual characteristics located within 

the bitemark and suspect's teeth especially tooth position, diastemata between 

teeth, dental rotation, etc. (7). An overview of these two types of comparison 

methods is described below. 

1.3.2.1 Metric Comparisons 

The specific dimensions of a dental arch can be an important factor to 

immediately include or exclude a suspect. The basic arrangement of human teeth 

follows general developmental lines but variations between individuals exist. The 

measurements of significance are the mesial-distal width, buccal-Ungual width, 

and rotational angle of each tooth. 

Numerous studies have examined the differences in human teeth measurements 

(62-66) based upon different population groups and noticeable differences have 
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been seen. M o s t measurements are manually obtained by using an instrument 

such as a caliper. The possibility o f introducing human and instrumental error is 

relatively high. A study o n the reliability o f human odontometric data showed a 

high inter-observer error component and a greater discrepancy i n the mesial-

distal dimension than i n the buccal-lingual dimension (67). N e w metric 

comparison methods are emerging that may reduce this error and enable the use 

o f computer software programs. These techniques wi l l be discussed i n a 

subsequent section. 

It is important to note the lirnitations o f the evidence under examination. Often, 

an investigator is faced with the task o f comparing absolute measurements 

obtained from a suspect's cast to vague or diffuse injuries depicted in a day-old 

bite or photograph. A positive identification should not be based exclusively on a 

metric analysis without a supplemental physical comparison. 

1.3.2.2 Physical Comparisons 

The most common method o f bitemark analysis is the physical comparison or 

association o f the suspect's teeth to the bite injury. This involves matching the 

pattern o f an outline o f the suspect's anterior teeth to an identically-sized 

photographic image o f the bitemark. The examination includes the 
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documentation of any consistencies and inconsistencies demonstrated between 

the two patterns. 

A rrririimum number of concordant points needed for a positive identification of 

bitemarks has not been established. The debate focuses around the idea that 

some experts consider a formal identification is established only if a minimum 

number of corresponding characteristics with no unexplained non-conformity is 

put into evidence (68). Other experts contend the identification is a matter of 

judgment based upon the evaluation of the contributions to individuality on a 

quantitative and a qualitative level (68). Differences in subjective interpretations 

of patterns exist amongst odontologists. 

The ABFO has developed a list of acceptable terms used to describe the link 

between a bitemark and a suspect. These recommendations are listed in Table 6. 

The opinion rendered by the odontologist is based upon a personal threshold 

that is arrived at after comprehensive examination, consideration of all variables, 

and determination of the degree of concordance. 
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Table 6. Degrees of certainty describing the link between bitemark and suspect 

Potential Conclusions 
Term Connotation 

Positive Identification virtual certainty; no reasonable or practical 
possibility that someone else did it 

Probable Identification more likely than not 
Possible Identification could be; can't be ruled out 
Negative Identification not the biter 

Insufficient Evidence insufficient quality of evidence to make any 
statement of relationship to the biter 

The reliability of using these categorical conclusions was assessed during the 1999 

ABFO Bitemark Workshop (69). Examiners were asked to draw conclusions 

based upon how certain they were that different suspects had made specific 

bitemarks. Receiver operating characteristics analysis revealed an accuracy score 

of 0.86, which the authors concluded was less than optimal accuracy due to the 

legal context in which bitemarks are found. With a need to be able to defend 

procedures and techniques in a court of law, a conservative approach was 

recommended when examining bitemark evidence. 

1.4 BITEMARK OVERLAYS 

The physical comparison of the suspect to the bite is achieved by producing a 

transparent bitemark overlay. This aids in visualizing the biting edges of the teeth 

while they are compared to the bitemark photograph. An overlay contains 

outlines of the perimeters of the suspect's anterior teeth that would most likely be 
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seen i n a resvilting bitemark. This outline produces what is referred to as a 

hollow-volume overlay. That is, an outline that is transparent outside and inside 

me contours o f the teeth o f interest. (See Figure 10.) Numerous techniques have 

been developed to produce bitemark overlays. The most c o m m o n methods are 

described below. 

1.4.1 Hand-Traced from Stone Casts 

The most simplistic overlay technique involves a hand-traced representation o f 

the suspect's teeth. This method, originally described by Lun tz and Luntz (70), 

produces a life-size representation o f the suspect's teeth by securing a sheet o f 

clear f i lm over a cast o f the suspect's teeth and tracing the perimeter o f the 

anterior teeth wi th a fine-tipped marker. These representations o f the teeth were 

subsequendy direcdy compared to a life-size photograph o f the bite injury. This 

method is quick and economical, but highly subjective i n the depiction o f the 

biting edges, accuracy o f the actual biting edges recorded on the film, and the 

stability o f the transparency sheet. 
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1.4.2 Hand-Traced from Wax Impressions 

Luntz and Luntz also described another hand tracing method by integrating a 

step in which the stone casts are indented into a wax wafer (70). By creating an 

impression of the biting edges into softened wax, the configuration of a likely 

bite pattern is recorded. A sheet of clear film is positioned on top of the wax 

impression, and the perimeter of the indented tooth markings is traced with a 

fine-tipped marker. This may be directiy compared to a life-size photograph. 

The main critique of this method is the subjectivity in the creation of the wax 

impression through the amount of pressure applied to the dental casts. 

Different forces significantiy alter the depth that the teeth impress into the wax. 

These differences in depth penetration produce impressions in the wax whose 

dimensions may be significantiy different than the dimensions of the teeth at 

the biting edges. The previously described subjectivity of the depiction of the 

biting edges and the stability of the transparent sheet are also a problem with 

this technique. 

1.4.3 Hand-Traced from Xerographic Methods 

In 1991, Dailey published a technique for the production of overlays using a 

photocopier (71). Initially, the photocopier is calibrated to ensure 100% image 
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output. Upper and lower dental casts are placed on the glass o f the copier and 

weighted to ensure maximal incisal contact wi th the glass. A n A B F O N o . 2 scale 

is positioned next to the casts and photocopied at 100% magnification. The 

photocopied image is then placed face down on a light box. The illumination 

allows the examiner to visualize and trace the outlines o f the incisal edges on the 

back o f the photocopy. This eliminates unwanted background images and 

focuses the attention o n the teeth o f interest. This tracing is then inserted into 

the photocopy machine and printed out on a transparency fi lm to produce an 

overlay. A margin o f error exists that is inherent i n the continued reproduction 

o f the images. Us ing photocopies o f photocopies to produce an image is 

questionable. Additionally, examiner subjectivity is still present i n the tracing o f 

the incisal edges. 

1.4.4 The Radiopaque Impression Method 

Published i n 1996, N a r u and Dykes presented a new spin o n the previous wax 

impression method (72). Denta l casts are impressed into a softened piece o f wax 

to record the biting surfaces. Radiopaque powder, such as amalgam or B a S 0 4 , is 

mixed wi th alcohol to produce a solution. This mixture is carefully placed i n the 

hol low indentations o f the tooth marks and left for five minutes to facilitate 

alcohol evaporation. Occlusal radiographic film is placed under the wax wafer 
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and a radiographic image is exposed and developed. The film will show 

radiopacities where the tooth marks are positioned. A computer or photocopier 

is programmed to reverse the image and produce an inverted representation of 

the pattern. 

1.4.5 Computer-Generated Overlays 

In 1998, Sweet endeavoured to reduce examiner subjectivity in the production of 

overlays by developing a technique using a computer, scanner, and imaging 

software program (54). Dental casts are placed on the glass platen of a flatbed 

scanner along with an ABFO No. 2 scale. The image is scanned into Adobe 

Photoshop®. Using the Magic Wand Tool, the biting edges of the teeth are 

objectively selected and pasted into a new layer. The Magic Wand Tool selects 

portions of an image based on the similarities of adjacent pixel values. By 

removing the background layer containing dental structures not related to the 

biting edges, the images of the teeth recorded in the new layer can be printed on a 

clear sheet and used for an overlay. 
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1.4.6 Comparison of Overlay Techniques 

Several studies have evaluated the accuracy o f various overlay product ion 

methods. In 1998 Sweet and Bowers compared the five most c o m m o n overlay 

methods described above (73). Examples o f the overlays produced by each 

method are shown i n Figure 10. 

Figure 10. Examples o f five c o m m o n overlay techniques 
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Data was collected for the area and relative rotation from each tooth present on 

the 150 sets of overlays studied. Results of a multivariate analysis of variance 

showed significant differences between the techniques for both area and 

rotation. The computer-based production method was the most accurate and 

most objective, and was used as a gold standard to compare the accuracy of the 

other methods. Hand-traced methods were determined to be inaccurate and 

subjective. 

Another study examined differences in examiner expertise with the 

reproducibility in the production of overlays using manual and digital methods 

(72). Four examiners were selected; an odontologist, a dental nurse, a dental 

surgeon, and a layman. Results demonstrated how subjectivity, perception, and 

manual ability can influence variations among the examiners for the hand 

drawings. The digital method was less sensitive to these factors. 

Although not completely objective, the use of computers is forging the way 

toward less subjectivity in the comparisons of bitemarks. With advancements in 

computer technology and imaging, a movement is underway to integrate the 

numerous digital applications that are beneficial in a forensic investigation to 

bitemark comparisons. 
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1.5 C O M P U T E R S A N D DIGITAL I M A G I N G 

Computers are rapidly becoming an essential element of everyday life. Their low 

cost, availability, and ease-of-use make the digital manipulation of information 

easier than it has been before. Forensic odontology investigations have followed 

similar trends and have begun to take advantage of computers and other digital 

resources. 

1.5.1 Computer Applications in Forensic Odontology 

In 1996, Rawson reviewed the most likely uses for computers in forensic 

dentistry and are listed in Table 7 (74). 

Table 7. 1996 listing of computer uses in forensic dentistry 

Uses for Computers in Forensic Dentistry 
1) Writing and processing documents 
2) Searching for missing people and handling antemortem and postmortem records relating to 
mass disasters 
3) Reviewing charts and managing records 
4) Researching and handling data such as literature reviews 
5) Radiographic images 
6) Taking digital photographs and enhancing and comparing images 

Although this list provides a general overview, the uses for computers have 

continued to expand. The applications related to the identification of human 

remains, analysis of evidence, and web use in research and casework has seen vast 
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improvements. A few significant areas of focus relating to the identification of 

human remains and bitemark analysis are discussed below. 

1.5.1.1 Techniques i n Digi ta l Identification of Remains 

Two computer programs are used in mass disaster identifications. CAPMI 

(Computer-Assisted Post-Mortem Identification), was developed by the United 

States Army Institute of Dental Research and is DOS-based (75). WinID was 

developed by Dr. James McGivney and is made available free of charge to all 

interested parties, including the largest response team in North America, the 

United States Public Health Services Disaster Mortuary Operational Response 

Team (75). Several other computer applications for disaster response teams have 

been developed in Europe, Canada, and Australia. The use of these programs 

significandy reduces the time involved by narrowing the list of potential 

individuals that most likely match the remains. 

Additionally, computers have proven to be useful in identifying specific sets of 

remains. Computer imaging programs have been used to compare dental 

restorations and structures in antemortem and postmortem radiographs (76,77), 

distinguish different types of restorative materials (78), and to estimate the age of 

adult teeth (79). 
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1.5.1.2 Techniques i n Digi ta l Bitemark Analysis 

In 1995, Nambiar et al developed SCIP, an interactive shape analysis computer 

program (80). This program is useful in measuring the locations and positional 

relationships between two shapes. It is based on a "least squares" method, which 

finds the common location and orientation of two shapes to compare their 

similarities and differences. This information is used to calculate a sirnilarity 

index. Nambiar tested this program by experimenting with bitemarks from 

known suspects on flat wax surfaces, foodstuff, and human skin (80,81). The 

authors concluded that a similarity index of 2.0 or less could identify a biter. 

Some studies have focused on the differences in accuracy between manual 

measurements versus computer measurements (82,83). In both instances, it was 

shown that scanning three-dimensional models into two-dimensional images 

produces measurements that are at least as accurate as those produced by other 

techniques. 

McGivney and Barsley developed a method for the mathematical documentation 

of bitemarks (84). In this method the centroid of each mark is determined and 

used as a point of reference for defining the mark. Lines are then used to 

connect each point around the arch. The lengths of these lines and the angles 
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formed between adjacent lines are recorded and used to describe the bitemark. 

The authors suggest that these lengths and angles may yield information to 

distinguish identifiable physical characteristics in the biter. For example, large 

lengths may indicate large teeth or interdental spacings, whereas shorter lengths 

may signify small or overlapping teeth. The authors warn that applying this 

method to poorly-defined bitemarks may prove inconclusive. Further research is 

necessary. 

The most critical factor in bitemark analysis is the quality of the injury 

photograph as it is this evidence that is used in the direct comparison to a 

suspect's teeth. Therefore, photographic elements such as lighting exposure, 

focus, resolution, and angle are crucial in obtaining a high-quality end product. 

Sadly, many bitemark photographs fall short of expectations. Odontologists have 

developed specialized techniques to attempt to address this shortfall. 

1.5.1.2.1 Correction of Photographic Distortion 

Distortion associated with bitemark photographs is a direct result of improperly 

aHgning the camera to the injury when the image is captured. Bowers (85) 

classified four types of distortion found in bitemark photographs, which are 

summarized in Table 8. 
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Table 8. Categones of off-angle distortion found in bitemark photographs 

Distortion Type Definition 
Entire scale and evidence on the 

I same plane, the camera is not 
properly aligned 

II Entire scale and evidence are not II parallel 
III Portion of scale is off plane 
rv Scale is bent, curved or skewed 

A study examining the use of Adobe Photoshop® to correct these distortions 

was completed by Johansen and Bowers (85). The results showed that Type I 

distortion can be reliably corrected using Adobe Photoshop®. The authors 

further concluded that Type III and IV distortion, which are subsets of the 

category of distortion found in Type I, are amenable to digital rectification 

methods. But in Type II distortions, the distortion is caused by the misalignment 

of the original evidence and scale. This situation would require the bitemark to 

be re-photographed. 

In addition to problems with distortion, bitemark images may exhibit a poor 

visual quality. Digital enhancement techniques have been developed to improve 

the features captured in the photograph. In 2001, Karazalus and Palmback 

described the application of a computer program called Lucis®, a Differential 

Hysterisis Processing technique, to use in forensic cases (86). The principle 
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behind Lucis® is the ability to work with hundreds of levels of contrast rather 

that the limited levels seen by the human eye. Lucis® selects a contrast range 

that can suppress distracting fine background details and visually enhance the 

critical portions of the image. The authors report that Lucis® is an image 

enhancement program and not an image restoration method. This software has 

opened the door to future applications to improve the quality of photographic 

evidence. 

Adobe Photoshop® is a popular method used to select the biting surfaces of 

anterior teeth and produce an overlay (9,54). In 2001, Pretty and Sweet examined 

the effectiveness of the use of bitemark overlays produced using Photoshop® 

(87). A series of simulated bitemarks were created on pig-skin, overlays were 

produced representing possible suspects and distributed to examiners for case 

analysis. The examiners were selected to represent three different groups based 

upon previous bitemark experience. The effectiveness of overlays for physical 

comparison was measured by examining the sensitivity and specificity of the 

examiners' conclusions with a forced decision model. These results were then 

analyzed as a single variable of accuracy using receiver operator characteristics 

analysis. The mean area under the curve for the groups was 80.7%, which means 

the examiners were able to correctly identify the biter eight out of ten times. 

Interestingly, the study also showed that experience had little impact on the 
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effectiveness of the use of overlays. This study established error rates for the use 

of overlays and laid a foundation for further investigation. 

Overlays are also produced using software programs that analyze the tone 

contrast found in scanned cast images. Using tone-line imaging, it has been 

suggested that artistic ability, knowledge of dental anatomy, and personal bias do 

not influence the result producing a more objective analysis (88). Nam and 

Dykes developed a technique that enables an overlay to be created by mverting 

the tonal elements within the cast image to produce an outline of the original 

biting edges (72, 89). Figure 12 illustrates a few steps involved in the production 

of an overlay using this technique. 

Figure 12. Overlay production using computer imaging contrast conversion 
methods 
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These two methods are the most popular for the production of computer-

generated overlays. They are used widely in North America and Europe, 

respectively. In the current study, we will compare the results of each technique 

to evaluate their comparative reliability. 
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2.1 Statement of the Problem 

Courts have recently taken an aggressive approach toward the scientific 

foundation of expert testimony. The validity and reliability of scientific 

techniques used in the courtroom have brought many previously accepted 

methods of forensic investigation under closer inspection. Significant cases such 

as Daubert and Kuhmo have demonstrated that scientific evidence must meet a 

minimum level of judicial scrutiny before testimony is accepted. 

The current study aims to compare the reliability of two different methods to 

produce computer-generated bitemark overlays. Questions must be answered on 

how often one examiner would produce an overlay identical to another examiner 

and on how examiners would produce consistent overlays using the two different 

techniques. 

While researchers have examined different computer methods individually, there 

has never been a direct comparison of one leading technique to the other. This 

study will focus on the production of overlays by using a) Adobe Photoshop® 

Magic Wand Tool, and b) Adobe Photoshop® Inversion Tool, the techniques 

popular in North America (Sweet and Bowers) and Europe (Naru and Dykes). 

By evaluating the inter- and intra-exarniner reliability of the two techniques, the 

scientific foundation of bitemark analysis will be furthered. 
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3.1 EXPERIMENTAL DESIGN AND PROTOCOLS 

Participants were asked to produce hollow-volume overlays using two different 

computer techniques. The overlays were collected and measurements of the area 

and x- and y- positions were obtained for each of the six upper and six lower 

anterior teeth. These measurements were evaluated using analysis of variance and 

calculations of reliability coefficients. 

3.1.1 Examiner Groups 

The following groups were selected to address this issue: 

• Diplomates of the American Board of Forensic Odontology with 

extensive bitemark experience 

• Forensic Dentists with limited bitemark experience 

• 2 n d Year Dental Students 

Ten examiners were recruited in each group based upon their ability to meet the 

established criteria: access to a computer with version Adobe Photoshop® v5.0 

or higher, capability to save digital images to either a Zip disk or CD-ROM, and 

willingness to volunteer their time to the study. A total of thirty examiners 

received the study materials. 
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3.1.2 Cast Selection 

The dental casts were selected to be representative of a typical range of the 

variations found in the human dentition. Six casts were chosen that exhibited 

assorted levels of difficulty based upon tooth placement and rotation. The casts 

were stratified as follows: two casts had perfect alignments, two casts showed 

moderate levels of crowding, and two casts had buccal-lingual inversions. 

3.1.3 Cast Preparation 

Digital images of the casts were obtained by scanning to high-quality JPEG 

format using the method described by Johansen (9). An ABFO No. 2 scale was 

included in each image. The final images were confirmed to be life-size and were 

saved in a Photoshop Document (PSD) file format at a resolution of 150 

pixels/inch. The casts were labeled A through F and can be found in Appendix 

A. 

In order to evaluate mtra-examiner reliability, it was necessary that some of the 

casts would need to be examined more than once. To accomplish this, all cast 

images were duplicated and altered at the occlusal surfaces of the posterior 

teeth to mislead the examiners into diinking the casts were different. Figure 13 

illustrates an example of an original and modified cast. 
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Figure 13. Example of an original and modified cast image used to assess 
mtra-exarriiner reliability 

To control for the potential for the examiners to improve their skills with each 

successive overlay, the order the casts were to be completed was randomized. 

Each examiner was placed into one of ten participant groups and the cast order 

was randomized within these groups. 

Each of the six original casts were duplicated and modified resulting in twelve 

casts images that were distributed to the examiners. The casts were labeled Cases 

1 through 12 dependent upon which randomization group the examiner was 

placed in. Each examiner would create an overlay for each case twice allowing 

for calculations of mtra-examiner reliability without the need for a washout 

period to elapse between examinations. 
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3.1.4 Study Package 

Each examiner received a package mcluding the following: 

o Instructions 
o Questionnaire 
o CD-ROM labeled "Study C D " containing the twelve cast 

images labeled Cases 1-12 
o CD-ROM or Zip Disk labeled "Blank CD or "Blank 

Disk" to submit their overlays 
o Pre-addressed envelope for the return of the materials 

A pilot study was completed to assess the comprehensibility of the instructional 

booklets. Three independent examiners were given a cast image and asked to 

follow the instructions to create an overlay using each technique. The resulting 

overlays and examiners' comments were evaluated to determine if the 

instructions were adequate. The study booklets were modified accordingly. 

3.1.4.1 Study Questionnaire 

A questionnaire was developed to gauge experience levels for each examiner. A 

copy of the questionnaire can be found in Appendix B. The questionnaire 

focused on two areas: computer and bitemark experience. 
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3.1.4.2 Technique A 

Technique A is the well-known, peer-reviewed method routinely used in North 

America. Appendix C contains the complete instructions provided to the 

participants and an example showing the main steps involved to produce an 

overlay using Technique A for the maxillary anterior teeth. The main feature in 

Technique A is the use of the Magic Wand Tool. The Magic Wand cursor is 

placed over the biting edge of each tooth and the area is selected. The area 

selected will include all adjacent pixel tones of similar values based upon the 

tolerance setting of the Magic Wand Tool. This will create an outline of the 

perimeters of the biting surface of each tooth. The perimeter is then defined by 

stroking a solid black line around the selected area to produce the overlay. 

Figure 14 summarizes the process involved. 

Figure 14. Technique A overlay production steps 

Open image in Photoshop® 

Zoom-in to magnify the incisal edges of the anterior teeth 

Select the incisal edges using the Magic Wand Tool 
u 

Copy the selected areas into a new layer called 'Overlay' 

Clear the center noise and stroke the perimeter of the teeth 
on the inside with 2 pixel black line 

Deselect the background image of the cast and save the overlay 
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3.1.4.3 Technique B 

Technique B is used predominately in Europe and is based on previously 

published methods (72, 89) that focus on different contrast levels found in the 

cast image. Appendix D contains the complete instructions provided to the 

participants and an example showing the main steps involved to produce an 

overlay using Technique B for the maxillary anterior teeth. The main feature in 

Technique B is the use of the Glowing Edges filter. This filter objectively selects 

and highlights the edges of the cast and teeth. The contrast of the image is then 

inverted and the unwanted areas are erased until only an outline of the incisal 

edges of the anterior teeth remain. Figure 15 summarizes the process involved. 

Figure 15. Technique B overlay production steps 

Open the image in Photoshop® 

Zoom-in to magnify the incisal edges of the anterior teeth 
JJ 

Select Filter > Stylize > Glowing Edges 

Select Image > Adjust > Invert 
u 

Erase unwanted areas until you are left with an outline 
of the incisal edges of the anterior teeth 

w 
Continue to erase separating the individual anterior 

teeth and save the overlay 
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3.1.4.4 Follow-up Questionnaire 

After the overlays were returned by the examiners, a follow-up questionnaire was 

used to collect additional data. Appendix E contains the questionnaire. Three 

questions were asked: 

1) Which technique did you prefer for the production of a 
bitemark overlay? Why? 

2) What was the average time it took you to produce an overlay 
using Technique A? Technique B? 

3) For both techniques, when you focused on the anterior teeth 
was the entire arch/cast visible or did you zoom-in on the teeth 
to get a closer look at the incisal edges? 

3.2 MEASUREMENT OF AREA AND POSITION 

The renderings of the biting edges of the teeth recorded on the overlays by the 

examiners were converted to black using Adobe Photoshop®. The area (square 

mm) and position (x-coordinate, y-coordinate) of the black regions were 

calculated using Scion Image®. A description of these stages is explained below. 

The overlay was opened in Adobe Photoshop®. The tolerance setting of the 

Magic Wand Tool was adjusted to 18. The entire overlay was selected and then 

inverted so that only the biting edges remain selected. A new file was created 

with a standard width and height of 14 centimeters each with a resolution of 150 
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pixels/inch in a grayscale mode on a white background. The selected images of 

the teeth were pasted into this new file. The selection was Filled using 100% 

opacity black and normal blending. The image was Deselected and the layers 

were merged and flattened. The final product was saved as an uncompressed 

TIFF image. Figures 16 and 17 illustrate one of the examiner's original hollow-

volume overlays and the converted solid-volume overlays for each technique. 

Figure 16. Original and converted overlay example for Technique A 
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Figure 17. Original and converted overlay example for Technique B 
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If two teeth were found adjoined, a one-pixel wide break was created using the 

eraser tool at the normal anatomical separation between the teeth. This was 

necessary to differentiate each tooth. 

Each converted overlay was opened in Scion Image® and the following 

preferences were set: a) area measurements in niillimeters, b) x-y centroid 

position, and c) activation of the wand auto-measure tool. Each measurement 

was recorded in a spreadsheet. Figure 18 shows a sample image of an overlay 

analysis. Appendix F contains the complete data set for each examiner with the 

follow examiner group codes: D = Diplomates, F = Forensic Dentists and S = 

Dental Students. The Universal Tooth Numbering System (#1-32) was used to 

identify the specific teeth. 
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Measurements of area, x-coordinate, and y-coordinate were collected for each 

tooth on each converted overlay. This resulted in 36 data points for each case. A 

total of 432 data points were collected for each examiner for each technique. 
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3.3 ASSESSMENT METHODS 

3.3.1 Reliability 

Reliability is defined as the extent to which a method of measurement performs 

consistendy (90). Often, reliability assessments focus on the premise of 

reproducibility. The principle aim of a reliability analysis is to determine the 

degree of agreement between examiners when using a particular rating scheme or 

technique. Ratings can be qualitative or quantitative measurements. The type of 

rating measured will determine the most appropriate reliability test for the final 

analysis. 

Reliability assessments may follow two different approaches commonly seen in 

clinical and laboratory settings. In a clinical setting, it is common to examine 

observer agreement regarding the presence or absence of a particular sign or 

symptom (91). The outcome of this type of assessment is highly dependent upon 

the detail of the rating scale. For example, ten examiners may be asked to 

evaluate an individual's dental anxiety. One scale may have the examiner rate 

anxiety levels as simply the presence or absence of anxiety. A different scale may 

have the examiner rate the individual's anxiety on a scale of 1-10 with 1 as low 

anxiety and 10 as high anxiety. It is evident that when there are more categories 

included, there is a lower chance of perfect agreement between the examiners. 
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Therefore, a more appropriate term for this type of assessment is the degree of 

association between the examiners (91). An analysis based upon this approach 

will allow trends to show significance without demanding perfect agreement as a 

means of reproducibility. 

In the laboratory setting, cases are assessed where there is an inestimable number 

of possible rating responses. This assessment typically involves an estimation of 

the precision of a technique by measuring samples and determining the variability 

of individual measurements (91). Precision is defined as how close repeated 

measurements of the same quantity are to each other (90). In this case, the 

reproducibility of the scores is determined by the amount of error in an individual 

assessment. Variability is measured by evaluating the standard deviation of the 

individual values around the calculated mean (91). Although this type of 

assessment is expressed as distinct numerical values, it is not sufficient to 

conclude a technique is reliable based solely upon insignificant differences in the 

means. Consequendy, reliability assessments should focus both upon the 

observers' error rates and the association between the ratings designated to the 

individuals by different observers (91). 
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3.3.2 Reliability Tests 

To determine the variance due to different factors, a technique called analysis of 

variance (ANOVA) is used. This approach involves dividing the various factors 

into categories to determine the individual effects. 

The variability due to the samples is calculated by the difference between the 

score obtained and the mean sample score. This difference is squared and 

added together to produce the sum of squares (91). The variability due to 

observers is calculated the same way using the observer scores. The calculation 

of the random error involves determining how much each individual score 

deviates from its expected value (91). Once these values have been established, 

the total variance of the scores can be broken down into the three components. 

The mean square is obtained by dividing the sum of squares by the degree of 

freedom (DF) (90). The degree of freedom is determined by subtracting one 

from the number of samples or observers involved for that component. 
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The components of variance (a2) can then be estimated by relating the mean 

squares using the equations below (90). 

ŝample = mean square samples — mean square error 
number of observers 

ôbserver = mean square observers — mean square error 
number of samples 

a 2
e r r o r = mean square error 

Finally, this information may be used to estimate the reliability of the 

measurements. The reliability coefficient (R) is used to quantify the magnitude 

of effect. The intraclass correlation coefficient equation is shown below (90). 

R = 

2 
sample 

2 , _2 + n 2  

sample observer ei 

R values will range between zero and one. A coefficient close to one indicates 

excellent reliability whereas a value close to zero indicates poor reliability (90). 

An analysis of variance is commonly employed when comparing the effects of 

different factors between different groups of examiners. To understand the 

results, an overview of a typical SAS printout for an analysis of variance design is 

displayed in Table 9. 
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Table 9. A typical SAS printout for an analysis of variance 

SOURCE D F Sum of 
Squares 

Mean 
Square F Value Pr >F 

Model/Treatment 3 712.586 237.529 3.77 0.028 
Error 19 1196.631 62.981 

Corrected Total 22 1909.217 
From Mendenhall, 1979 

The objective of an analysis of variance is to locate important independent 

variables in a study and determine how they interact and affect the response 

(92). Of particular interest to the impact of different vanables is the calculation 

of the F value. This value is calculated by dividing the mean square error into 

the mean square for the treatment (92). This F value can then be compared to 

a table of critical F Values to test the null hypothesis that there is no difference 

between the treatment means. For the purposes of this study, the computer 

automatically compares this value and determines a probability of observing a 

value of F as large or larger than the calculated F value, given the null 

hypothesis is true. In the example shown in Table 9, the probability' of 0.028 

translates to a 2.8% chance of having no significant difference between the 

treatment means. Therefore, the smaller the p value the more significant effect 

will be seen and the null hypothesis is rejected. A limitation of using p values is 

that if an investigator calculates a small p value and rejects the null hypothesis, 

they have littie idea of how big or small the effect could be in the population. 

Supplemental analyses, which focus on the effect size are recommended. 
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Up until this point the focus has been on exaniining the differences between 

unique observers, which is an evaluation of the inter-examiner reUability. 

Technique assessments often also include an examination of the intra-examiner 

rehability. This is accomplished through repeated measurements of the same 

sample at different times by the same observer. The data can be collected and 

analyzed using the same methods as the inter-examiner assessment. 

3.3.3 Reliability Model 

Assessing the reliability of the production of computer-generated bitemark 

overlays is multi-faceted. The influences of several independent variables 

involved have the potential to affect the final results significandy. A statistical 

model was needed that could incorporate these various factors and measure the 

size of their effects. Alan Donald, Ph.D., a statistical consultant, was employed to 

develop and apply a suitable model to assess the reliability for the parameters of 

the study. An analysis of variance was required to assess the effect of the 

following factors: forensic experience, examiners, casts, teeth, and random error. 
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3.3.3.1 Calculation of Expected Mean Squares and Variances 

One of the values obtained in an analysis of variance is the mean squares of 

different factors. The mean squares provide an estimate of the effect sizes and 

variance of the factors involved in the A N O V A . The mean square is not a direct 

estimate of the variance for that factor. Rather, the composition of the mean 

square depends upon the relationship between the factors and whether they are 

fixed or random. 

For this study, Technique A and Technique B are considered fixed factors. If the 

experiment were replicated, the identical techniques would be employed. 

Therefore, technique was not a factor in the analysis. Additionally, the experience 

level of the examiner groups is considered a fixed factor. The remaining factors; 

examiners, casts, teeth, and error are considered random factors. The selection of 

these factors are based on a representative sample taken from a larger population. 

A repeat of the experiment with different participants or dental casts may yield 

different results. An analysis was performed on each examiner group 

independently and as a cumulative assessment. 

The three outcome measures that have been obtained for each tooth are: 1) area 

in square millimeters, 2) x-coordinate of the centroid position, and 3) y-
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coordinate of the centroid position. All of the outcome measures were analyzed 

indepcndendy. The statistical model for the collected data is as follows: 

y = p. + A, + By + Q + Dl(k) + e„m 

y - any of the three outcome measures 
A - experience; fixed; levels; a = 3; index /; effect is § A 

B - examiners, nested in experience; random; levels; b = 8; indexj, variance is C T B 

C- casts; random; levels; c = 6; index k, variance is CTC 

D - teeth, nested in casts; random; levels; d = 12; index 4 variance is a2

D 

8 - error; random; levels, n = 2; index m; variance is <T£ 

A table was created to illustrate the calculations involved in deteimining the 

expected mean squares based upon the data collected. See Table 10. 

Table 10. Calculations for the expected mean squares 

79 



Chapter Three - Materials and Methods 

The variances are calculated by using the expected mean square calculations and 

the observed mean square (MS) values obtained in the A N O V A analysis. The 

estimates of the variances are as follows: 

o 2p= MSB - MSE 
144 

cry= M S C - M S D 
576 

cry = MSP - MSE 
48 

o^g = MSE 

With the estimates of variance determined, the next ifiing to consider is how to 

apply these results into an assessment of reliability. A measurement of reliability 

was calculated using the following equation: 

G2

 c + <J2
D 

R = 
a2

 B + + a 2
D + a 2

£ 

A reliability coefficient was determined for each outcome measure, for each 

group of observers, and for each technique under investigation. The results were 

then compared. 
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4.1 INTER-EXAMINER AND INTRA-EXAMINER RELIABILITY 

A SAS PROC G L M program was used to perform the ANOVAs. The observed 

mean squares from the ANOVAs were put into a Quattro-Pro spreadsheet to 

calculate the reliability coefficients. The results for reliability are displayed in 

Tables 11 through 18 for each examiner group and a cumulative total. The 

A N O V A analysis for the area, x-position, and y-position are displayed in Tables 

19 through 24. 
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4.1.1 Diplomates 

Table 11. Diplomate rehability analysis for Technique A 

Outcome Variable Mean Variance Reliability 
Measured Factor Square Estimate Coefficient 

Rater 1028.966 7.116 Inter-examiner = 

Area 
Cast 167.478 0.200 0.421 

Area 
Tooth 128.985 7.793 Intra-examiner = 

Error 4.294 4.294 0.651 

Rater 37.934 0.205 Inter-examiner = 

X-position Cast 886.306 ( M K ) ( 1 0.952 X-position 
Tooth 2754.057 171.605 Intra-examiner = 
Error 8.337 8.337 0.953 

Rater 6.348 0.012 Inter-examiner = 

Y-position Cast 101.728 0.1)1 H I 0.997 Y-position 
Tooth 23474.970 1466.892 Intra-examiner = 

Error 4.691 4.691 0.997 

Table 12. Diplomate reliability analysis for Technique B 

Outcome Variable Mean Variance Reliability 
Measured Factor Square Estimate Coefficient 

Rater 779.796 5.346 Inter-examiner = 

Area 
Cast 263.466 0.000 0.510 Area 
Tooth 265.461 15.967 Intra-examiner = 

Error 9.986 9.986 0.615 

Rater 35.801 0.222 Inter-examiner = 

X-position Cast 246.633 0.000 0.973 X-position 
Tooth 2353.284 146.837 Intra-examiner = 
Error 3.899 3.899 0.974 

Rater 61.223 0.411 Inter-examiner = 

Y-position 
Cast 17079.060 0.000 0.998 Y-position 
Tooth 22933.370 1433.211 Intra-examiner — 
Error 1.991 1.991 0.999 
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4.1.2 Forensic Dentists 

Table 13. Dentist reliability analysis for Technique A 

Outcome 
Measured 

Variable 
Factor 

Mean 
Square 

Variance 
Estimate 

Rehability 
Coefficient 

Area 

Rater 1785.346 12.344 Inter-examiner — 
0.260 

Intra-examiner = 
0.478 

Area 
Cast 176.781 0.319 

Inter-examiner — 
0.260 

Intra-examiner = 
0.478 

Area 
Tooth 115.601 6.743 

Inter-examiner — 
0.260 

Intra-examiner = 
0.478 

Area 

Error 7.713 7.713 

Inter-examiner — 
0.260 

Intra-examiner = 
0.478 

X-position 

Rater 40.118 0.211 Inter-examiner = 
0.942 

Intra-examiner = 
0.943 

X-position Cast 767.004 0.000 
Inter-examiner = 

0.942 
Intra-examiner = 

0.943 

X-position 
Tooth 2583.731 160.878 

Inter-examiner = 
0.942 

Intra-examiner = 
0.943 

X-position 

Error 9.681 9.681 

Inter-examiner = 
0.942 

Intra-examiner = 
0.943 

Y-position 

Rater 8.660 i).()23 Inter-examiner = 
0.9% 

Intra-examiner — 
0.996 

Y-position Cast 80.800 0.000 
Inter-examiner = 

0.9% 
Intra-examiner — 

0.996 

Y-position 
Tooth 23379.780 1460.906 

Inter-examiner = 
0.9% 

Intra-examiner — 
0.996 

Y-position 

Error 5.283 5.283 

Inter-examiner = 
0.9% 

Intra-examiner — 
0.996 

Table 14. Dentist reliability analysis for Technique B 

Outcome Variable Mean Variance Rehability 
Measured Factor Square Estimate Coefficient 

Rater 1823.307 12551 Inter-examiner = 

Area 
Cast 239.393 0.00(1 0.349 Area 
Tooth 262.178 15.381 Intra-examiner = 

Error 16.081 16.081 0.489 

Rater 18.093 0.071 Inter-examiner — 

X-position (last 181.305 o.ooc 0.949 X-position 
Tooth 2367.079 147.447 Intra-examiner = 
Error 7.931 7.931 0.949 

Rater 52.998 0.266 Inter-examiner = 

Y-position 
Cast 17435.390 0.000 0.990 Y-position 
Tooth 22745.370 1420.664 Intra-examiner = 
Error 14.754 14.754 0.990 
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4.1.3 Dental Students 

Table 15. Student reliability analysis for Technique A 

Outcome Variable Mean Variance Reliability 
Measured Factor Square Estimate Coefficient 

Rater 316.858 2.161 Inter-examiner = 
Area Cast 308.816 1.198 0.423 Area 

Tooth 78.709 4.563 Intra-examiner = 
Error 5.699 5.699 0.503 
Rater 44.032 0.238 Inter-examiner = 

X-position Cast 679.397 o.ooc 0.940 X-position 
Tooth 2537.232 157.963 Intra-examiner = 
Error 9.831 9.831 0.941 
Rater 11.464 0.042 Inter-examiner = 

Y-position Cast 58.522 0.000 0.996 Y-position 
Tooth 23270.850 1454.088 Intra-examiner = 
Error 5.438 5.438 0.9% 

Table 16. Student reliability analysis for Technique B 

Outcome Variable Mean Variance Reliability 
Measured Factor Square Estimate Coefficient 

Rater 407.564 2.764 Inter-examiner = 
Area Cast 304.400 0.456 0.522 Area 

Tooth 216.815 12.955 Intra-examiner = 
1 Lrror 9.536 9.536 0.584 
Rater 2.038 O.OOC Inter-examiner = 

X-position Cast 209.753 O.OOC 0.968 X-position 
Tooth 2354.097 146.831 Intra-examiner = 
Error 4.808 4.808 0.968 
Rater 14.802 0.022 Inter-examiner = 

Y-position Cast 17141.110 0.000 0.992 Y-position 
Tooth 22802.640 1424.436 Intra-examiner = 
Error 11.671 11.671 0.992 
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4.1.4 Cumulative Reliability Analysis 

Table 17. Cumulative reliability analysis for Technique A 

Outcome 
Measured 

Variable 
Factor 

Mean 
Square 

Variance 
Estimate 

Reliability-
Coefficient 

Area 

Status 580.283 
Inter-examiner — 

0.327 
Intra-examiner = 

0.527 
Area 

Rater 1043.724 ~.2U6 Inter-examiner — 
0.327 

Intra-examiner = 
0.527 

Area Cast 614.899 0.539 

Inter-examiner — 
0.327 

Intra-examiner = 
0.527 

Area 
Tooth 304.685 6.221 

Inter-examiner — 
0.327 

Intra-examiner = 
0.527 

Area 

Error 6.075 6.075 

Inter-examiner — 
0.327 

Intra-examiner = 
0.527 

X-position 

Status 14.018 
Inter-examiner — 

0.946 
Intra-examiner = 

0.947 
X-position 

Rater 40.661 0.219 Inter-examiner — 
0.946 

Intra-examiner = 
0.947 

X-position Cast 2317.895 0.01 H 

Inter-examiner — 
0.946 

Intra-examiner = 
0.947 

X-position 
Tooth 7864.347 163.650 

Inter-examiner — 
0.946 

Intra-examiner = 
0.947 

X-position 

Error 9.135 9.135 

Inter-examiner — 
0.946 

Intra-examiner = 
0.947 

Y-position 

Status 8.538 
Inter-examiner -

0.997 
Intra-examiner = 

0.997 
Y-position 

Rater 8.824 0.026 Inter-examiner -
0.997 

Intra-examiner = 
0.997 

Y-position Cast 236.620 0.000 

Inter-examiner -
0.997 

Intra-examiner = 
0.997 

Y-position 
Tooth 70119.320 1460.71-1 

Inter-examiner -
0.997 

Intra-examiner = 
0.997 

Y-position 

Error 5.050 5.050 

Inter-examiner -
0.997 

Intra-examiner = 
0.997 

Table 18. Cumulative reliability analysis for Technique B 

Outcome Variable Mean Variance Reliability 
Measured Factor Square Estimate Coefficient 

Status 2794.373 
Inter-examiner = 

0.437 
Intra-examiner = 

0.550 

Rater KX13.556 6.886 Inter-examiner = 
0.437 

Intra-examiner = 
0.550 

Area Cast 747.478 0.057 

Inter-examiner = 
0.437 

Intra-examiner = 
0.550 Tooth 714.652 14.638 

Inter-examiner = 
0.437 

Intra-examiner = 
0.550 

Error 12.041 12.041 

Inter-examiner = 
0.437 

Intra-examiner = 
0.550 

Status 7.642 
Inter-examiner — 

0.964 
Intra-examiner = 

0.964 

Rater 18.643 0.092 Inter-examiner — 
0.964 

Intra-examiner = 
0.964 

X-position Cast 621.701 0.000 

Inter-examiner — 
0.964 

Intra-examiner = 
0.964 Tooth 7069.326 147.164 

Inter-examiner — 
0.964 

Intra-examiner = 
0.964 

Error 5.436 5.436 

Inter-examiner — 
0.964 

Intra-examiner = 
0.964 

Status 16.989 
Inter-examiner -

0.993 
Intra-examiner = 

0.993 

Rater 43.008 0.233 Inter-examiner -
0.993 

Intra-examiner = 
0.993 

Y-position Cast 51609.060 0.000 

Inter-examiner -
0.993 

Intra-examiner = 
0.993 Tooth 68465.860 1426.175 

Inter-examiner -
0.993 

Intra-examiner = 
0.993 

Error 9.446 9.446 

Inter-examiner -
0.993 

Intra-examiner = 
0.993 
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4.1.5 Area 

Table 19. Area A N O V A results for Technique A 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr> F 

Status 2 1160.566 580.283 95.52 <0.0001 
Observer 
(Status) 21 21918.196 1043.724 171.81 <0.0001 

Cast 5 3074.495 614.899 101.22 <0.0001 
Tooth 
(Cast) 66 20109.208 304.685 50.16 <0.0001 

Table 20. Area A N O V A results for Technique B 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr> F 

Status 2 5588.747 2794.373 232.08 <0.0001 
Observer 
(Status) 21 21074.677 1003.556 83.35 <0.0001 

Cast 5 3737.388 747.478 62.08 <0.0001 
Tooth 
(Cast) 66 47167.056 714.652 59.35 <0.0001 
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4.1.6 Position 

Table 21. X-Position A N O V A results for Technique A 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr > F 

Status 2 28.0367 14.018 1.53 0.2157 
Observer 
(Status) 21 853.883 40.661 4.45 <0.0001 

Cast 5 11589.475 2317.895 253.74 <0.0001 
Tooth 
(Cast) 66 519046.890 7864.347 860.91 <0.0001 

Table 22. X-Position ANOVA results for Technique B 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr > F 

Status 2 15.284 7.642 1.41 0.2453 
Observer 
(Status) 21 391.523 18.6439 3.43 <0.0001 

Cast 5 3108.507 621.7014 114.36 <0.0001 
Tooth 
(Cast) 66 466575.485 7069.3255 1300.41 <0.0001 
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Table 23. Y-Position A N O V A results for Technique A 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr > F 

Status 2 17.077 8.538 1.69 0.1845 
Observer 
(Status) 21 185.302 8.824 1.75 0.0187 

Cast 5 1183.102 236.620 46.85 <0.0001 
Tooth 
(Cast) 66 4627875.096 70119.320 13884.8 <0.0001 

Table 24. Y-Position A N O V A results for Technique B 

Source DF Sum of 
Squares 

Mean 
Square F Value Pr > F 

Status 2 33.978 16.989 1.80 0.1657 
Observer 
(Status) 21 903.165 43.008 4.55 <0.0001 

Cast 5 258045.290 51609.058 5463.87 <0.0001 
Tooth 
(Cast) 66 4518747.050 68465.864 7248.51 <0.0001 
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4.2 E X A M I N E R O V E R L A Y E X A M P L E S 

Figures 19 and 20 are examples of the different types of overlays produced by the 

examiners. 

Figure 19. Converted solid-volume overlay produced by a single click on a tooth 
(arrow) and the original overlay 

Close-up of original overlay 
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Figure 20. Comparison o f two hollow-volume overlays produced using 
Technique B 
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Close-up view of maxillary arch 
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5.1 EXPERIMENTAL DESIGN 

A.R. Feinstein once stated, "To advance the art and science of forensic 

odontology, the equipment an odontologist needs most to improve is 

himself/herself' (6). Although poignant about the biased nature of man, the 

techniques used to study and advance forensic dentistry requires proper 

investigation. All experimental designs should follow a sound, scientific 

methodology. These requirements usually include defining a problem, 

developing a hypothesis and prediction, and collecting and evaluating data (6). 

Therefore, a discussion on the experimental design used for this study is 

appropriate for a complete analysis of the findings. 

5.1.1 Examiner Selection 

Forensic dentistry encompasses a diverse range of topics. Without a mandatory 

licensing board, a forensic dentist can purport to be an expert based on 

accumulated experience and not necessarily training. It is not uncommon, 

therefore, to have an experienced forensic dentist who is skilled in one area of 

interest but lacking practice in another. The overwhelming majority of a forensic 

dentist's time is spent on comparative identifications of found remains and not 

bitemark analyses. Nonetheless, forensic dentists are being called upon to analyze 

bite injuries despite a lack of bitemark experience. Differences in the levels of 
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experience amongst examiners who are analyzing bitemark overlays is a key issue 

for investigation. 

In a previous study (100), three examiner groups were also chosen to represent 

differing levels of bitemark experience. These groups consisted of 1) Diplomates 

of the American Board of Forensic Odontology (DABFO), 2) forensic dentists 

from the ASFO, and 3) general dental practitioners. The study's conclusions 

showed no significant differences between the three groups suggesting that 

experience and training in bitemark analysis have no affect on the success of 

using overlays to identify biters correctiy. 

The current study focuses on having the examiners produce the overlays, rather 

than the use of an overlay to analyze a bitemark. 

Diplomates of the ABFO are certified specialists who have successfully passed 

the certification examination. They represent the group with the highest level of 

training and experience in bitemark injuries. The second group of forensic 

dentists in the current study were selected from members of the ASFO. These 

examiners have experience in comparative identifications and minor to moderate 

experience in bitemark analysis. The final group represented examiners with 

limited dental knowledge and no forensic experience. They were 2 n d year dental 

students recruited from the University of British Columbia, Faculty of Dentistry. 

94 



Chapter Five - Discussion 

Recruitment of examiners to participate in this study was a challenge due to the 

time commitment. Most of those in the first two groups maintain full-time 

clinical practices and also have additional forensic casework. It was anticipated 

that the time commitment for each participant would be approximately two to 

four hours, and this was determined to be the maximum, reasonable time 

requested of the participants. After having committed to the project, a few 

examiners decided they no longer had the available time and withdrew from the 

study. Furthermore, some examiners revealed, after the fact, that they lacked the 

version of Adobe Photoshop® necessary to complete the project and were 

forced to withdraw. The deadline allocated for each participant to complete the 

study was six weeks. Most of the data was not received until more than twelve 

weeks had passed. The overall response was an 80% return rate. The end result 

was eight Diplomates, eight forensic dentists, and eight students. In future 

studies, it would be beneficial to collect data and information like this in a 

workshop or symposium. A controlled environment, standardization of 

computer software and hardware, and immediate acquisition of the results would 

eliminate some of the obstacles that were encountered in the collection of this 

data. 
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5.1.2 Cast Selection 

Every individual has a presumed dental uniqueness that is exhibited in the shape, 

size, position, and anatomical variations found within the teeth and 

corresponding alveolar structures. Therefore, the selection of the casts used for 

this study had to reflect a degree of dental uniqueness found in the population. 

Cast selection was taken from an actual bitemark case in which the odontologist 

was given six different dental casts to compare to one bitemark. There were 

different degrees of difficulty randomly shown in each cast. Six casts were 

selected so as to allow examiners time to perform their analyses within the 

allotted timeframe. To increase compliance, both inter- and intra-examiner 

studies were completed simultaneously in one session. Some examiners 

commented that they noticed a few cast images were duplicates but appreciated 

being able to complete the study in one setting. The analysis of variance showed 

that all casts and individual teeth contribute to significant variations of the means. 

Therefore, the specific degree of difficulty associated with each cast had no 

significant effect on the results. 
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5.1.3 Materials and Instructions 

When using examiners in a research study, a clear explanation of methods must 

be defined. A step-wise instruction manual was provided in the study package 

containing the protocol to be followed. This enabled examiners to read and 

visualize exactiy what should be appearing on their computer screen. Exarriiners 

commented on how helpful this aspect of the study was. The step-by-step 

instructions and the supplemental figures assisted examiner adherence to the 

protocols. 

Lasdy, after the initial assessment of the first submitted overlays, a concern 

surfaced about the magnification used to visualize the biting surfaces of the teeth. 

The instructions stated and also showed that the entire arch was visible for 

demonstrative purposes. In actuality, an analysis would include zooming-in to a 

level of magnification that would allow better visualization of each tooth. To 

assess if each examiner had magnified the cast image, a follow-up response was 

sent out. The overwhelrriing response was that the exarriiners zoomed-in for 

further clarification. This confirmed consistency in examiner techniques. 
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5.1.4 Imaging Programs 

The use of Adobe Photoshop® and Scion Image® provided a reliable method 

for the collection and measurement of the data. Of greatest concern was the 

potential for introducing measurement error during the conversion of the hollow-

volume overlays to solid-volume overlays. To address this, two independent 

examinations were completed. The first test was performed to assess the 

potential for instrument error by looking at the reproducibility of the 

measurements obtained from Scion Image®. In this case, a random sample of 

10% of the solid-volume overlays was measured twice. The two sets of 

measurements were compared and no differences were noted. (Data not shown) 

The second test was performed to assess the potential for observer error in the 

production of the solid-volume overlays. The author was responsible for creating 

the solid-volume overlays. To test consistency in the author's protocol used, a 

random sample of 10% of the original hollow-volume overlays were converted to 

solid-volume overlays twice. Measurements were obtained and compared to the 

first set of data. There were no differences noted in the x- and y-coordinates and 

only a negligible difference was seen in the area measurements. (Data not shown) 

Thus, the use of the computer programs was acceptable. 
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5.2 EXPERIMENTAL DATA 

Each examiner group was analyzed separately followed by a cumulative 

assessment for each technique. 

5.2.1 Reliability 

The reliability of the production of computer-generated overlays using Technique 

A and Technique B was assessed by A N O V A and the calculation of a reliability 

coefficient. 

5.2.1.1 Area 

The area selected for the biting surfaces of the teeth was measured. This 

characteristic is an important consideration in bitemark analysis because the 

specific dimensions of a suspect's teeth confines the dimensions that a resulting 

bite injury would display. There is an inherent variability found witfiin the area 

produced by teeth in a bitemark. The marks left by a set of teeth may vary in 

dimension due to the depth of penetration into the skin and the length of the 

teeth involved, and the response of the skin to the force of the injury as depicted 

through abrasion or bruising, etc. 
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5.2.1.1.1 Technique A 

The reHabikty coefficients obtained for the area measurements in Technique A 

were considerably lower than expected. The inter-examiner values were as 

follows: Diplomates = 0.412, forensic dentists = 0.260, and dental students = 

0.423. These values fell well below an acceptable range of reliability. The intra-

examiner values were only slightly better with Diplomates = 0.651, forensic 

dentists = 0.480, and dental students = 0.503. 

The unfavourable results can be explained with a closer examination of some of 

the overlays submitted. It was apparent that for some novice examiners, and 

some experienced examiners with limited computer practice, there was a 

tendency to produce and overlay by simply single clicking the Magic Wand Tool 

on the biting surface of each tooth. If the selection was in an area of different 

contrast levels of pixels than the majority of the remaining biting surface, such as 

a chip or worn edge of a tooth, the Magic Wand tool would limit the liighlighted 

area to that specific region. An example of a resulting solid-volume overlay 

produced using this single click method is shown in Figure 18 of the results 

section. 

Instances of single clicking were found in all levels of examiners suggesting that 

this was not a result of lack of knowledge regarding bitemarks, but rather lack of 
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experience with the use of Adobe Photoshop®. In addition, the instructions for 

Technique A should be more clear as to the likelihood of having to select 

multiple clicks for each individual tooth. Having the examiners print out the 

overlays to use in an actual bitemark comparison could eliminate the occurrence 

of this type of mishap. The absence of the image of the teeth would clearly 

demonstrate to the examiner if the overlay captured the elements intended. An 

overlay printed on a transparency film could be direcdy compared to a bite injury 

and the examiner could evaluate the applicability of the overlay they produced. 

5.2.1.1.2 Technique B 

The reliability coefficients calculated for Technique B were sHghdy greater for all 

three examiner groups. The inter-examiner values were as follows: Diplomates = 

0.510, forensic dentists = 0.394, and dental students = 0.522. The mtra-examiner 

values were as follows: Diplomates = 0.615, forensic dentists = 0.489, and dental 

students = 0.584. Again, these values fall beneath an acceptable reliability level. 

While Technique A involved selecting areas to include in an overlay, Technique B 

focused on removing unwanted areas to result in an overlay. An overwhelming 

majority of participants commented on the tedious task of erasing the 

unnecessary portions. The lack of control of the mouse, inability to differentiate 
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the tooth surface from the cast surface in a contrast-inverted image, and the fickle 

nature of the Eraser tool were criticism of this technique. 

An interesting factor noticed with the overlays received from Technique B was 

the attention to detail, or lack there of, to define the individual perimeters of the 

teeth. While some examiners clearly defined each individual tooth, others simply 

followed the curvature of the teeth to produce a general outline of the arch. 

Figure 19 in the results section illustrates some differences in the overlays 

received. 

This factor may have contributed to the extreme variability found within the area 

of each tooth. By not erasing the excess "noise" around the perimeters of each 

tooth, a substantial amount of additional area becomes included in the overlay. 

5.2.1.1.3 Cumulative Reliability Analysis 

The overall inter-examiner reliability coefficient found for Technique A was 0.337 

and for Technique B was 0.437. The mtra-examiner reliability coefficients were 

calculated to be 0.527 for Technique A and 0.550 for Technique B. These values 

indicate a less than adequate measure of reliability. 
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The analysis of variance calculations indicate that all four variables analyzed for 

their contribution to the effect size, (experience, examiner, cast, and tooth) 

resulted in a p value of <0.0001 for both techniques. This suggests that each 

variable had a significant effect on the differences in the means, thus eliminating 

the chance the differences were caused by random error alone. 

5.2.1.2 Position 

The position of the tooth in each overlay was measured. This measurement is a 

valuable factor in bitemark analysis as an unexplainable inconsistency in tooth 

position can irnmediately exclude a suspect from having caused a bite injury. 

5.2.1.2.1 Technique A 

The reliability coefficients calculated for all examiner groups were exceptionally 

high with near perfect agreement in some cases. The inter-examiner reliability 

coefficients for x-position and y-position, respectively, were: Diplomates = 0.952 

and 0.997, forensic dentists = 0.942 and 0.996, and dental students = 0.940 and 

0.996. The intra-examiner reliability coefficients were equally impressive: 

Diplomates = 0.953 and 0.997, forensic dentists = 0.943 and 0.996, and dental 

students = 0.941 and 0.996. 
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These results indicate a high degree of inter- and intra-examiner reliability and 

demonstrate the objective advantage of using computers to determine positional 

data. Of additional interest is the fact that there were no significant differences in 

the values obtained for each examiner group seen in the A N O V A results. This 

suggests that previous bitemark experience is not a significant factor in the 

production of an overlay. 

5.2.1.2.2 Technique B 

The reliability coefficients for Technique B were equally remarkable. The inter-

examiner reliability coefficients for x-position and y-position, respectively, were: 

Diplomates = 0.973 and 0.998, forensic dentists = 0.949 and 0.990, and dental 

students = 0.968 and 0.992. The mtta-examiner reliability coefficients were: 

Diplomates = 0.974 and 0.999, forensic dentists = 0.949 and 0.990, and dental 

students = 0.968 and 0.992. 

The positional reproducibility by all examiner groups strengthens the notion that 

computer-generated bitemark overlays can be consistently and objectively 

produced. 
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5.2.1.2.3 Cumulative Reliability Analysis 

The overall inter-examiner reliability coefficients calculated for Technique A for 

the x- and y- position was 0.946 and 0.997 and for Technique B was 0.964 and 

0.993. The intra-examiner reliability coefficients were calculated to be 0.947 and 

0.997 for Technique A and 0.964 and 0.993 for Technique B. These results 

confirmed a high degree of reliability for both techniques in the assessment of the 

positional data. 

The analysis of variance results for Technique A indicated that for the x-position, 

the examiner, cast, and tooth all had a p value <0.0001, translating to a significant 

effect on the differences in the means. However, the experience factor had a 

larger p value of 0.2157. This value implies that experience level was responsible 

for less of a significant effect in the means than the other factors. This same 

trend was noted for Technique B with the experience factor having a p value of 

0.2453. 

The analysis of variance results for Technique A for the y-position showed that 

the cast and tooth had significant effects on the differences in the means with 

both factors having a p value of <0.0001. The effects of the experience level and 

observer had a lesser effect with p values of 0.1845 and 0.0187, respectively. 

These results support the notion that the forensic experience level of the 
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examiners has less of an effect on the differences than the cast and the teeth. 

Similarly, Technique B showed the experience level to have less of an effect than 

the other factors with a p value of 0.1657. 

5.3 INDIVIDUAL EXAMINER PREFERENCES 

The examiners were asked their opinions of the two techniques under 

investigation. The opinions of each technique will be discussed separately. 

The overwhelming majority of participants preferred Technique A. Comments in 

support highlighted many of the practical advantages of this technique. The most 

often cited comment was the ability to accurately and clearly interpret the cast 

image. With a true representation of the cast visible, examiners said they had 

more control in selecting the biting surfaces based on their interpretation of the 

anatomy of the teeth. The average time required to complete an overlay using 

Technique A was faster than using Technique B. 

Criticisms of Technique A centered on the fastidious nature of the Magic Wand 

Tool. Novices in the production of computer-generated overlays remarked on 

the difficulties experienced in selecting the biting edges. One participant 

commented, "I would try to highlight small areas, but the Magic Wand would not 

allow the area I wanted to be highlighted, instead lughughting large areas around 
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the teeth as well." This problem can be resolved by adjusting the Tolerance 

setting of the Magic Wand Tool. The initial tolerance setting was 18. Further in 

the instructions was the following disclaimer: 

Please note: the "Tolerance" setting may need to be reduced if 
unwanted areas are being selected. This can be done at your 
discretion at any time until you have achieved the outline of all 
maxillary and mandibular anterior teeth that you believe are most 
likely to leave an imprint while biting. 

Examiners unfamiliar with Adobe Photoshop® may not be aware of the 

significance of adjusting the tolerance level of the Magic Wand Tool or even have 

the knowledge to be able to modify the settings. Clarification of this step should 

be included in any further studies. 

One examiner commented that the ability to adjust the tolerance settings 

introduces examiner subjectivity into the experimental design. This step was 

intentionally included for that fact. Critics of the use of overlays remark that 

examiners introduce a personal bias in their selection of the biting edges. One of 

the aims of this study was to show that even with a subjective preference setting, 

computer-generated overlays are a reliable and reproducible method. The results 

showed this for tooth position. 
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Most participants found Technique B to be more subjective than Technique A. 

The greatest complaint was the loss of the true image of the cast after the 

contrast inversions. One comment said: 

"Technique B is very two-dimensional and nearly impossible to develop any 
appreciation of the depth in the teeth. It seems quite subjective as the operator 
subtracts what he or she doesn't "like". The subtraction itself is a problem in 
two major ways. I) the operator may not notice an inadvertent slip of the 
mouse since the evidence of the slip by definition is erased, and 2) the 
cumulative erasures reduces the number of available landmarks upon one 
might (should) base the decision on what to further keep and what to erase." 

This sentiment was mentioned by most of the participants. The few exarriiners 

who preferred Technique B to Technique A felt that the Eraser Tool was easier 

for them to control than the Magic Wand Tool. 

Technique A is more commonly used in North America and because all the 

examiners reside in North America, this may be a contributing factor. However, 

the partiality towards Technique A was seen in the group of dental students as 

well, who would have no previous farriiliarity with any established techniques. 
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5.4 COMPARISON OF TECHNIQUE A A N D B 

The reliability assessment of Technique A and Technique B produced similar 

results. Both techniques scored low for the area measurements and extremely 

high for the positional measurements. Both techniques are reliable methods to 

produce bitemark overlays to assess tooth position. 
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6.1 CONCLUSIONS 

• Recruitment of experienced forensic dentists to participate in research 

using specific software programs is difficult. 

• The number of cases included is dependant upon the maximum time 

available to examiners. 

• The inter- and intra-examiner reliability coefficients are low for the 

comparison of area measurements for both Technique A and Technique 

B in all examiner groups. 

• Analysis of variance shows that experience level, examiner, cast, and 

tooth differences all contribute to a significant effect in the differences of 

the means for tooth area measurements. 

• The inter- and intra-examiner reliability coefficients are exceptionally high 

for the comparison of positional measurements for both Technique A 

and Technique B in all examiner groups. 

• Analysis of variance shows that experience level does not have a 

significant effect in the differences of the means for tooth position 

measurements, whereas the examiner, cast, and tooth differences do 

contribute to a significant effect. 

• Most examiners preferred Technique A to Technique B 

• Technique A and Technique B are reliable methods to produce bitemark 

overlays to assess tooth position. 
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6.2 FUTURE DIRECTIONS 

Future research in the area of computer-generated bitemark overlays could take 

several directions. While investigators have studied the reliability of the use and 

production of bitemark overlays, the next step is to test the external validity of 

bitemark overlays. This would include having examiners both produce and utilize 

their original overlays in a simulated bitemark comparison. By applying these 

techniques in a mock forensic investigation, the applicability of the overall 

reliability of computer-generated bitemark overlays could be established. 

Additional studies comparing overlays should assess the differences in tooth 

rotation. In bitemark comparisons, the positional measurements and degree of 

rotation of each tooth play a critical role in the inclusion or exclusion of a 

suspect. Further to this, the depth to which a tooth impresses the skin seen in a 

bitemark is variable. Therefore, studies evaluating the differences seen in the area 

and positional measurements produced by the same cast with different degrees of 

penetration is encouraged. As with any study that involves outside examiners to 

follow a specified technique, the importance of the training tools, such as 

directions and instructions, cannot be over-emphasized. Future overlay studies 

should include a quantitative test of the instructions prior to assessing the 

technique. 
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Further, studies regarding the effects of different scanning procedures could 

provide insight as to the best way to obtain cast images. Examining different 

variables such as scanning resolutions, placement of the casts, and different 

dental stone materials may aid in standardizing optimal procedures. 

Finally, as computer software programs continue to be modified and upgraded 

from previous versions, the changes in the features should continue to be 

examined for potential benefits. Whether the software may enhance the bitemark 

photograph or assist in the examination of the suspect's cast, the use of 

computers will continue to advance bitemark analysis. 

113 



References 

References 

114 



References 

1. Stimson PG, Mertz CA. Forensic Dentistry. Boca Raton, FL: CRC 
Press, 1997. 

2. Gladfelter YA. Dental Evidence: a Handbook for Police. Springfield, IL: 
CCThomas, 1975. 

3. Harvey W. Dental Identification and Forensic Odontology. London: 
Kimpton, 1976. 

4. Pierce LJ, Strickland DJ, Smith ES. The case of Ohio v. Robinson; an 
1870 bite mark case. Am J Forensic Med Pathol\990;\ 1 (2):171-177. 

5. Fixott RH. How to become involved in forensic odontology. Dent Clin 
North Amer 2001 ;45(2) :417-425. 

6. American Board of Forensic Odontology, Inc. "ABFO Guidelines and 
Standards." Manual of Forensic Odontology. 3 r d Ed. Bowers and Bell. 
Grimsby,ON: Manticore PubHshers, 1997:299-357. 

7. Sweet DJ. "Human bitemarks: examination, recovery, and analysis." 
Manual of Forensic Odontology. 3 r d Ed. Bowers and Bell. Grimsby,ON: 
Manticore Publishers, 1997: 148-169. 

8. Spencer D. "Bitemarks in child abuse." Manual of Forensic Odontology. 
3 r d Ed. Bowers and Bell. Grimsby,ON: Manticore Publishers, 1997: 177-
178 

9. Johansen RJ, Bowers CM. Digital Analysis of Bitemark Evidence. Santa 
Barbara, CA: Forensic Imaging Services, 2000. 

10. BarbenelJC, Evans JH. Bite marks in skin - mechanical factors, j Forensic 
Jo 1974;14:235-238. 

11. Jakobsen JR, Keiser-Nielson S. Bite mark lesions in human skin. Forensic 
Sci Int 1981;18:41-55. 

12. Millington PF. Histological studies of skin carrying bite marks. ] Forensic 
Sci 1974;14:239-240. 

13. Pretty IA, Sweet D. Anatomical locations of bitemarks and associated 
fmdings in 101 cases from the United States. J Forensic Sci 2000;45(4):812-
814. 

115 



References 

14. Vale GL, Noguchi TT. Anatomical distribution of human bite marks in a 
series of 67 cases. J Forensic Sci 1983;28(l):61-69. 

15. Rothwell BR, Thein AV. Analysis of distortion in preserved bite mark 
skin. ] Forensic Sci 2001;46:573-576. 

16. Pretty IA, Sweet D. The scientific basis for human bitemark analyses - a 
critical review. Sci Justice 2001;41(2):85-92. 

17. Sakoda S, Fujita MW, Zhu B-L, Oritani S, Ishida K. Wounding dynamics 
in distorted bitemarks: two case reports. ] Forensic Odontostomotol 
2000;18(2):46-51. 

18. DeVore DT. Bite marks for identification? - a preliminary report. Med 
^L^1971;ll(3):144-145. 

19. Thompson IOC, Phillips V M . A bitemark case with a twist. ] Forensic 
Odontostomotol' 1994;12(2):37-40. 

20. Hein PM, Pannenbecker J, Schutz E. Bite injuries upon a newborn. Int J Legal 
AW1992;105(l):53-55. 

21. Bernitz H , Piper SE, Solheim T, Van Niekerk PJ, Swart TJP. 
Comparison of bitemarks left in foodstuff with models of the suspects' 
dentitions as a means of identifying a perpetrator. / Forensic Odontostomotol 
2000;18(2):27-31. 

22. McKenna CJ, Haron MI, Brown K A , Jones AJ. Bitemarks in chocolate: a 
case report. J Forensic Odontostomotol 2000;\%(\):\0-\A. 

23. Kerr NW. Apple bite mark identification of a suspect. Int J Forensic Dent 
1969;13:20-23. 

24. Deming JE, Mitdeman RE, Wetli CV. Forensic science aspects of fatal 
sexual assaults on women. J Forensic Sci 1983;28(3):572-576. 

25. Rawson RD, Koot A, Martin C, Jackson J, Novosel S, Richardson A, 
Bender T. Incidence of bite marks in a selected juvenile population: a 
preliminary report. ] Forensic Sci 1984;29(l):254-259. 

26. Sheasby DR, MacDonald D G . A forensic classification of distortion in 
human bite marks. Forensic Sci Int 2001;122:75-78. 

116 



References 

27. Sweet D, Hildebrand DP. Saliva from cheese bite yields D N A profile of 
burglar: a case report. Int J LegalMed 1999;112(3):201-3. 

28. Sweet D, Shuder GC. Analysis of salivary D N A evidence from a 
bitemark on a body submerged in water. J Forensic Sci 2000;44(5): 1069-72. 

29. Sweet D, Lorente M , LorenteJA, Valenzuela A, Villanueva E. An 
improved method to recover saliva from human skin: the double swab 
technique. J Forensic Sci 1997;42(2):320-2. 

30. Webb DA, Sweet D, Hinman DL, Pretty IA. Forensic implications of 
biting behavior: a conceptually underdeveloped area of investigation. / 
Forensic Sci 2002;47(1):103-106. 

31. Walter RD. Anger biting: the hidden impulse. Am J Forensic Med Pathol 
1985;6(3):219-221. 

32. Walter RA. An examination of the psychological aspects of bite marks. 
Am JForensic MedPatholT984;5(l):25-29. 

33. Morrison HL. Psychiatric observations and interpretations of bite mark 
evidence in multiple murders. J Forensic Sci 1979;24(2):492-502. 

34. Furness J. Teeth marks and their significance in cases of homicide. 
Forensic Science Case Book. Seventeenth Symposium; London, 1968. 

35. McNamee A H , Sweet D. Adherence of forensic odontologists to the 
ABFO guidelines for victim evidence collection. / Forensic Sci 
2003;48(2):382-385. 

36. Pretty IA, Sweet D. Adherence of forensic odontologists to the ABFO 
bite mark guidelines for suspect evidence collection. / Forensic Sci 
2001;46(5):1152-1158. 

37. Spring GE. Evidence Photography: an overview. / Biol Photogr 
1987;55(4):129-132. 

38. Rawson RD, Vale GL, Herschaft E E , Sperber N D , Dowell S. Analysis 
of photographic distortion in bite marks: a report of the bite mark 
gmdelines committee. J Forensic 3«'1986;31(4):1261-1268. 

117 



References 

39. Hyzer WG, Krauss TC. The bite mark standard reference scale - ABFO 
No. 2. /Fonf»wJ"«1988^3(2):498-506. 

40. Krauss TC. Photographic techniques of concern in metric bite mark 
analysis. ]Forensic Sci 1984;29(2):633-638. 

41. Havel DA. The role of photography in the presentation of bitemark 
evidence. / BiolPhotogr 1985;53(2):59-62. 

42. Wright FD. Photography in bite mark and patterned injury 
documentation - part 1. J Forensic Sci 1998;43(4):877-880. 

43. Wright FD. Photography in bite mark and patterned injury 
documentation - part 2: a case study. J Forensic Sci 1998;43(4):881-887. 

44. Dorion R. "Excision of bitemarks." Manual of Forensic Odontology. 3 r d 

Ed. Bowers and Bell. Grimsby,ON: Manticore Publishers, 1997: 171-
172. 

45. Sweet DJ, Bastien RB. Use of acrylonitrile-butadiene-styrene (ABS) 
plastic ring as a matrix in the recovery of bitemark evidence. / Forensic Sci 
1991 ;36(5):1565-71. 

46. LaytonJJ. Identification from a bitemark in cheese. J Forensic Sci 
1966;6:76-80. 

47. Standards of evidentiary reliability. 
http://www.ipce.info/library 3/files/camp/standards.htm 

48. Cottone JA, Standish MS. Outline of Forensic Dentistry. Chicago, IL: 
Year Book Medical Publishers, 1982. 

49. Bowers CM. Jurisprudence issues in forensic odontology. Dent Clin 
North Anier 2001 ;45(2):399-415. 

50. Zarkowski P. Bite mark evidence: its worth in the eyes of the expert. / 
Loaf Ethics Dent 1988;1 (l):47-57. 

51. Aksu M N , Gobetti JP. The past and present legal weight of bite marks as 
evidence. Am J Forensic Med PatholT996;17(2):136-140. 

118 

http://www.ipce.info/library


References 

52. GuTidelach A. Lawyers' reasoning and scientific proof: a cautionary tale 
in forensic odontology. ]Forensic Odontostomotol 1989;7(2):11-16. 

53. Whatmough L N , Nuckles DB. Bite mark evidence: increasing 
acceptance with a qualified expert witness. Leg Med 1992:49-78. 

54. Sweet D, Parhar M , Wood RE. Computer-based production of bite mark 
comparison overlays. J Forensic Sci 1998;43(5):1050-1055. 

55. Bowers CM. Arguments on the individuality of human teeth. 
www.forensic.to/webhome/bitemarks/arguments on the individuality 
ol.htm 

56. MacFarlane TW, MacDonald D G , Sutherland DA. Statistical problems 
in dental identification. J Forensic Sci 1974;14:247-252. 

57. Sognnaes RF, Rawson RD, Gratt N M , Nguyen NBT. Computer 
comparison of bitemark patterns in identical twins. JAm Dent Assoc 
1982;105:449-451. 

58. Rawson RD, Ommen RK, Kinard G, Johnson J, Yfantis A. Statistical 
evidence for the individuality of the human dentition. / Forensic Sci 
1984;29(l):245-253. 

59. Pretty IA, Turnbull MD. Lack of dental uniqueness between two bite 
mark suspects. J Forensic Jo 2001;46(6):1487-1491. 

60. de Villiers CJ, Phillips V M . Personal identification by means of a single 
unique dental feature. J Forensic Odontostomotol 1998;16(1):17-19. 

61. Kieser J, Firth N , Buckley H . Dental misidentification on the basis of 
presumed unique features. J Forensic Odontostomotol2001;19(2):36-9. 

62. Smith SS, Buschang PH, Watanabe E. Interarch tooth size relationships 
of 3 populations: does Bolton's analysis apply? Am J Orthod Dentofacial 
Orthop 2000;117:169-174. 

63. Gillen RJ, Schwartz RS, Hilton TJ, Evans DB. An analysis of selected 
normative tooth proportions. Int J Vrosthodont 1994;7(5):410-417. 

119 

http://www.forensic.to/webhome/bitemarks/arguments


References 

64. Kieser JA, Groeneveld HT. High-dimensional plots in the evaluation of 
interpopulation differences in human tooth size. JDent Assoc SAfr 
1992;47:361-364. 

65. ICieser JA, Groeneveld HT, Preston CB. A metric analysis of the South 
African caucasiod dentition. J Dent Assoc S Afr 1985;40:121-125. 

66. Santoro M , Ayoub M E , Pardi V A , Cangialosi TJ. Mesiodistal crown 
dimensions and tooth size discrepancy of the permanent dentition of 
Dominican Americans. Angle CV/w/2000;70(4):303-307. 

67. Kieser JA. Groeneveld HT, McKee J, Cameron N . Measurement error 
in human mensuration. Ann Hum Biol 1990;17(6):523-528. 

68. Taroni F, Mangin P, Perrior M . Identification concept and the use of 
probabilities in forensic odontology - an approach by philosophical 
discussion. J Forensic Odontostomatol2000;\&(\):\5-\&. 

69. Arheart K L , Pretty IA. Results of the 4 t h ABFO bitemark workshop -
1999. Forensic Sci Int 2001;124:104-111. 

70. Luntz L, Luntz P. Handbook for dental identification. Philadelphia, PA; 
Lippincott, 1973. 

71. Dailey JC. A practical technique for the fabrication of transparent bite 
mark overlays. ] Forensic Sci 1991;36(2):565-570. 

72. Naru AS, Dykes E. The use of a digital imaging technique to aid bite 
mark analysis. Sci Justice 1996;36(l):47-50. 

73. Sweet DJ, Bowers CM. Accuracy of bite mark overlays: a comparison of 
five common methods to produce exemplars from a suspect's dentition. 
J Forensic Sci 1998;43(2):362-367. 

74. Rawson RD. Computers in forensic dentistry. J Calif Dent Assoc 
1996;24(5):58-61. 

75. Lewis C. WinID2 verses CPMI4: two computer-assisted dental 
identification systems. J Forensic JVz 2002;47(3):536-538. 

76. Bowers CM, Johansen RJ. Digital imaging methods as an aid in dental 
identification of human remains. J Forensic Sci 2002;Al(2):?>5'\-?>59. 

120 



References 

77. Wood RE, Kirk NJ, Sweet DJ. Digital dental radiographic identifications 
in the pediatric, mixed and permanent dentitions. / Forensic Sci 
1999;44(5):901-916. 

78. Wenzel A, Hintze H , Horsted-Bindslev P. Discrimination between 
restorative dental materials by their radiopacity measured in film 
radiographs and digital images. J Forensic Odontolostomotol 1998;16(1):8-13. 

79. Kolltveit K M , Solheim T, Kvaal SI. Methods of measuring 
morphological parameters in dental radiographs: Comparison between 
image analysis and manual measurements. Forensic Sci Int 1998;94:87-95. 

80. Nambiar P, Bridges TE, Brown K A . Quantitative forensic evaluation of 
bite marks with the aid of a shape analysis computer program: part 1; the 
development of "SOP" and the similarity index. / Forensic Odontostomotol 
1995;13(2):18-25. 

81. Nambiar P, Bridges TE, Brown K A . Quantitative forensic evaluation of 
bite marks with the aid of a shape analysis computer program: part 2; 
"SOP" and bite marks in skin and foodstuff. / Forensic Odontostomotol 
1995;13(2):26-32. 

82. Brook A H , Pitts NB, Renson CE. Determination of tooth dimensions 
from study casts using an image analysis system. / Int Assoc Dent Child 
1983;14:55-60. 

83. Atsu SS, Gokdemir K, Kedici PS, Ikyaz YY. Bitemarks in forensic 
odontology. J Forensic Odontostomotol 1998;16(2):30-34. 

84. McGivneyJ, Barsley R. A method for mathematically documenting 
bitemarks. J Forensic Sci 1999;44(1):185-186. 

85. Bowers CM, Johansen RJ. Photographic evidence protocol: the use of 
digital imaging methods to rectify angular distortion and create life size 
reproductions of bite mark evidence. ]Forensic Sci 2002;47(\):\78-\85. 

86. Karazalus CP, Palmbach TT, Lee HC. Digital enhancement of sub-
quality bitemark photographs. J Forensic Sci 200l;46(4):954-958. 

87. Pretty IA, Sweet D. Digital bite mark overlays-an analysis of 
effectiveness. JForensicSci 2001;46(6):1385-1391. 

121 



References 

88. Robinson E, WentzelJ. Toneline bite mark photography. J Forensic Sri 
1992;37(l):195-207. 

89. Nam AS, Dykes E. Digital image cross-correlation technique for bite 
mark investigations. Sri Justice 1997;37(4):251-258. 

90. Brunette D. Critical Thinking. London; Quintessence Books, 1996. 

91. Streiner DL, Norman GR. Health Measurement Scales. A practical guide 
to their development and use. Oxford; Oxford University Press, 1989. 

92. Mendenhall W. Introduction to Probability and Statistics. 5 t h Edition, 
North Scituate, MA; Duxbury Press, 1979. 

122 



Appendix A 

Appendix A 

Study Cast 

Images 

1 2 3 



Appendix A. 

CASTA 

124 



Appendix A 

CAST B 

125 



Appendix A 



Appendix A 

C A S T D 

127 



Appendix A 

CASTE 

128 



Appendix A 

CAST F 

129 



Appendix B 

Appendix B 

Study 

Questionnaire 

130 



Appendix B 

Bitemark Study Questionnaire Participant Code 

Please circle the appropriate responses: 

1. Research study group D A B F O Forensic Dentist Dental Student 

Basic Computer Assessment 

2. I use computers: everyday weekly monthly seldom never 

3. I routinely use computers for: (circle all the apply) 

internet/email word processing/spreadsheet use photo imaging programs 

4. I am familiar with and have used Adobe Photoshop®. yes no 

5. If you answered yes to #4, I use Adobe Photoshop® for: (circle all that apply) 

Personal photographs Graphic design elements/Web site design Bitemark case analysis 

Bitemark Assessment 

6. The number of bitemark cases I have been involved in is: 0 1-3 4-7 7-10 
more than 10 

7. I am familiar with the use of computer generated overlays for bitemark analysis: yes no 

8. I have experience with the production of computer generated overlays for bite mark analysis: 

yes no 

9. If you answered yes to #8, how many overlays have you produced in your career: 

1-3 4-7 7-10 more than 10 
10. I have received specialized training in the production of computer generated ovedays: 
(through C E courses, symposiums, workshops, etc.) 

yes no 

11. I use the following software in the production of computer generated ovedays: 

Adobe Photoshop® 5.0 Adobe Photoshop® 6.0 Adobe Photoshop® 7.0 
Other 
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T e c h n i q u e A I n s t r u c t i o n s 

1. Open up the image in Adobe Photoshop®. (The following are for 
illustrative purposes only and are not life size.) 

2. From the Menu Bar, select View > Zoom In, until you are at a 
magnification in which you can comfortably see the incisal edges of the 
anterior teeth. 

3. From the Toolbox, select the Magic Wand tool. If you have trouble 
locating the Magic Wand icon, simply hold your cursor over each icon 
and the title of the icon will be displayed. 

4. Before we begin, make sure that in the menu on the top, Anti-Aliased is 
unchecked and Contiguous is checked and our initial Tolerance setting is 
18. To create an overlay, you will be selecting the biting edges of the 
twelve anterior teeth. The biting edges of the teeth are selected using the 
Magic Wand Tool. 
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5. Position the Magic Wand tool over each tooth's biting edge to select it. 
An outline of "marching ants" should appear. 

6. To add to the selected area of the tooth or to continue to outline the 
remaining biting edges, the Shift key must be held down while clicking on 
additional areas. Select all biting edges for the twelve anterior teeth. 

7. If you make a selection that you do not want to include in your final 
outline, simply click Ctrl +Z or (Command +Z for the Mac) and 
Photoshop will step back one step to the previous selection. Please note: 
the "Tolerance" setting may need to be reduced if unwanted areas are 
being selected. This can be done at your discretion at any time until you 
have achieved the outline of all maxillary and mandibular anterior teeth 
that you believe are most likely to leave an imprint while biting. Your 
figure should look similar to the one below. 

Creating a New Layer in Photoshop 

8. From the Menu Bar, select Layer > New > Layer. This will open a pop­
up window. The default title of the new layer is 'Layer 1'. Rename this 
layer 'Overlay'. Click OK. 
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In the Layers Palette, the new layer called Overlay is now positioned above the 

'Background' layer. This layer is highlighted and shows a paint brush in the 

second column, which indicates that it is the active layer you are working in. See 

Figure below. 

Layers 
~~ , —,—-
(Normal [*J Opacity: |1Q0^ | ± | 

Lock: r a r # r * r a 

Highlighted 
Active Layer 

Overlay 

ij*yj3j-Dj_gaLBi \/A 

9. Click on the 'Background' layer so that it becomes the active layer you are 
working in. 

10. From the Menu Bar, select Edit > Copy. 

11. Click on the 'Overlay' layer to now activate that layer. 

12. From the Menu Bar, select Edit > Paste. The biting edges of the casts 
that you selected are now pasted into the 'Overlay' layer. 

13. From the Menu Bar, select Select > Reselect. An outline of "marching 
ants" should reappear. 
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14. From the Menu Bar, select Edit > Clear to remove the noise from inside 
the marching ants. 

Creating a Hollow Volume Overlay 

15. We want to outline the biting edges at the position of the "marching ants" 
to create a hollow volume of the teeth. From the Menu Bar, select Edit 
> Stroke. A pop-up window will appear. Choose a stroke with the 
following values: Width = 2, Color = Black, Location = Inside, Blending 
= Normal and 100%. Click OK. 

These two last steps have a) cleared the center area resulting in a hollow 
volume of the teeth and b) outlined the biting edges with a solid line 2 
pixels wide. 

16. From the Menu Bar, select Select > Deselect to remove the marching 
ants. See Figure below. 
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Saving the Overlay 

17. Create a new folder on your desktop labeled "Technique A". Do this by 
minimizing all your active windows, Right-Click in a blank area on your 
desktop and selecting New > Folder. 

18. Bring Photoshop® back into view. Go to the Menu Bar, select File > 
Save As and save the current file in the new folder Technique A. 

19. Once you have completed all the overlays for both techniques, save them 
to the CD-ROM. See the instructions for this following the instructions 
for Technique B. 
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Technique A Example 

1) Open image in Photoshop® 

aflsH;:}J3|Adobe Photoshop s ^ L a o | ^ ' M i ' i ' P M 

2) Zoom-in to magnify the incisal edges of the anterior teeth 
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3) Select the incisal edges using the Magic Wand Tool 

4) Copy the selected areas into a new layer called 'Overlay' 

£U3 ic t« . r « r » i 

a o < * . asm mm aaa • M £ M » M ~ gBStaitj |g|A*uibe PhoKnhon jgJMiaottfr PamaPont ;A 
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5) Clear the center noise and stroke the perimeter of the teeth 
on the inside with a 2 pixel black line 

6) Deselect background image of casts and save the overlay 
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Appendix D 

Technique B 

Instructions 

and Example 



Appendix D 

T e c h n i q u e B I n s t r u c t i o n s 

1. Open up the image in Adobe Photoshop®. 

Selecting- the Edges 

2. From the Menu Bar, select Filter > Stylize > Glowing Edges. Accept the 
default settings of Edge width =2, Edge Brightness = 6, Edge 
Smoothness = 5. Your image should now look similar to the figure 
below. 

3. From the Menu Bar, select Image > Adjust > Invert. 
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4. Now define the perimeters of the biting edges of the teeth. From the 
Menu Bar, select View > Zoom In. Repeat the Zoom In step until you 
are at a magnification in which you can see the incisal edges of the upper 
and lower anterior teeth. Your image should appear similar to the one 
shown below. 

Removing- Unwanted Areas 

5. From the Toolbox, select the Eraser Tool. 

6. To remove large, unwanted areas, use an Eraser size such as 19. To select 
an Eraser size, simply look under the main Menu Bar, at the Eraser 
Options Bar. Enter the new size in the box. Choose a large size to 
remove the posterior regions of the casts, and then select a smaller 
number (like 3 or 5) to remove around the perimeter of the anterior 
biting edge surfaces. 

7. To erase an area, hold the Eraser tool over an area and depress the mouse 
button. Continue holding the button as you sweep over the areas to 
erase. Continue erasing the unwanted areas until you are left with an 

143 



Appendix D 

outline of the biting edges of all six upper and lower anterior teeth. See 
Figure below. 

•OOMJ %tr. 4*,TM/JMU r <3K*w4»m*> *• —* W ' UM W . M . — W » WWim tpH.1. 

Saving the Overlay 

8. Create a new folder on your desktop labeled "Technique B". Save the 
overlay you just produced in this new folder. 

9. You have now completed the first image. Once you have completed all 
the overlays for both techniques, save them to the CD-ROM. 
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Technique B Example 

1) Open image in Photoshop® 

I II I ^ T Z E i 
; £Se Edit Image lajw- Setect fillet • H«w.- Muvim Be|P-:: •: 

2) Zoom-in to magnify the incisal edges of the anterior teeth 
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3) Select Filter > Stylize > Glowing Edges 

4) Select Image > Adjust > Invert 

iM :i*t Iwase Im' i « - tMp 
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5) Erase unwanted areas until you are left with an outline of the 
incisal edges of the anterior teeth 

6) Continue to erase separating the individual anterior teeth 
and save the overlay 
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Appendix E 

Follow-up 

Questionnaire 
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AppendixF 

Examiner 

Data Reports 
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Area Data Report - D l 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 7.89 3.21 4.99 5.08 6.14 7.14 3.07 3.35 9.98 7.17 6.88 7.14 
7 6.65 8.26 11.35 11.35 9.29 9.43 15.05 15.28 7.28 6.37 10.58 8.37 
8 14.14 14.39 14.77 13.96 12.87 13.10 17.75 17.55 10.55 11.38 18.35 17.12 
9 10.75 10.55 15.54 12.62 18.01 18.18 15.37 15.77 11.78 9.52 17.26 15.86 
10 8.17 8.92 8.32 8.95 7.48 8.63 15.83 16.17 4.04 4.01 10.95 11.15 
11 8.72 8.34 7.94 8.72 5.48 6.34 10.35 11.24 5.28 8.32 11.56 7.77 
22 9.29 8.20 2.92 5.33 9.81 9.84 14.51 7.00 6.45 4.39 8.00 15.00 
23 8.49 7.89 7.57 4.42 7.83 8.89 8.26 7.63 6.85 6.14 8.95 9.49 
24 7.94 7.20 9.03 9.15 9.29 9.29 7.63 7.37 5.28 5.65 7.40 7.63 
25 6.77 6.39 8.29 7.48 8.14 8.29 8.06 7.63 5.22 5.42 7.46 8.46 
26 6.74 6.51 6.54 5.94 9.63 7.97 9.06 8.52 6.42 8.49 8.14 9.18 
27 14.31 10.98 7.43 4.33 3.04 8.09 7.94 4.22 9.95 9.18 8.29 6.19 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 16.17 16.40 15.00 17.66 19.27 19.18 7.80 5.33 19.81 18.18 17.89 19.61 
7 16.29 15.51 19.24 19.87 14.94 15.77 24.54 23.17 13.28 13.65 15.17 15.31 
8 21.53 22.05 22.51 22.11 19.56 20.90 26.38 21.16 17.41 19.56 16.34 18.15 
9 15.86 17.41 21.53 22.42 27.96 27.70 23.25 20.42 17.95 18.72 17.55 17.55 
10 17.29 18.44 18.12 18.61 13.42 13.39 24.34 23.97 8.37 9.52 18.47 15.71 
11 13.42 15.68 14.31 19.84 17.09 17.63 19.33 18.04 22.14 23.86 19.84 23.74 
22 15.68 16.97 22.48 19.73 14.16 19.21 14.16 17.38 15.14 20.59 22.42 24.49 
23 27.93 15.25 11.58 11.90 16.29 15.25 14.54 14.45 13.16 14.80 13.65 12.67 
24 12.39 12.33 13.36 14.68 17.06 18.06 11.7 11.76 12.22 11.76 11.01 11.61 
25 11.64 11.27 13.42 14.68 13.85 13.13 13.28 13.91 13.48 13.08 13.13 12.87 
26 15.91 16.60 12.67 13.22 14.91 14.11 13.91 13.22 15.60 15.23 14.22 16.54 
27 12.13 18.29 15.83 19.15 16.46 18.47 18.49 18.21 16.75 16.43 19.13 18.52 
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Position Data Kcpnn - 1)1 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD Cast_ L ^ L 1 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5264 38.45 5293 3826 5269 46.69 5270 46.18 51.72 44.91 51.86 45.05 50.73 37.38 50.79 36.98 54.58 39.37 53.84 39.69 50.24 2810 50.43 26.10 

7 58.40 3296 5847 3290 60.13 4218 60.13 41.67 57.67 40.60 57.91 40.51 55.87 37.75 56.33 37.76 61.13 37.19 61.24 37.27 56.56 2271 56.84 20.53 

8 66.37 29.36 6627 29.40 65.54 37.56 65.79 37.09 64.93 34.09 64.93 34.10 64.11 34.15 64.50 34.17 66.07 33.60 66.43 33.71 64.93 1827 64.78 16.13 

9 75.27 29.44 75.17 29.45 74.23 37.57 73.71 36.99 73.54 34.71 73.70 34.73 7207 33.03 7238 33.02 74.29 33.26 74.02 33.14 74.55 1808 74.69 15.94 

10 8259 33.83 8237 33.74 79.33 4229 79.39 41.75 81.60 3893 81.80 38.90 80.32 35.83 80.68 35.84 80.70 36.18 80.80 36.26 8240 21.84 8254 19.81 

11 87.91 40.18 87.79 40.04 86.88 47.25 86.59 .46.38 87.80 43.36 87.89 43.30 87.53 3817 87.73 38.19 86.16 39.81 86.26 40.33 8814 26.95 89.00 25.20 

22 80.73 104.82 80.59 104.83 85.34 100.38 85.02 99.87 87.05 9894 87.22 98% 85.78 103.78 85.63 104.19 85.71 100.47 85.05 101.45 81.96 116.28 8268 113.18 

23 75.56 10855 75.48 10849 81.22 99.72 80.96 9894 81.98 101.71 8235 101.54 79.92 106.52 80.33 106.48 80.01 103.84 79.77 103.97 76.13 118.50 76.09 116.44 

24 69.55 110.27 69.09 110.32 75.62 101.90 75.48 101.34 76.45 104.97 76.64 104.97 74.29 107.36 74.75 107.43 74.51 106.13 74.34 106.08 70.26 120.51 70.41 118.46 

25 64.09 109.51 64.03 109.51 69.85 101.54 69.80 101.08 71.73 103.71 71.88 103.69 68.51 107.61 69.03 107.61 69.30 106.19 69.31 106.24 64.16 120.06 64.24 118.08 

26 57.58 107.82 57.33 107.74 64.97 98.35 65.13 9818 65.58 103.33 65.92 103.27 6293 106.51 63.34 106.59 63.90 104.20 64.12 104.10 5809 117.74 58.34 115.69 

27 5229 103.34 5226 103.62 59.59 95.99 59.81 95.26 59.93 101.58 60.24 101.73 57.11 105.48 58.16 106.04 5813 101.43 5810 101.47 51.99 115.42 51.95 113.22 

TechniqueB 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.47 20.17 36.11 2299 34.75 3250 34.75 3284 31.57 29.41 30.65 29.47 3211 17.58 31.33 16.85 35.07 48.10 35.36 47.64 34.24 14.60 34.07 15.05 

7 4219 14.58 4221 17.25 4263 27.62 4249 27.75 37.92 24.25 36.67 24.70 37.33 18.05 37.12 17.63 4295 44.61 43,11 44.69 41.12 878 41.03 883 

8 50.05 10.86 50.00 13.69 47.84 23.16 47.59 23.13 44.60 17.95 43.47 1824 45.62 14.30 45.20 13.72 47.69 41.01 47.89 41.06 49.02 3.92 49.24 3.98 

9 59.38 10.97 59.26 13.70 56.64 23.15 56.71 23.18 54.28 1885 52% 1883 53.63 13.22 53.73 1254 55.88 40.61 55.% 40.68 5889 3.71 58.91 3.68 

10 66.37 1507 66.39 17.81 6214 27.81 6203 27.78 61.53 2268 60.70 2293 61.71 15.98 61.56 15.65 6252 43.80 6249 43.75 67.40 ai5 67.45 7.98 

11 71.70 21.99 71.65 24.28 69.55 3296 69.89 33.12 68.17 27.47 67.07 27.66 69.41 1878 69.71 18.73 67.80 47.57 6805 47.42 73.73 13.35 73.81 13.74 

22 64.80 86.29 64.64 89.12 68.10 84.91 68.03 85.69 67.36 8287 65.78 8210 66.70 83.86 66.76 83.54 66.% 10819 67.41 107.80 67.94 100.32 67.90 100.09 

23 56.71 90.77 59.55 9271 63.25 84.85 63.40 85.06 6233 85.46 61.29 85.62 61.30 86.58 61.21 86.28 61.23 111.57 61.51 111.34 60.97 103.% 60.75 104.07 

24 53.41 91.69 53.21 94.20 57.82 87.39 57.93 87.43 56.60 89.00 55.67 89.13 55.79 87.44 55.44 87.07 55.98 113.47 56.14 113.50 54.87 106.28 54.% 10633 

25 47.84 90.89 47.67 93.57 5218 87.05 5215 87.09 51.95 87.60 50.83 87.79 50.15 87.75 49.80 87.46 50.47 113.46 50.77 113.38 4886 105.67 48.87 105.69 

26 41.66 89.44 41.63 9236 47.28 83.90 47.38 84.07 45.63 86.95 44.51 87.08 44.33 86.69 44.19 86.35 45.01 111.53 45.09 111.18 4275 103.25 4243 103.12 

27 36.66 84.80 36.42 87.00 41.57 8215 4222 8229 39.93 85.18 38.83 84.79 38.66 85.44 38.42 85.23 39.41 10873 39.49 10873 35.89 99.59 35.40 98.69 
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Area Data Report -1)2 

Technique A 
Tooth # Cast A CastB Cast C CastD Cast E Cast F Tooth # 

1 2 1 2 1 2 1 2 1 2 1 2 
6 1.98 2.06 4.96 5.42 4.22 4.22 0.00 0.00 2.90 3.41 6.11 5.82 

7 1.46 1.66 7.63 7.63 4.73 4.42 4.36 5.36 5.62 5.39 3.81 3.35 

8 3.41 3.50 6.19 5.22 5.79 9.86 3.13 4.07 5.02 6.08 2.98 4.62 

9 3.56 3.33 6.34 6.54 3.33 3.53 4.87 3.38 8.17 7.80 5.22 6.31 

10 3.44 3.35 8.00 8.09 2.55 1.72 3.07 3.10 2.52 3.15 2.87 4.65 

11 2.06 4.39 7.34 7.46 5.48 5.53 5.02 6.05 3.44 4.30 4.73 5.08 
22 10.47 2.75 0.95 2.18 4.42 4.22 4.56 4.59 1.41 1.38 1.66 1.66 

23 4.01 3.50 2.75 2.92 6.31 4.96 2.70 3.64 1.75 1.55 4.50 6.51 
24 6.16 3.35 5.13 6.16 7.68 8.97 5.02 3.99 3.38 3.33 6.57 6.59 

25 5.94 5.45 6.59 6.59 4.24 4.24 7.28 6.39 4.24 4.24 7.00 7.05 

26 3.38 3.53 0.23 2.52 4.01 1.38 5.28 5.28 3.78 4.24 1.92 5.65 

27 0.77 0.77 2.09 1.84 2.61 2.61 3.99 3.90 4.76 3.81 3.58 3.56 

Technique It 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 6.59 6.02 7.51 8.46 5.96 4.24 0.00 0.00 6.82 7.63 6.68 5.91 

7 10.52 11.56 18.92 15.60 10.15 7.57 12.33 19.41 9.09 11.10 4.99 3.38 

8 21.19 18.24 18.29 13.10 17.55 11.96 23.25 21.42 12.87 15.66 7.28 6.42 

9 17.41 11.3 13.59 14.45 25.95 11.61 16.89 18.70 11.56 12.76 7.80 7.51 

10 16.69 10.27 13.71 13.39 14.31 11.10 20.07 19.50 6.14 6.28 7.37 5.85 

11 8.49 8.66 12.44 11.01 14.05 8.11 12.04 11.07 4.27 4.01 12.24 10.55 

22 6.80 5.99 6.08 4.44 8.06 6.14 6.14 5.99 7.03 5.71 3.56 4.82 

23 13.19 11.84 9.09 5.82 15.48 9.52 11.93 11.96 9.78 7.20 9.89 7.11 

24 13.22 11.44 13.79 12.24 17.26 13.85 10.21 10.29 8.46 6.82 9.66 7.14 

25 11.18 9.89 12.59 9.06 13.28 11.53 10.87 11.07 9.09 8.52 9.78 8.49 

26 12.73 8.69 4.87 4.96 12.70 10.29 10.21 11.67 8.34 7.57 9.63 5.82 

27 3.15 6.68 8.29 9.98 4.82 4.44 5.45 4.99 9.12 12.30 7.17 4.65 
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Pcisiiinn Daia Report - D2 
Technit uc A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5253 37.75 5255 37.73 5286 46.70 5291 46.64 51.84 44.73 51.84 44.73 0.00 0.00 0.00 0.00 53.68 40.15 53.67 40.20 50.29 28.79 50.28 28.85 

7 59.27 31.45 59.32 31.48 60.36 4209 60.36 4209 58.11 40.07 58.11 40.07 54.10 37.20 54.02 37.22 61.20 37.47 61.18 37.50 57.06 2291 57.14 2292 

8 67.54 29.11 67.24 29.13 65.13 37.30 64.90 37.26 64.69 33.74 64.59 34.09 6244 33.54 6255 33.56 66.95 33.60 66.85 33.63 6262 18.36 64.64 18.35 

9 74.33 28.87 74.38 28.86 73.59 37.41 73.57 37.41 73.68 35.07 73.69 3508 71.93 3217 71.78 3212 73.62 33.35 73.65 33.34 74.83 1818 74.80 1827 

10 81.21 3263 81.18 3261 79.50 4227 79.50 4227 81.34 38.35 81.49 38.13 78.37 35.08 78.32 35.08 80.76 36.14 80.92 36.22 8279 2212 8233 2219 

11 87.54 38.85 87.40 39.36 86.89 46.97 86.86 4695 87.80 43.36 87.80 43.35 86.54 3800 86.39 38.00 86.26 39.26 8625 39.65 89.46 27.96 89.41 28.06 

22 79.88 104.63 79.50 105.69 85.52 99.99 85.41 100.33 87.01 99.12 87.00 99.09 83.37 104.65 83.36 104.66 84.92 101.97 84.91 101.97 8289 116.85 8289 116.85 

23 73.46 109.12 73.39 109.17 80.85 99.57 80.86 99.58 82.05 101.84 8214 101.77 78.88 106.78 78.95 106.78 80.22 104.11 80.31 104.10 76.11 119.32 76.20 119.24 

24 68.29 110.17 67.67 110.17 76.21 101.96 76.14 101.94 76.47 105.02 76.45 104.97 7278 107.27 7292 107.33 74.62 106.11 74.63 106.12 70.39 121.13 70.37 121.14 

25 63.35 109.38 63.25 109.36 70.02 101.61 70.02 101.61 71.89 104.00 71.89 104.00 67.22 107.46 67.48 107.47 69.59 106.22 69.61 10622 64.31 120.68 64.35 120.68 

26 56.77 107.89 56.70 107.83 66.72 99.82 65.70 99.29 65.88 103.54 66.84 104.15 61.35 106.65 61.36 106.65 64.41 104.16 64.50 104.19 59.97 119.08 58.50 118.53 

27 51.87 103.67 51.87 103.67 59.96 97.32 59.92 97.28 59.87 101.52 59.87 101.52 56.29 105.90 56.28 105.89 58.96 10203 59.08 10215 51.88 115.99 51.87 115.99 

Technic ue B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.28 2210 37.13 2221 35.22 3235 28.35 31.06 31.76 28.94 31.93 28.70 0.00 0.00 0.00 0.00 35.05 47.77 34.46 47.71 33.30 14.21 33.64 13.49 

7 4237 17.11 4222 17.30 4276 27.7 35.92 26.55 38.43 23.92 38.22 24.34 37.34 17.60 34.78 17.44 4263 44.84 4201 44.80 40.14 an 40.49 7.42 

8 50.09 1359 50.26 13.65 47.97 23.09 40.63 21.62 44.92 17.85 44.53 17.87 45.49 14.27 4279 13.80 47.55 41.03 47.19 41.09 47.75 159 48.12 291 

9 59.68 13.72 59.64 13.52 56.33 2292 49.34 21.72 53.96 18.61 53.26 18.26 53.99 13.09 50.90 1271 55.17 40.76 54.91 40.68 57.76 3.49 58.01 282 

10 66.43 17.95 66.52 17.81 61.86 27.81 55.07 26.64 61.76 2283 61.81 2295 61.76 16.00 59.08 15.46 6239 43.81 61.76 43.72 65.75 7.53 65.99 686 

11 7200 2396 7201 23.91 69.49 3268 6249 31.55 67.83 2697 67.99 27.27 68.76 18.21 66.10 17.68 67.48 46.29 66.82 46.26 71.28 1299 71.77 1235 

22 64.24 90.19 64.13 90.21 67.72 86.46 60.82 85.07 67.12 83.00 67.19 8293 66.21 85.08 63.52 84.51 66.77 108.73 66.00 108.77 65.17 10262 65.74 101.49 

23 59.41 92.86 59.43 9270 63.58 84.74 56.57 83.81 6235 85.41 6230 85.78 61.35 86.68 58.61 86.13 61.17 111.43 60.98 111.45 59.29 104.43 59.59 10380 

24 53.30 94.47 53.27 94.52 58.00 87.43 50.91 86.28 56.74 88.92 56.61 89.05 55.77 87.61 5298 87.03 55.97 113.69 55.16 113.65 53.40 106.44 53.73 105.74 

25 47.80 93.68 47.95 93.76 5221 87.31 45.31 85.88 51.99 87.65 51.98 87.76 50.11 87.86 47.42 8728 50.55 113.42 49.70 11133 47.25 105.96 47.77 105.29 

26 41.54 9208 41.51 91.98 47.89 84.76 41.09 8374 45.60 8691 45.77 87.21 43.95 86.92 41.58 86.20 44.85 111.30 43.97 111.15 41.49 103.64 41.51 103.06 

27 37.38 8(5.25 3656 88.78 4203 81.34 35.01 80.6 40.03 85.12 40.01 85.37 39.01 85.81 36.46 85.45 39.57 10883 38.70 108.68 35.17 101.19 35.81 100.97 
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Area Data Report - 1)3 
Technique A 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 3.64 3.99 7.71 7.68 6.22 7.51 6.51 4.47 8.95 7.11 8.11 7.31 
7 9.69 8.60 13.53 12.65 11.33 10.15 9.12 17.23 8.92 10.47 12.07 10.04 
8 12.47 10.70 15.68 15.74 14.14 14.45 20.19 20.10 15.37 12.01 13.36 14.77 
9 10.04 12.10 14.97 14.42 21.30 20.07 18.95 15.68 13.19 12.24 13.13 13.08 
10 9.03 10.44 11.21 10.92 8.23 9.58 17.95 17.92 5.48 6.22 10.49 6.97 
11 10.84 6.71 9.86 8.14 7.80 8.11 10.84 8.32 10.06 7.23 12.56 8.52 
2 2 4.16 4.24 8.52 10.29 10.75 5.85 4.47 5.91 6.57 5.08 7.05 5.30 

2 3 10.58 10.24 6.19 7.28 10.38 10.18 11.44 11.93 8.77 4.99 7.43 7.25 
2 4 8.06 7.77 11.15 9.43 12.50 11.70 9.38 9.41 7.46 5.30 7.31 7.89 
2 5 7.86 8.00 9.86 9.41 9.38 9.52 9.89 10.09 7.11 5.62 7.80 8.03 
2 6 9.12 8.89 9.00 8.97 12.19 9.66 10.81 10.52 10.81 6.71 6.74 9.72 

2 7 5.71 5.19 10.12 8.54 16.72 4.87 6.19 6.11 11.33 10.35 7.74 6.62 

Technique B 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.55 3.27 6.54 4.73 7.11 4.65 4.47 9.29 4.07 1.75 6.39 4.93 

7 10.78 10.27 16.37 10.87 14.91 10.52 21.51 12.96 10.27 5.99 13.99 10.67 

8 16.89 12.85 20.19 14.16 19.67 17.35 24.03 16.66 16.72 11.01 19.78 14.25 

9 11.99 13.76 14.91 12.76 24.40 13.16 21.94 11.56 14.65 IM 17.98 11.50 

10 12.70 10.95 12.85 10.29 12.99 5.02 22.57 15.37. 7.89 5.28 15.37 10.29 

11 6.22 5.65 7.48 6.59 12.67 4.42 9.29 9.23 4.47 3.30 12.39 8.66 

2 2 4.39 2.95 4.22 3.15 6.25 3.15 7.57 3.67 6.68 8.66 2.70 2.06 

2 3 12.73 11.87 11.58 4.16 13.85 7.20 13.36 7.86 9.12 5.19 9.46 7.46 

2 4 10.75 9.75 11.84 7.40 13.79 7.57 10.49 6.11 8.66 6.22 9.35 7.94 

2 5 8.95 8.69 10.67 6.34 12.22 5.16 11.01 5.76 8.40 4.90 10.04 7.31 

2 6 10.72 10.29 5.36 2.29 12.07 7.28 12.82 7.11 10.47 5.10 9.32 3.78 

2 7 3.70 2.49 2.84 2.87 3.93 2.87 4.62 2.87 11.96 3.53 4.44 2.35 
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Appendix F 

Position Data Report - D3 
Technic [ue A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.09 37.88 5295 37.88 5299 46.72 5298 46.71 51.90 44.84 5215 44.65 51.09 37.87 51.18 37.71 54.27 39.99 53.94 40.04 50.43 29.10 50.48 28.80 

7 58.29 3291 5850 3271 60.47 4226 60.44 4227 57.69 40.83 57.87 40.62 55.68 37.47 55.86 37.73 61.50 37.50 61.36 37.36 56.96 23.50 56.85 23.33 

8 65.78 29.18 65.84 29.22 65.89 37.79 65.94 37.79 64.53 34.24 64.% 34.08 64.18 34.17 64.33 34.01 66.83 34.04 66.53 33.86 64.62 1868 64.59 18.72 

9 75.25 29.37 74.94 29.42 73.96 37.70 73.87 37.68 73.56 34.99 73.71 34.85 7211 33.12 7234 3284 74.22 33.54 73.91 33.55 74.82 1847 74.63 18.47 

10 82.16 33.59 8201 33.75 79.52 4238 79.54 4243 81.53 3891 81.76 3891 80.48 35.86 80.48 35.69 80.98 36.38 80.70 36.39 8289 2249 8288 2236 

11 87.54 40.03 87.63 39.58 86.85 47.10 86.81 46.92 87.71 43.48 87.87 43.31 88.07 3845 87.86 37.97 86.12 39.23 86.29 40.01 88.55 27.61 89.18 27.86 

22 79.96 105.87 79.79 105.87 85.20 100.42 85.18 100.43 87.05 99.18 . 87.16 99.21 84.86 104.68 84.89 104.67 85.54 101.30 85.31 101.60 8262 116.75 8248 116.81 

23 75.30 10846 75.13 10848 81.13 99.77 81.12 99.82 8201 101.87 8215 101.76 80.03 106.66 79.99 106.44 80.36 104.03 79.80 104.32 76.48 119.31 76.31 119.21 

24 6890 110.38 6854 110.35 75.60 10210 75.92 10216 76.46 105.24 76.67 104.99 74.27 107.44 74.37 107.25 74.66 10625 74.60 106.28 70.65 121.22 70.49 121.19 

25 63.71 109.54 63.45 109.53 69.89 101.78 69.87 101.76 71.78 103.90 71.94 103.74 68.67 107.61 6878 107.51 69.51 10631' 69.50 106.35 64.55 120.72 64.47 120.66 

26 57.23 107.83 57.07 107.87 65.14 98.85 65.17 98.84 65.78 103.58 65.61 103.24 6293 106.60 63.03 106.46 64.32 104.20 64.11 104.20 5875 118.55 5845 118.28 

27 5238 104.17 5226 104.24 59.88 96.65 59.55 96.33 60.02 101.21 60.14 101.66 57.8 106.11 57.84 105.97 58.45 101.64 58.25 101.49 5239 115.98 5207 115.83 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.20 2230 37.01 2229 35.38 3228 35.40 3259 31.54 29.40 31.77 29.26 30.18 20.90 29.85 2201 35.72 46.% 35.76 47.06 33.78 13.47 34.01 15.42 

7 4244 17.23 4230 17.20 4293 27.66 43.07 27.80 37.% 24.55 38.05 24.44 37.40 20.08 36.97 20.06 4263 45.18 4259 45.26 39.86 844 40.18 10.15 

8 50.23 13.74 49.63 13.34 48.02 23.18 48.30 23.24 44.54 1814 44.41 1830 45.61 1651 45.67 16.32 48.07 41.24 4814 41.39 4811 3.58 48.17 5.53 

9 60.11 13.73 59.42 13.71 56.44 23.01 56.51 23.04 53.87 1874 53.97 19.00 53.76 15.38 53.58 15.35 55.59 40.91 55.49 41.04 57.97 3.27 58.05 5.05 

10 66.42 17.91 66.50 1805 6204 27.85 6222 27.90 61.68 2292 6200 23.09 6200 1825 61.88 18.10 6268 43.98 6269 44.06 66.67 7.58 66.93 9.54 

11 7229 23.94 7222 24.10 69.72 33.00 69.73 3274 67.87 27.11 68.13 27.69 69.61 20.75 68.77 20.26 67.66 46.45 67.80 46.39 71.75 1228 7208 14.40 

22 65.10 8803 65.09 8824 68.12 86.45 68.10 86.50 67.29 83.20 67.36 83.24 66.10 87.25 66.18 86.97 67.33 10868 67.12 109.11 66.48 101.34 66.66 103.27 

23 59.71 9271 59.65 9274 63.95 85.44 63.69 85.16 6224 85.74 6234 86.07 61.36 8882 61.15 88.68 61.92 111.67 61.47 111.83 59.77 103.77 59.93 105.88 

24 53.50 94.54 53.49 94.55 58.10 87.46 58.44 87.52 56.74 89.03 56.91 89.06 55.87 89.72 55.51 89.83 56.20 113.73 56.23 113.91 53.98 105.73 54.01 107.74 

25 47.99 93.67 47.91 93.66 5248 87.31 5248 87.48 51.% 87.89 5225 8809 50.13 90.07 50.40 89.91 51.13 113.90 51.12 114.03 47.81 105.30 48.06 107.35 

26 41.49 9210 41.43 9204 48.29 84.72 48.43 85.17 45.72 87.14 46.15 87.56 44.49 8887 43.80 89.08 45.46 111.71 45.63 11212 4204 103.04 41.97 105.38 

27 36.53 8824 37.23 89.17 41.79 80.47 4252 8295 39.95 85.41 39.99 85.45 39.17 8822 38.85 87.99 39.83 109.16 40.68 109.99 35.07 99.96 35.52 10273 

156 



Appendix F 

Area Data Report - 1)4 

Technique A 
Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 

1 2 1 2 1 2 1 2 1 2 1 2 

6 1.75 1.55 4.27 4.96 4.04 3.24 0.00 0.00 3.30 2.04 5.82 3.99 

7 4.42 3.96 9.98 11.93 4.42 3.30 12.56 12.53 5.19 4.85 8.86 6.31 

8 13.16 11.30 6.68 12.59 9.26 10.41 15.40 11.93 9.26 6.88 14.65 12.59 

9 8.60 7.11 10.98 11.56 18.12 15.20 13.53 10.21 7.28 7.83 14.82 12.62 

10 7.14 6.31 7.46 7.89 5.45 5.13 9.12 10.27 2.70 2.38 12.04 3.93 

11 5.53 4.96 7.08 8.20 5.48 4.01 6.11 4.90 3.33 2.06 10.49 7.11 

2 2 1.92 6.77 4.04 1.12 3.93 3.35 4.42 3.70 2.47 1.26 4.44 3.53 

2 3 7.31 6.48 1.78 2.52 6.45 4.90 9.23 6.85 3.10 3.07 6.19 5.68 

2 4 5.16 4.39 7.05 6.37 7.57 7.71 6.62 4.96 2.38 2.21 6.94 6.16 

2 5 5.19 4.73 6.91 4.42 4.33 3.73 6.59 6.57 4.24 3.81 7.34 6.65 

2 6 5.33 2.84 4.62 5.13 6.59 4.19 5.96 4.42 3.21 2.52 5.85 4.44 

2 7 1.18 1.81 2.98 1.63 2.49 1.49 3.90 2.32 1.66 1.29 4.22 3.10 

TechniqueB 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.02 6.28 8.54 8.66 8.06 9.23 0.00 0.00 7.05 8.95 7.97 7.28 

7 9.15 10.78 19.13 11.87 14.16 12.16 19.64 16.89 9.92 11.30 17.46 13.48 

8 19.3 17.92 21.56 21.28 17.69 17.12 24.80 24.37 16.69 19.24 28.82 33.32 

9 14.82 13.48 21.79 16.00 20.85 19.67 20.04 20.50 13.99 14.16 27.96 33.15 

10 15.31 15.60 17.75 16.26 13.59 11.76 18.72 18.35 8.49 10.52 25.29 19.30 

11 11.90 8.83 11.27 11.35 11.70 8.86 10.18 6.54 4.99 4.13 18.21 14.82 

2 2 7.60 6.14 3.44 6.19 9.23 6.16 7.43 7.97 8.97 9.61 6.31 9.23 

2 3 11.38 14.51 6.11 4.62 13.36 9.95 14.45 17.06 9.15 11.7 6.57 8.60 

2 4 11.67 10.78 13.56 9.49 16.72 13.59 10.67 13.51 10.09 11.61 10.58 7.91 

2 5 10.64 10.92 10.58 14.97 13.28 10.44 11.15 12.33 11.96 10.35 12.67 11.24 

2 6 14.16 10.92 11.30 11.58 13.19 13.71 13.05 15.23 14.34 15.40 14.19 12.87 

2 7 3.84 5.65 8.32 8.83 4.90 4.99 8.69 7.57 12.59 15.63 10.35 6.71 
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Appendix F 

Podium Dai.i Report -1)1 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5275 37.90 5287 38.15 5279 46.94 5286 47.04 51.84 44.89 51.87 44.80 0.00 0.00 0.00 0.00 5181 40.10 5198 39.46 50.28 2885 49.90 28.82 

7 57% 3292 58.26 33.00 60.50 4229 60.57 4239 58.11 40.24 58.07 40.30 5442 37.75 54.52 37.75 61.17 37.67 61.01 37.70 56.80 2135 56.55 23.32 

8 65.72 29.39 65.65 29.67 65.45 37.52 66.10 37.95 64.14 34.07 64.78 34.17 6115 34.18 63.63 34.07 66.47 3181 6667 33.87 64.64 18.84 64.88 18.82 

9 75.CK 29.47 7520 29.61 73.98 37.64 74.06 37.77 73.53 34.91 73.47 34.82 71.07 3109 70.52 33.15 715 33.53 73.50 33.47 74.75 18.72 74.48 I860 

10 81.% 33.87 8203 33.89 79.31 4238 79.46 4261 81.67 39.07 81.76 39.01 78.72 35.61 79.38 35.85 81.01 36.49 80.99 36.57 8241 2269 8222 2205 

11 87.48 39.63 87.66 39.77 86.89 47.16 86.84 47.29 87.80 4153 87.87 4147 86.55 5U16 86.66 38.02 86.24 39.43 85.98 38.99 8847 27.73 88.97 27.89 

22 79.72 105.96 80.37 104.75 85.13 100.75 85.37 100.61 87.00 99.25 87.04 99.28 83.52 104.83 83.45 104.63 85.51 101.23 85.94 100.99 8231 116.84 8251 116.82 

23 7505 10843 75.15 108.64 80.56 99.77 80.86 99.91 8211 101.95 8219 101.85 78.69 106.65 78.69 106.26 79.61 104.38 79.81 104.27 7616 119.35 7619 119.16 

24 68.47 110.36 6860 110.47 75.72 10206 75.7 10207 76.49 105.20 76.56 105.12 7298 107.45 7294 107.14 74.42 106.29 74.18 10627 70.35 121.22 7027 121.17 

25 63.46 109.54 63.58 109.70 69.99 101.73 69.94 101.81 71.85 104.17 7201 104.13 67.48 107.62 67.43 107.45 69.41 106.29 69.34 10638 64.33 120.76 64.37 120.65 

26 56.81 107.78 5673 107.90 65.43 98.96 65.13 9a86 65.28 103.30 65.49 103.37 61.32 106.68 61.46 106.57 64.28 104.22 64.07 104.29 58.42 118.54 58.05 118.38 

27 5208 10348 51.87 103.84 59.52 96.57 59.64 97.06 59.86 101.69 59.71 101.58 56.45 106.06 56.13 105.29 57.84 101.62 57.71 101.52 51.71 115.88 51.80 116.01 

Technic u c B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.73 2252 37.08 22.27 35.36 3220 35.32 3219 31.40 29.17 31.66 29.41 0.00 0.00 0.00 0.00 34.78 48.02 35.36 47.99 33.65 13.11 33.84 13.46 

7 4240 17.12 4225 17.22 4287 27.71 4299 27.93 37.72 24.72 37.76 24.87 37.30 19.96 37.52 20.14 4244 45.45 4109 44.99 39.% 8.23 39.70 9.00 

8 49.85 1175 50-18 13.60 48.43 2327 47.91 23.17 44.60 18.06 44.89 18.17 45.43 1643 45.43 16.42 48.03 41.37 48.21 41.16 47.98 4.47 48.19 4.28 

9 59.54 13.88 5888 13.79 56.78 23.15 56.10 23.07 53.84 1&53 53.79 19.02 53.59 15.20 53.17 15.38 55.34 40.91 55.53 40.86 57.72 4.09 57.92 4.02 

10 66.37 17.99 66.27 18.01 6222 27.90 6224 27.80 61.58 2288 61.75 2284 6205 1829 61.59 18.16 6253 4396 6258 43.% 66.12 7.63 65.% 7.58 

11 7201 24.21 71.91 24.02 69.72 3295 69.50 3271 67.84 27.52 68.18 27.80 69.30 20.61 69.02 20.70 67.70 46.51 67.66 46.28 7210 11.98 71.91 1232 

22 64.11 90.45 6179 90.52 69.61 84.35 67.88 8642 67.01 8149 67.03 8357 66.12 87.32 65.89 87.19 66.79 10&81 66.73 109.25 66.22 100.66 65.83 100.93 

23 59.38 9302 59.48 9279 63.89 84.99 6268 85.59 6215 85.77 6215 85.96 61.32 8890 61.19 88.68 61.15 111.52 61.60 111.59 60.09 103.77 59.80 104.11 

24 53.15 94.65 52% 94.57 58.25 87.48 58.65 87.56 56.59 89.20 56.65 89.15 55.76 89.68 55.71 89.60 55.53 113.47 56.09 11170 53.63 105.29 53.60 106.03 

25 47.59 9392 47.74 9367 5227 87.22 5254 87.49 51.87 87.86 51.85 87.95 50.23 89.98 50.11 89.62 50.44 11163 50.99 11164 47.72 104.72 47.81 105.29 

26 41.45 91.92 41.32 91.94 46.96 84.51 47.62 84.43 45.48 87.11 45.47 8721 44.36 89.06 44.13 88.62 45.21 111.43 45.25 111.15 41.62 102.42 41.68 10298 

27 3663 8658 3644 87.72 4264 8237 41.91 81.60 39.97 8567 40.10 85.42 39.10 88.38 38.84 87.86 39.87 109.13 39.42 108.63 35.50 100.07 34.86 100.23 
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Appendix F 

Area Data Report - D5 

Technique A 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t 1 Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.68 9.49 9.43 7.46 9.09 9.03 0.00 18.12 9.20 9.20 6.85 9.55 
7 10.58 6.88 13.53 13.10 11.35 10.58 17.26 16.92 8.92 9.43 13.39 10.55 
8 15.89 16.17 16.75 15.94 14.54 15.71 20.39 19.53 13.13 15.46 15.66 17.75 
9 12.39 12.13 17.43 13.76 20.16 20.16 18.27 17.58 12.56 12.62 16.09 16.83 
10 10.75 10.64 10.75 10.98 8.69 8.23 17.03 18.15 5.42 5.25 9.86 11.78 
11 7.11 10.95 10.44 10.81 8.43 9.03 13.59 13.51 6.14 7.31 11.56 12.33 
2 2 11.30 12.24 4.76 8.32 12.42 6.51 12.47 15.66 5.42 6.16 13.02 19.07 
2 3 10.32 10.52 6.28 7.77 11.56 10.01 7.37 6.42 6.48 7.05 7.83 7.46 
2 4 8.95 9.06 9.69 11.33 11.53 11.58 8.43 7.66 6.48 5.56 7.25 7.77 
2 5 7.91 8.11 9.98 9.35 5.56 9.58 9.46 4.70 6.02 5.94 8.00 ,8.46 
2 6 7.05 8.26 6.28 5.45 8.92 8.11 10.78 7.28 6.22 5.48 9.72 10.01 
2 7 2.98 13.65 7.63 3.61 6.57 5.02 6.37 6.85 9.78 10.01 13.82 6.82 

Technique B 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.33 6.11 9.84 6.11 10.87 9.86 17.32 23.46 10.38 7.83 8.06 13.99 
7 13.73 11.73 13.99 15.05 17.03 13.65 19.04 25.32 13.45 14.60 16.00 18.81 
8 19.10 20.47 19.13 20.16 26.49 23.17 25.52 23.46 15.20 16.54 18.81 32.95 
9 16.11 12.16 21.85 21.42 24.97 22.60 23.25 23.28 15.80 17.95 14.97 34.01 
10 15.66 12.53 17.38 14.19 14.65 11.93 19.64 24.40 7.00 7.14 16.03 17.63 
11 11.04 9.06 11.81 6.31 16.40 12.87 14.11 14.62 3.13 4.44 15.46 13.51 
2 2 6.97 10.06 11.10 12.39 8.00 5.53 7.40 7.83 7.66 7.00 5.10 6.74 
2 3 15.54 17.00 12.33 9.84 11.13 12.96 13.76 11.15 9.41 7.14 10.72 13.10 
2 4 11.38 10.84 11.15 13.30 12.47 16.03 11.41 12.47 8.52 10.44 10.72 10.24 
2 5 8.63 10.90 10.55 11.10 12.85 12.39 11.56 11.9 8.95 10.70 10.04 11.93 
2 6 11.96 10.35 7.20 7.60 12.16 10.21 11.41 11.93 10.55 10.38 11.84 12.39 
2 7 4.79 7.25 8.32 8.97 5.13 4.82 11.96 9.66 10.49 13.91 7.14 7.23 
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AppendixF 

Position D.u.i Report - 1)^ 
Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E Cast F 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 52.85 37.84 53.84 3801 5288 47.00 5293 46.76 51.73 45.39 51.76 45.35 0.00 0.00 50.94 39.12 54.41 39.75 54.27 39.93 50.43 2888 50.65 28.95 

7 58.30 3281 58.64 3294 60.64 4209 60.40 4226 57.86 40.83 57.81 40.83 56.90 37.91 57.38 38.21 61.50 37.50 61.54 37.42 56.64 23.74 57.06 23.34 

8 65.95 29.39 66.64 29.39 66.19 37.67 66.01 37.81 64.96 34.26 64.% 34.32 65.33 34.19 65.94 34.38 66.67 33.88 66.80 34.05 64.65 1892 65.40 18.95 

9 74.56 29.46 75.72 29.50 74.55 37.61 73.87 37.65 73.56 34.91 73.57 34.91 73.19 3308 73.71 33.25 74.03 33.58 74.01 33.63 74.81 1879 74.72 18.66 

10 81.83 33.77 8258 33.90 79.64 4222 79.55 4243 81.73 38.98 81.81 39.09 81.48 35.85 8201 36.03 81.06 36.46 80.99 36.37 8275 2253 8284 2257 

11 87.46 39.60 87.95 39.99 86.92 46.87 87.00 47.51 87.82 43.44 88.08 43.75 88.69 3838 89.06 38.47 86.40 39.31 8645 40.05 8841 27.72 88.58 27.63 

22 80.06 104.75 80.73 104.75 85.42 100.52 85.18 100.42 87.19 99.12 87.18 99.35 86.70 103.86 87.40 103.86 8564 101.40 85.38 101.42 8299 11573 8295 11581 

23 75.05 10844 75.67 10845 81.27 99.61 81.20 99.83 8234 101.78 8214 101.93 80.97 106.27 81.71 106.45 80.01 104.24 80.01 104.27 76.27 119.29 76.46 119.31 

24 6880 110.32 69.31 110.30 76.02 10200 75.56 10209 76.65 105.15 76.67 105.16 75.50 107.36 75.84 107.60 74.55 106.18 74.59 10621 70.49 121.22 70.62 121.20 

25 63.41 109.53 64.03 109.53 70.04 101.60 69.78 101.74 71.90 104.23 71.92 103.91 69.78 107.64 69.% 107.77 69.64 106.33 69.88 106.47 64.40 120.72 64.53 120.73 

26 56.74 107.84 57.61 107.93 65.26 98.66 64.80 9846 66.13 103.53 65.85 103.41 64.09 106.61 64.39 107.00 64.46 104.29 64.58 104.35 5851 118.39 5868 118.36 

27 5248 103.19 5225 103.53 59.90 96.62 59.90 97.42 60.12 101.98 60.17 101.87 58.85 106.14 59.53 106.41 5840 101.46 5862 101.64 51.61 114.63 5229 11593 

Technic] ueB 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.02 2221 37.17 2218 36.05 31.93 35.46 3237 31.72 29.04 31.28 29.19 30.29 20.83 29.91 21.18 35.26 48.04 34.87 47.88 3379 13.53 34.62 1298 

7 4263 1685 4269 17.17 4269 27.70 4243 27.87 37.84 24.24 37.99 24.39 37.26 19.96 37.37 20.03 43.01 44.92 4500 44.75 39.83 848 39.74 &82 

8 50.17 1361 50.26 1372 48.56 23.14 48.20 23.11 44.60 1854 44.47 1837 45.47 1650 45.14 16.51 47.63 41.20 47.97 41.11 4809 549 48.38 4.24 

9 59.42 13.65 59.37 13.44 56.95 23.16 56.% 23.19 53.93 1899 53.91 19.04 53.82 15.30 53.33 15.28 55.74 40.89 5554 41.03 57.67 3.64 57.82 4.05 

10 66.63 1808 66.54 1804 6245 27.80 6237 2800 61.60 23.06 61.94 2277 6211 1816 61.42 17.97 6294 44.18 6292 43.98 66.41 7.44 66.47 7.61 

11 71.94 24.46 71.83 24.14 69.84 33.51 70.01 3295 67.85 27.45 67.79 27.11 68.83 20.30 68.31 20.14 67.80 46.52 67.75 46.42 7208 1220 71.78 1227 

22 63.90 90.35 64.61 90.44 67.91 86.90 67.43 86.12 67.20 83.13 67.23 83.33 67.65 8812 65.98 8726 66.92 10893 66.72 109.24 66.13 100.89 65.77 101.36 

23 59.09 9264 59.26 9282 64.23 85.03 63.30 84.78 6227 85.60 6234 85.79 61.62 88.90 60.95 88.55 61.40 111.54 61.88 111.47 59.85 103.64 60.13 10149 

24 5299 94.38 53.38 94.49 58.20 87.59 58.20 87.43 56.30 89.19 56.78 89.08 55.86 89.85 55.42 89.44 56.45 113.98 56.60 11578 53.89 10572 53.93 10570 

25 47.50 93.65 47.71 93.59 5234 86.97 5235 86.95 5201 87.81 51.64 87.77 49.87 90.02 50.09 89.68 51.45 113.87 51.11 11593 47.63 105.24 47.87 10521 

26 41.40 91.78 41.46 91.92 48.17 84.65 48.47 84.64 45.46 87.20 45.73 87.42 44.27 88.87 43.93 88.72 46.00 111.39 4567 111.67 4222 10289 4217 10287 

27 37.66 8827 37.47 87.77 4236 83.10 4259 83.28 40.02 85.50 39.94 85.61 39.46 8878 39.24 88.70 40.51 109.32 39.78 109.04 3553 100.95 35.62 101.03 
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AppendixF 

Area Data Report - 1)6 
Technique A 

T o o t h # 
C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F 

T o o t h # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 1.89 2.18 4.13 4.82 3.07 3.81 0.00 0.00 3.73 3.96 4.90 4.90 

7 4.24 4.36 9.86 10.04 4.42 4.59 13.79 13.02 5.33 5.53 7.34 7.17 

8 13.30 10.70 11.04 10.41 11.67 11.7 12.19 13.42 9.49 9.66 14.51 14.37 

9 8.17 8.40 10.98 12.13 15.57 16.03 11.35 12.47 7.63 7.94 12.30 12.30 

1 0 6.97 6.19 7.46 7.43 5.45 5.53 12.16 13.16 2.55 2.78 10.95 10.92 

11 8.06 5.33 7.17 7.46 5.85 5.30 9.12 6.71 3.93 3.93 11.04 10.95 

2 2 2.92 7.37 2.35 4.01 3.41 3.38 4.82 3.99 2.78 2.41 3.93 3.84 

2 3 7.17 7.23 3.96 3.90 5.48 5.73 6.25 6.80 3.01 3.33 6.59 6.57 

2 4 5.13 3.56 6.16 7.57 7.43 8.52 5.68 5.79 3.67 3.70 6.91 6.91 

2 5 5.13 5.22 5.51 6.68 3.87 4.33 6.94 6.80 4.27 4.33 7.23 7.23 

2 6 4.27 3.84 6.82 3.58 3.78 3.64 5.62 5.94 3.76 3.38 5.42 5.25 

2 7 2.32 3.01 5.22 6.05 1.89 2.49 3.87 3.38 5.71 3.96 5.56 5.45 

Technique B 

T o o t h # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F T o o t h # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.68 6.14 7.46 10.35 10.84 10.67 25.61 0.00 13.02 10.81 8.83 9.32 

7 12.47 11.84 16.34 20.10 12.47 14.05 19.24 20.36 14.65 15.68 17.09 14.77 

8 18.70 19.76 19.61 23.74 22.82 19.70 25.29 24.72 19.50 18.29 20.04 21.53 

9 15.03 17.81 22.97 23.23 22.80 24.49 22.45 20.65 15.20 17.84 20.07 21.59 

1 0 11.76 13.62 17.89 15.08 13.22 11.24 22.25 21.56 8.43 8.34 17.52 17.29 

11 13.53 8.69 11.70 10.49 14.28 12.99 21.99 15.83 16.80 7.17 12.73 12.16 

2 2 10.49 8.26 22.16 11.18 6.39 6.22 21.59 6.74 15.71 9.12 6.37 7.68 

2 3 13.02 13.68 12.24 7.66 10.64 13.22 14.80 11.93 13.85 11.50 9.32 9.00 

2 4 12.36 11.58 13.42 12.90 11.81 14.65 12.44 10.32 9.32 10.52 10.12 8.43 

2 5 10.70 12.13 12.62 12.22 11.47 12.04 10.98 11.33 10.87 10.49 10.75 9.72 

2 6 9.32 9.49 15.03 7.17 13.10 1285 13.79 13.99 14.05 12.30 11.15 8.20 

2 7 4.30 6.91 19.61 15.48 5.30 4.56 18.09 6.11 16.77 14.39 6.19 7.37 
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Appendix F 

Position Data Report - D 6 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD CastE Cast F 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 52.84 3811 5277 3809 5275 46.96 5284 46.89 51.82 44.83 51.86 44.83 0.00 0.00 0.00 0.00 53.79 40.21 5176 40.23 50.09 28.98 50.09 28.98 

7 58.10 33.07 5818 3283 60.54 4226 60.54 4227 58.11 40.24 58.17 40.17 54.20 37.86 54.23 37.65 61.18 37.67 61.2 37.65 56.81 2138 56.89 23.34 

8 6590 29.55 6S76 29.34 65.81 37.79 65.62 37.72 64.67 34.22 64.74 34.25 63.12 34.28 6249 34.02 66.37 33.79 66.41 33.82 64.38 ia90 64.39 1859 

9 7530 29.64 75.21 29.47 73.89 37.63 74.13 37.65 7156 34.84 73.56 34.84 70.43 33.25 70.37 33.01 73.59 33.48 7168 33.48 74.39 1859 74.39 18.59 

10 8213 34.04 8208 3171 79.30 4239 79.36 4242 81.70 38.97 81.63 39.02 79.13 36.10 79.09 35.87 80.78 36.32 80.91 36.40 8245 2269 8246 2269 

11 87.41 40.29 87.64 39.71 86.98 47.33 86.95 47.27 87.77 4153 87.84 4156 85.78 38.15 86.43 38.18 86.27 39.82 86.26 39.79 8827 27.72 88.29 27.72 

22 79.82 106.04 80.36 104.64 85.31 100.78 85.12 100.75 87.02 99.26 87.03 99.26 83.26 104.36 83.11 104.66 85.37 101.48 85.23 101.65 8244 117.02 8243 117.05 

23 7524 10859 75.24 108.43 81.09 99.79 81.02 99.78 8206 10203 8210 101.98 78.61 106.54 78.48 106.33 79.59 104.39 79.85 104.32 7621 119.35 7619 119.35 

24 6865 110.48 67.93 110.32 75.68 10229 75.73 10207 76.48 105.21 76.49 105.15 7264 107.41 7264 107.23 74.62 106.26 74.50 106.25 70.34 121.24 70.34 121.24 

25 6361 109.7 63.62 109.55 69.85 101.70 69.99 101.75 71.88 104.19 71.99 104.15 67.11 107.62 67.18 107.45 69.56 106.38 69.52 10635 64.37 120.75 64.37 120.75 

26 56.74 107.82 56.77 107.78 65.11 99.14 65.06 98.61 65.60 10153 65.60 103.55 61.09 106.73 61.23 106.58 64.00 104.17 64.14 104.18 58.46 118.6 5849 118.62 

27 5242 104.41 5233 104.25 60.25 97.76 59.56 96.15 59.74 101.57 59.88 101.70 56.06 106.02 55.99 105.7 58.12 101.47 58.85 10219 5204 115.94 5203 115.96 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.14 22,25 37.13 2224 35.40 3226 35.29 3226 31.52 29.35 31.90 29.05 30.12 21.72 0.00 0.00 35.19 47.83 35.22 47.94 34.18 15.36 34.35 1526 

7 4223 17-46 4236 17.33 4259 27.64 4200 27.91 37.91 24.68 37.98 24.43 37.02 20.22 37.44 19.86 43.19 44.62 43.15 44.75 40.24 10.38 39.72 10.50 

8 50.10 13.53 50.19 13.64 48.35 23.15 47.70 23.07 44.25 ia32 44.56 18.20 45.42 1648 45.44 16.33 48.02 41.17 47.66 41.20 48.18 153 48.08 560 

9 5892 13.64 59.25 13.70 56.95 23.18 56.74 2116 53.47 18.73 53.79 18.76 54.16 15.30 53.62 15.09 56.34 40.76 55.87 40.94 58.34 5.28 58.18 5.33 

10 66.47 18.07 66.34 17.84 6202 27.80 6217 27.87 61.78 2287 61.73 23.06 61.69 18.13 61.72 18.07 6285 44.25 6293 43.98 66.37 9.71 66.55 9.68 

11 71.82 24.56 7202 2187 69.69 3254 69.58 3256 67.82 27.18 67.99 27.43 69.28 21.08 68.65 20.39 67.81 46.43 67.82 47.08 7211 14.49 71.92 14.34 

22 64.47 89.68 64.09 90.11 68.35 85.77 67.62 86.34 67.12 8111 67.36 8106 67.54 8621 65.94 87.01 67.29 108.85 6634 109.17 66.01 10111 66.04 10110 

23 59.49 9267 59.45 9272 64.13 85.13 6126 85.15 6240 85.85 6217 85.74 61.44 88.84 61.20 88.70 61.17 111.74 61.39 111.53 60.05 105.66 59.95 105.80 

24 5327 94.37 5153 94.39 58.16 87.26 58.20 87.53 56.89 88.78 56.54 89.10 55.67 89.68 55.29 89.55 56.45 11175 56.11 1117 5197 107.73 53.83 107.76 

25 47.85 93.58 47.90 9145 5244 87.04 5232 87.20 51.87 87.83 51.75 87.77 50.23 89.77 50.01 89.71 51.02 11170 50.76 11158 48.18 107.23 48.05 107.30 

26 41.42 91.87 41.68 9211 47.49 84.20 48.11 85.02 45.70 87.09 45.76 87.26 44.34 88.88 44.28 88.63 45.46 111.44 45.35 111.57 41.96 104.94 4204 104.99 

27 37.28 87.52 37.36 87.88 4221 8219 4222 81.75 40.05 85.44 40.11 8556 38.53 87.92 38.93 88.03 39.66 108.9 39.69 109.21 35.39 10214 35.69 10227 
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AppendixF 

Area Daia Report - 1)7 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 3.78 1.78 4.87 4.13 2.9 2.52 0.00 0.00 3.87 2.09 3.93 4.53 
7 4.10 5.16 9.61 8.97 6.39 5.94 8.63 11.81 3.81 4.13 7.23 6.11 
8 8.69 10.01 9.98 9.46 8.80 8.00 11.13 12.1 8.11 7.40 7.14 10.41 
9 7.43 8.14 11.78 9.89 9.63 9.52 13.08 11.27 6.45 7.17 5.13 7.48 
10 6.14 5.10 7.74 5.22 4.85 6.74 11.93 9.41 2.58 3.33 4.36 7.60 
11 4.96 4.70 7.43 6.51 4.01 4.30 3.35 3.99 2.04 1.95 5.88 6.91 
22 4.50 5.22 2.41 4.36 4.76 2.61 1.95 2.47 3.24 2.81 3.18 3.61 
23 7.94 6.51 2.75 3.73 7.14 6.25 7.17 5.91 4.65 4.70 6.14 6.34 
24 3.99 4.22 5.68 6.19 7.17 7.17 4.42 4.07 3.70 4.19 5.88 6.65 
25 3.44 4.5 5.94 5.85 6.82 6.97 4.76 5.53 3.64 3.90 6.39 5.71 
26 5.30 5.42 4.07 5.28 6.82 6.59 6.02 5.48 5.42 6.34 7.54 6.59 
27 5.48 3.96 5.33 4.67 2.44 2.47 2.52 1.95 3.47 2.52 3.30 4.19 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 7.71 8.66 10.78 11.81 14.19 10.75 18.49 13.30 10.32 12.24 8.97 10.41 
7 15.34 13.48 18.67 18.44 14.77 14.82 19.58 25.00 11.76 12.79 15.89 12.65 
8 20.33 20.22 22.45 21.25 19.15 19.87 26.58 27.33 17.66 21.28 16.00 18.95 
9 16.34 16.14 22.14 22.11 26.09 29.56 25.23 21.76 16.77 15.20 18.90 19.15 
10 14.77 16.26 17.61 19.70 15.05 14.02 26.52 24.29 9.72 9.58 15.97 18.06 
11 8.57 13.33 13.85 14.68 11.96 14.14 14.68 14.54 9.09 8.54 14.60 13.59 
22 4.59 17.78 9.29 5.48 6.59 6.08 7.48 9.72 7.43 13.08 4.76 8.83 
23 13.42 14.31 16.43 20.44 13.99 15.63 13.76 16.14 14.97 13.56 10.49 11.33 
24 12.82 13.02 12.82 14.37 15.14 17.09 11.73 12.82 12.04 12.50 11.76 12.53 
25 10.01 12.47 8.86 13.42 12.87 15.28 10.12 12.13 12.13 12.16 11.76 12.19 
26 11.33 14.11 12.42 9.09 13.19 15.05 8.46 13.25 16.14 16.60 13.13 13.68 
27 6.74 9.32 5.71 19.30 3.41 5.28 13.42 8.80 14.05 16.52 9.66 11.18 

163 



Appendix F 

Position Daia Report - D 7 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 52.20 38.68 5254 38.47 50.48 46.88 5280 46.60 51.85 44.64 51.59 45.01 0.00 0.00 0.00 0.00 53.89 40.02 54.01 39.53 50.07 2883 50.16 28.84 

7 5a45 33.10 58.10 3107 58.25 4225 60.65 41.95 57.46 40.58 57.92 40.44 54.17 37.93 54.66 37.75 61.25 37.82 60.98 37.74 5628 23.80 56.77 2329 

8 66.25 29.57 65.76 29.52 63.30 37.74 65.82 37.36 64.78 3194 64.90 34.16 63.48 34.48 63.44 34.25 66.82 33.91 66.37 33.79 64.10 18.50 64.18 18.72 

9 75.44 29.43 75.08 29.60 71.74 37.67 74.41 37.32 73.75 34.46 73.59 34.58 70.62 3123 71.22 33.03 74.12 33.42 73.85 33.35 74.95 1817 75.19 18.38 

10 8201 33.25 81.90 3171 77.08 4243 79.52 4215 81.42 38.75 81.82 39.36 79.24 36.21 79.48 36.10 81.58 36.79 81.16 36.74 8107 2247 8264 2246 

11 88.17 39.65 87.68 39.85 84.66 47.43 87.17 47.58 87.87 4130 87.86 4151 87.03 38.41 86.84 38.19 86.28 39.00 85.99 38.97 89.24 27.96 89.13 27.88 

22 80.93 104.88 80.42 104.85 83.11 100.60 86.02 99.12 87.19 98.59 87.13 9889 83.68 104.17 83.77 103.75 85.62 101.25 85.61 100.89 8291 116.41 8281 116.40 

23 75.56 10842 75.34 10&56 78.76 99.63 81.10 99.46 81.88 101.75 81.99 101.90 78.75 106.69 78.73 106.47 80.24 104.30 79.98 104.23 7635 119.32 7632 119.25 

24 69.17 110.38 68.55 110.40 73.19 101.96 75.68 101.79 76.63 104.88 76.48 105.18 73.00 107.58 7276 107.36 74.89 106.46 74.38 106.26 70.28 121.29 70.21 121.16 

25 64.21 109.88 6158 109.67 67.68 101.77 70.02 101.45 71.85 10171 71.65 103.86 67.56 107.56 67.67 107.48 69.49 10631 69.39 106.40 64.44 120.74 64.00 120.53 

26 57.32 107.82 57.26 10802 6286 98.80 64.99 98.41 65.62 10115 65.61 103.49 61.54 106.60 61.82 106.72 64.10 104.09 64.12 104.32 5ai9 118.37 58.51 118.43 

27 5291 10128 5273 103.76 57.29 95.73 59.86 95.94 59.89 101.50 59.99 101.75 56.23 105.72 56.13 105.48 58.94 10201 58.21 101.52 5223 115.78 51.78 115.52 

Technic] ucB 

Tooth 
# 

• Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.25 21.88 37.11 21.94 35.22 31.52 35.09 31.59 31.88 2868 3219 28.47 30.55 20.45 30.08 20.27 35.03 47.44 34.90 47.72 3168 1132 33.88 1110 

7 4210 17.13 4219 17.28 4248 27.16 4249 27.07 37.88 24.16 37.78 24.22 37.56 19.96 37.30 20.02 43.27 44.43 4137 44.49 39.54 asi 39.68 8.34 

8 50.18 1138 50.30 1168 47.92 2265 48.16 2271 44.50 18.08 44.59 1814 45.41 1653 45.26 16.38 47.97 41.08 4ai9 41.07 47.93 135 48.48 150 

9 59.54 1160 59.32 1169 56.90 2266 57.08 2265 54.22 18.69 54.08 1891 53.72 15.44 53.35 15.26 55.80 40.75 55.69 40.73 5804 122 58.11 120 

10 66.45 17.92 66.46 17.81 6221 27.25 6251 27.23 61.79 2100 6200 23.05 61.82 18.06 61.44 18.02 6288 4181 6280 44.01 66.52 7.53 66.26 7.56 

11 7202 2188 7208 24.49 69.34 31.19 69.59 31.91 68.13 27.29 67.63 26.83 69.31 20.54 68.43 20.13 67.96 47.01 6800 47.16 7233 1235 71.83 11.89 

22 64.30 90.15 64.78 89.31 67.97 86.64 67.83 85.57 67.38 8100 67.12 83.53 65.92 87.39 65.50 86.91 67.83 109.49 66.82 109.06 66.28 100.92 64.97 101.52 

23 59.26 9272 59.24 9293 63.85 84.83 63.74 85.14 6233 85.63 62.21 85.70 61.51 8876 60.91 88.34 61.68 111.53 61.28 111.79 59.80 103.76 59.99 10172 

24 53.11 94.25 53.38 94.48 58.20 86.86 58.18 8686 56.77 89.11 56.72 89.13 55.78 89.53 55.48 89.48 56.01 113.67 55.99 113.62 5193 105.79 54.07 105.82 

25 47.76 93.44 47.96 93.61 5266 86.59 5251 86.68 5204 87.68 51.84 87.86 50.32 89.50 50.20 89.62 50.91 113.73 50.86 11170 47.87 105.20 47.72 105.18 

26 41.39 91.68 41.51 9208 47.84 83.70 48.23 84.16 45.76 87.23 45.68 87.05 44.70 88.45 44.17 88.46 45.75 111.45 45.35 111.25 41.64 10286 41.67 10291 

27 37.39 87.74 37.25 87.99 41.93 8233 41.98 81.47 39.92 85.49 39.87 85.39 39.18 88.54 38.91 88.19 39.18 108.66 39.46 10891 35.44 100.57 35.86 100.66 
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Appendix F 

Area Data Report - D8 
Technique A 

Tooth # Cast A CastB Cast C CastD CastE CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.99 6.14 9.43 10.49 7.51 9.78 0.00 0.00 13.82 13.68 8.29 9.75 
7 10.27 12.73 17.98 16.86 8.95 9.98 13.71 13.73 12.56 12.56 13.22 10.61 
8 14.14 15.20 14.02 17.61 16.20 14.65 25.26 25.81 14.88 18.12 19.30 10.98 
9 11.50 15.91 17.41 17.55 25.86 28.01 23.17 23.37 17.03 17.15 19.38 10.49 
10 12.82 9.98 14.25 14.77 11.21 11.99 22.97 24.06 9.15 8.17 7.57 9.03 
11 13.76 10.15 15.77 12.44 10.18 10.38 13.51 16.66 10.01 10.04 14.60 9.98 
22 14.85 6.42 8.80 8.80 8.17 8.43 7.89 7.83 9.32 9.29 8.06 4.53 
23 14.48 15.23 9.55 9.58 12.07 13.16 9.95 10.01 7.94 8.46 9.61 9.32 
24 9.98 11.38 13.39 14.74 14.42 14.34 13.28 11.76 8.97 8.83 9.20 8.97 
25 10.84 11.10 12.01 12.16 8.40 9.18 12.99 13.08 9.03 9.46 9.66 9.78 
26 10.04 12.30 10.67 9.49 8.54 9.26 11.70 11.47 9.84 10.06 11.99 8.95 
27 8.14 9.58 5.71 9.84 5.76 5.94 9.12 8.37 9.23 10.44 8.89 5.91 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 4.22 7.51 8.06 8.86 14.60 7.94 7.11 0.00 8.11 '7.05 15.05 7.14 

7 12.85 13.73 18.35 15.31 13.91 12.62 23.77 22.34 15.14 13.08 15.17 6.11 

8 20.07 20.90 19.64 17.86 19.99 18.84 26.21 24.72 13.79 16.69 20.30 8.17 

9 16.37 17.32 19.76 20.93 25.38 25.78 22.34 22.91 15.80 15.66 19.90 7.97 

10 13.45 15.25 16.03 14.68 13.82 11.93 24.00 23.11 7.48 7.43 17.63 6.94 

11 9.98 9.52 14.31 13.13 14.25 8.46 16.17 15.05 8.34 7.11 17.72 12.07 

22 6.59 3.81 3.84 5.85 7.74 7.34 8.00 8.03 6.51 5.85 18.24 1.58 

23 14.62 13.56 11.70 8.52 15.00 14.22 15.66 14.62 13.10 10.24 11.99 8.14 

24 12.50 13.56 14.14 11.96 17.12 13.28 13.25 13.16 12.39 11.64 12.16 7.86 

25 10.47 12.30 13.48 12.56 13.82 13.68 14.34 13.25 10.44 9.69 12.82 8.26 

26 12.65 13.22 4.73 4.87 12.90 14.54 15.05 15.08 13.82 15.97 13.42 5.99 

27 5.59 16.72 7.00 11.44 4.96 4.99 10.72 12.01 16.32 15.91 18.35 5.10 
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AppendixF 

Position Dai.i Report - DS 
Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5298 37.87 53.15 37.87 5296 46.58 53.14 4647 51.87 44.86 5215 44.81 0.00 0.00 0.00 .0.00 54.42 39.79 54.42 39.77 50.33 28.85 50.46 28.83 

7 58.21 3294 58.58 3276 60.48 4206 60.43 4212 58.15 40.25 58.30 40.24 54.14 37.46 53.99 37.45 61.56 37.37 61.56 37.37 5671 2148 56.78 2334 

8 65.65 29.35 65.85 29.32 65.46 37.38 65.65 37.50 65.33 34.24 65.31 34.06 6263 34.19 6252 34.20 66.71 33.71 6669 33.83 64.47 18.86 64.69 18.44 

9 74.77 29.18 74.97 29.35 73.87 37.43 73.90 37.43 73.64 34.92 73.73 35.00 70.81 3303 70.73 33.01 74.25 33.48 74.24 33.47 74.79 1877 74.84 18.32 

10 8202 3361 81.84 33.07 79.55 4231 79.55 4229 81.68 39.03 81.79 39.02 78.92 35.85 78.70 35.84 81.17 36.45 80.95 36.29 8122 2253 8273 2241 

11 87.45 40.03 87.78 39.63 86.48 46.83 86.81 46.92 87.71 43.47 87.85 43.45 86.19 38.18 85.94 38.24 86.42 40.01 8642 40.01 88.36 27.69 89.00 27.90 

22 80.22 104.74 80.01 105.88 85.20 100.39 85.20 100.39 86.96 99.32 87.16 99.31 83.34 104.80 83.18 104.79 85.25 101.72 85.40 101.61 8226 116.86 8243 117.11 

23 74.94 10853 75.10 10852 81.08 99.61 81.10 99.60 8208 101.90 8221 101.93 78.78 106.83 78.61 106.83 79.68 104.42 79.66 104.40 7626 119.32 76.26 119.22 

24 68.88 110.43 68.94 110.37 75.72 101.94 75.59 101.96 76.44 105.15 76.57 105.16 7298 107.49 7281 107.44 74.79 106.24 74.83 106.26 70.39 121.23 70.41 121.13 

25 63.56 109.49 63.77 109.45 69.98 101.68 69.86 101.70 71.79 104.19 71.99 104.13 67.29 107.63 67.10 107.62 69.81 10643 69.77 10643 64.31 120.74 64.31 120.66 

26 57.10 107.99 57.29 107.84 65.30 98.93 65.36 99.00 65.85 103.71 65.93 103.62 61.31 106.74 61.13 106.75 64.54 104.27 64.49 104.29 58.38 118.37 5847 118.49 

27 5223 104.13 5241 104.12 59.97 97.29 59.70 9657 59.95 101.80 60.13 101.81 56.38 106.20 56.17 106.13 59.04 10216 59.00 10206 5202 115.93 51.96 116.01 

Technic ue B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.03 19.63 37.44 19.34 35.25 3209 33.23 31.17 31.88 28.71 28.46 2S25 3239 17.63 0.00 0.00 35.18 47.85 35.31 43.96 3197 1128 33.81 13.49 

7 4237 14.45 4235 14.61 4277 27.54 41.13 26.62 37.95 24.46 35.12 20.30 37.46 17.97 37.16 18.28 43.18 44.43 4290 41.19 39.95 8.34 40.07 7.84 

8 50.29 10.82 50.40 11.00 48.35 23.04 46.32 2209 44.79 17.97 4201 13.87 45.62 14.38 45.63 14.65 48.00 41.26 47.82 37.28 48.12 161 48.41 298 

9 59.50 10.92 59.57 11.06 56.26 23.01 54.82 21.95 53.85 1868 50.65 14.43 53.69 13.20 53.39 13.60 55.41 40.82 55.29 37.12 5802 126 58.54 290 

10 66.44 15.22 6646 15.34 6218 27.91 59.93 26.62 61.84 2285 58.66 18.78 61.77 16.03 61.72 16.41 6255 43.86 6269 40.09 6643 7.61 66.40 7.00 

11 7209 21.18 7209 21.33 69.53 3246 67.42 31.60 68.09 27.18 65.11 23.38 68.72 18.27 68.35 18.47 67.74 47.10 67.80 43.55 7216 1231 71.85 1223 

22 64.07 87.44 64.91 88.12 67.64 86.04 65.63 85.16 67.20 83.08 64.06 78.75 66.06 85.19 65.89 85.38 67.45 109.50 67.46 105.59 6690 100.35 66.29 101.45 

23 59.44 89.92 59.42 90.07 64.09 84.99 61.70 83.93 6231 85.59 59.33 81.38 61.30 86.59 61.16 87.00 61.89 111.62 61.81 107.76 59.95 103.66 59.72 103.82 

24 53.14 91.54 53.23 91.76 58.06 87.37 56.12 8634 56.71 89.04 53.74 84.73 55.70 87.49 55.60 87.87 56.00 11145 5608 109.79 54.02 105.85 53.99 10172 

25 47.78 90.78 47.85 91.01 5230 87.23 50.24 86.04 51.96 87.65 48.89 8358 50.17 87.81 50.11 88.06 50.89 113.56 51.12 109.85 47.84 105.18 47.87 105.26 

26 41.46 89.16 41.52 89.41 48.29 84.89 46.19 8373 45.85 87.10 4268 8283 44.35 8678 44.20 87.05 45.09 111.27 45.38 107.39 41.59 10286 41.69 103.04 

27 37.67 84.75 3689 83.17 43.15 83.14 40.08 81.06 40.00 85.27 36.91 81.18 39.50 8646 39.19 86.92 39.37 108.83 39.48 104.97 34.94 99.41 35.60 100.70 
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Appendix F 

Area Data Report - F l 
Technique A 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.61 1.98 5.08 4.70 3.33 4.22 0.00 0.00 3.18 2.67 5.33 6.02 

7 3.70 4.10 7.63 9.66 4.90 4.73 8.14 3.73 5.62 5.39 0.92 3.58 

8 5.59 6.22 9.18 9.18 7.23 6.11 4.47 4.50 4.13 9.98 2.49 5.13 

9 3.33 4.76 9.66 5.39 10.24 16.57 2.84 3.58 8.77 9.12 6.45 6.37 

10 3.96 4.24 5.94 5.48 4.65 5.05 12.50 1.84 3.15 3.15 2.55 2.84 

11 7.17 4.73 7.17 5.71 5.48 5.53 9.09 7.00 4.50 4.50 8.00 6.80 

2 2 1.92 2.44 3.07 4.65 4.39 3.93 4.27 4.24 1.75 0.80 2.32 1.66 

2 3 3.38 3.44 0.03 0.37 5.76 3.33 3.67 2.90 0.63 1.84 6.22 6.42 

2 4 5.19 4.01 7.11 3.04 8.97 7.37 6.74 5.99 3.44 3.78 6.74 6.62 

2 5 5.22 5.10 7.14 7.00 2.72 2.67 6.88 7.25 3.93 4.33 7.08 7.08 

2 6 3.81 4.27 9.58 3.01 3.53 2.24 4.30 5.82 2.55 2.52 5.65 5.71 

2 7 0.80 1.43 11.13 1.69 2.61 2.61 3.73 2.87 4.16 0.69 6.39 3.56 

Technique B 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 9.43 9.38 9.58 10.27 11.50 12.27 15.14 15.66 11.24 20.99 13.05 12.27 

7 13.65 16.49 18.81 22.48 13.48 13.96 19.44 19.99 12.13 15.28 13.16 17.55 

8 20.90 20.93 20.87 19.84 19.56 20.44 26.15 23.46 15.00 18.01 21.59 17.12 

9 16.32 20.01 20.01 19.93 21.42 22.42 22.60 21.02 15.28 15.60 24.29 17.55 

10 15.14 18.67 19.81 21.45 15.91 14.45 22.11 24.11 7.11 8.89 16.97 12.27 

11 9.78 12.44 14.60 12.79 14.05 12.30 13.71 16.97 12.19 15.28 13.79 10.87 

2 2 9.89 8.43 11.18 11.18 7.31 6.19 9.89 9.75 11.61 12.99 6.34 18.44 

2 3 13.13 12.76 9.29 10.29 11.18 12.50 15.46 15.00 11.38 13.25 12.44 11.10 

2 4 9.55 12.65 14.88 13.62 15.08 13.76 12.73 11.21 10.64 12.70 11.38 12.24 

2 5 11.41 11.07 12.59 13.02 11.38 9.75 12.44 12.65 12.07 12.65 11.78 12.01 

2 6 11.33 12.82 11.99 14.11 14.74 15.03 14.22 12.27 14.57 17.23 13.42 15.71 

2 7 8.97 8.89 9.03 10.21 6.31 7.31 12.82 15.63 16.34 17.98 14.82 14.25 
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Appendix F 

Position Data Report - F l 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5277 37.89 5270 37.92 5287 46.69 5284 46.88 51.83 44.72 51.84 44.90 0.00 0.00 0.00 0.00 53.70 40.30 53.88 39.38 50.34 2896 50.30 28.87 

7 58-04 3285 57.72 33.13 60.36 4209 60.52 4227 58.12 40.06 58.11 40.24 54.70 36.91 54.04 37.25 61.20 37.64 60.84 37.67 56.71 2282 57.13 2292 

8 65.42 29.27 65.91 29.29 65.39 37.42 65.39 37.59 64.86 33.79 64.69 33,91 61.60 33.60 6248 33.60 67.00 33.76 66.35 33.97 6276 1840 64.55 18.43 

9 74.55 29.03 74.49 29.11 73.75 37.41 73.33 37.49 74.56 34.86 73.58 34.80 71.00 3211 71.83 3211 73.62 33.51 73.05 33.81 75.00 1829 74.75 18.27 

10 81.47 3295 81.66 33.24 79.62 4242 79.72 4264 81.51 3859 81.66 3887 77.95 35.62 78.85 35.17 80.92 36.39 80.58 36.39 8279 2217 8276 2220 

11 87.37 39.90 87.55 39.56 86.90 46.99 86.84 46.96 87.80 43.36 87.80 43.52 85.27 37.95 86.31 37.95 86.27 39.89 85.93 39.89 87.78 27.37 89.16 27.98 

22 79.72 105.96 79.69 105.87 85.25 100.52 85.14 100.65 87.01 99.12 87.00 99.25 8248 104.65 83.33 104.64 84.84 10217 84.62 10211 8270 117.09 8289 116.85 

23 73.60 109.34 73.70 109.21 81.28 98.89 80.12 99.50 8210 101.81 81.10 10273 78.48 106.81 78.91 106.78 79.14 104.58 7847 104.62 7631 119.34 76.19 119.25 

24 6832 110.34 6821 110.36 75.92 101.98 76.32 10211 76.45 104.97 76.45 105.21 71.97 107.28 7283 107.27 74.64 106.28 74.34 106.28 70.49 121.24 70.35 121.14 

25 63.55 109.57 63.55 109.57 69.95 101.62 70.00 101.78 7200 104.10 71.97 104.27 66.41 107.46 67.25 107.46 69.80 106.51 69.22 106.37 64.48 120.74 64.32 120.66 

26 56.78 107.90 56.66 107.75 65.33 98.96 65.43 99.28 65.93 103.61 66.19 103.97 60.62 106.71 61.25 106.61 64.44 104.34 65.11 104.69 5865 118.61 5849 11854 

27 5203 103.84 5249 103.97 59.94 96.61 59.99 97.51 59.87 101.52 59.87 101.69 55.40 105.87 55.98 105.32 59.17 10233 57.8 101.92 5217 115.90 51.87 115.99 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 ' 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.82 2237 37.01 2243 35.14 3217 35.42 3207 31.39 29.02 31.60 29.05 29.49 21.33 29.20 21.08 35.56 46.97 35.53 47.48 3591 1546 33.95 1356 

7 4222 17.24 4233 17.19 43.00 27.65 4261 27.59 37.85 24.24 37.85 24.42 37.37 20.00 37.14 19.68 4277 45.00 4242 44.64 39.58 8.42 39.84 860 

8 50.25 13.69 49.97 13.56 48.18 23.11 48.20 23.06 44.57 1814 44.52 1816 45.48 1650 44.90 16.11 48.54 41.33 4810 41.26 4835 4.09 48.61 3.61 

9 59.47 13.64 5876 13.33 57.02 23.05 56.79 23.05 53.48 ia54 53.92 1849 53.78 1533 53.84 15.02 56.27 40.74 56.01 40.68 57.98 4.20 57.72 129 

10 66.37 1803 66.23 17.74 6238 27.93 6255 27.95 61.80 2299 61.75 2299 61.84 18.02 61.66 17.95 6234 43.58 6262 43.81 66.35 7.49 66.96 7.57 

11 7230 24.17 71.84 24.08 69.77 3264 69.50 3268 68.11 27.47 67.99 27.11 69.18 20.39 68.43 20.33 67.40 46.13 67.81 46.41 7221 1216 7265 1217 

22 64.30 90.24 64.03 90.14 67.63 87.21 67.74 86.38 67.08 83.13 67.33 8282 65.87 87.25 65.82 86.88 67.29 109.12 66.88 109.13 6583 101.12 66.34 100.76 

23 59.24 9266 5892 9291 63.48 84.76 63.49 84.58 6220 85.80 6247 85.82 61.24 88.64 61.27 88.69 60.73 111.84 61.49 111.59 60.15 103.52 59.91 103.70 

24 53.91 94.46 53.14 94.40 58.13 87.45 58.22 87.33 56.75 8889 56.76 8899 55.74 89.70 55.60 89.39 56.35 113.81 56.27 113.54 53.85 10576 54.04 10585 

25 47.93 9357 47.62 93.52 5242 87.01 5241 86.92 51.91 87.93 51.83 8807 50.25 89.76 49.99 89.69 50.82 113.72 50.82 11568 47.67 105.12 47.74 10523 

26 41.25 91.89 41.51 9223 47.57 83.58 47.72 84.29 45.60 87.11 45.70 87.23 44.39 8878 44.22 88.51 45.45 111.58 45.44 111.77 41.73 10282 41.36 10267 

27 36.84 8817 37.13 87.77 4236 8213 4209 81.58 39.97 85.2G 40.53 8609 39.14 8880 38.63 88.57 39.29 10885 39.53 10899 34.93 99.52 34.42 99.29 
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Appendix F 

Area Data Report - 12 
Technique A 

Tooth # Cast A CastB Cast C CastD CastE CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 17.35 5.56 18.72 18.95 15.94 7.91 8.40 6.05 11.78 12.56 12.24 16.40 
7 11.53 10.98 18.52 20.62 9.26 9.92 23.14 20.44 12.24 11.24 11.27 12.30 
8 19.18 15.60 19.33 23.05 14.34 20.39 23.05 24.54 16.77 12.47 18.72 20.39 
9 16.26 16.14 16.89 21.42 25.52 25.15 23.46 23.51 19.87 19.64 18.75 20.99 
10 13.65 14.65 13.53 14.16 13.19 11.81 23.40 23.43 9.41 10.24 12.59 12.73 
11 17.46 8.86 17.46 16.57 9.32 10.18 16.14 17.98 13.28 9.15 13.48 14.08 
22 7.17 14.39 5.59 12.59 16.46 12.04 16.23 17.52 19.47 16.66 12.01 12.24 
23 12.39 16.32 9.06 9.63 14.48 13.28 11.33 15.31 9.15 7.91 7.31 11.35 
24 10.38 10.61 13.36 14.37 14.80 14.68 11.64 12.65 8.80 8.20 10.58 9.15 
25 11.10 10.64 11.21 11.27 12.87 13.30 12.42 12.50 8.20 9.12 9.78 9.32 
26 12.56 12.79 15.60 14.74 10.78 14.45 13.28 13.91 8.80 9.92 8.46 8.43 
27 17.00 15.68 16.06 15.66 16.77 18.29 13.25 24.23 12.90 12.67 7.97 11.21 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 9.98 22.85 17.00 20.99 22.34 21.05 18.18 29.16 22.82 21.76 22.37 20.53 

7 16.46 21.19 22.74 23.08 14.45 13.48 27.61 23.11 15.60 15.51 21.51 19.04 

8 20.56 27.87 26.81 25.52 21.73 24.92 28.27 26.90 25.18 23.40 22.8 20.85 

9 19.13 22.05 25.32 22.14 30.31 29.33 26.61 25.09 16.80 19.58 21.13 19.56 

10 18.52 13.85 19.04 20.24 14.60 14.14 26.09 23.51 8.63 9.32 19.24 18.67 

11 17.63 17.86 19.27 20.47 17.20 16.75 21.59 17.55 32.14 24.32 15.63 15.43 

22 5.73 15.60 11.73 26.61 17.23 8.29 8.69 27.15 12.65 13.05 1.43 14.74 

23 15.51 17.06 11.67 12.85 17.72 13.94 14.82 14.80 15.34 18.09 10.35 10.15 

24 9.23 12.70 14.82 13.68 18.84 15.68 15.71 14.94 13.28 12.30 10.52 10.49 

25 9.52 11.73 15.11 12.90 18.04 12.10 19.5 13.33 13.02 13.51 12.13 12.01 

26 13.39 12.04 13.56 19.13 20.99 15.46 15.11 14.71 18.61 17.84 12.70 11.70 

27 6.71 0.00 17.23 21.25 30.51 17.66 22.25 22.57 17.29 18.01 7.20 5.99 
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Appendix F 

Position Data Report - 12 

Technique A • IB llllî  111111 Sit lllli 
Cast A Cast B Cast C CastD CastE CastF 

Tooth 
# 1 2 1 2 1 2 1 2 1 2 1 2 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.06 3858 53.45 37.88 54.08 46.23 54.08 46.39 53.36 44.63 51.95 44.80 51.22 37.51 50.94 37.86 54.83 37.85 54.15 39.62 50.89 2878 51.28 28.90 

7 58.68 3285 58.83 3282 59.95 4222 60.12 4226 58.44- 40.04 58.23 40.10 56.52 37.87 55.74 37.76 61.82 35.76 61.19 37.49 56.91 23.36 57.08 23.42 

8 6631 29.32 66.29 29.33 65.93 37.64 65.57 37.75 64.69 33.98 64.40 34.32 64.80 34.20 64.03 34.18 67.26 3218 66.58 33.72 64.64 18.83 64.90 18.93 

9 75.32 29.45 75.50 29.45 73.93 37.42 74.35 37.69 73.69 34.87 73.59 34.86 7288 33.04 7211 33.03 75.17 31.80 74.48 33.49 74.81 1873 75.13 1884 

10 8250 33.73 8249 33.69 79.53 4233 79.69 4251 81.70 39.01 81.55 38.92 80.85 35.80 80.26 35.81 80.69 34.42 80.20 36.22 8272 2253 8289 2254 

11 87.69 39.96 88.20 39.58 86.36 46.83 86.46 47.04 87.95 43.51 87.71 43.47 87.72 38.05 87.42 38.30 86.41 37.52 86.09 39.99 8852 27.74 88.45 27.67 

22 80.30 105.98 80.72 104.76 85.34 100.44 85.14 100.46 87.15 9890 87.12 99.10 86.68 103.47 85.40 103.92 86.14 98.45 85.45 100.10 8290 115.74 83.07 115.75 

23 75.34 10863 75.06 10850 81.08 99.58 81.25 99.57 8241 101.69 8200 101.81 80.69 106.59 79.78 106.57 80.29 10261 79.29 104.40 7657 118.74 76.55 119.06 

24 69.28 110.32 69.35 110.39 75.72 101.94 75.51 10210 76.63 105.16 76.46 105.14 75.20 107.37 74.35 107.38 75.14 104.57 74.20 10612 70.84 120.98 70.68 121.14 

25 64.09 109.43 63.97 109.49 70.12 101.73 69.96 101.81 71.81 103.86 71.92 103.77 69.27 107.61 68.70 107.55 70.03 104.66 69.47 10641 64.50 120.62 64.59 120.65 

26 57.86 107.96 57.77 107.89 65.23 98.87 65.15 9891 65.88 103.37 65.58 103.28 63.56 106.53 6296 106.53 64.52 10241 63.95 104.15 5860 118.49 5880 118.48 

27 5249 103.67 5235 103.63 59.80 96.49 59.86 96.70 60.25 101.41 60.08 101.38 58.19 105.90 57.19 104.71 5861 99.65 57% 101.37 5222 115.90 5215 115.24 

1 echnique B 
Cast A CastB Cast C CastD Cast E CastF 

Tooth 
# 1 2 1 2 1 2 1 2 1 2 1 2 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.63 2201 36.41 23.65 34.76 3280 35.02 3297 3210 29.11 3228 29.14 29.49 19.67 29.83 21.09 35.30 47.60 35.30 48.05 33.66 14.18 33.69 11.83 

7 4228 17.29 4265 17.19 4216 27.89 4215 27.92 38.07 24.28 37.98 24.52 37.04 1836 37.20 19.28 4202 44.72 4218 44.93 4040 868 40.14 6.44 

8 50.44 13.68 50.16 13.44 47.23 23.45 47.09 23.37 44.44 1810 44.39 18.48 45.47 14.43 45.35 15.64 47.17 41.17 47.55 41.12 4800 3.85 48.35 1.44 

9 59.12 13.75 5880 13.43 56.95 23.38 56.70 23.16 54.06 1885 53.57 18.96 53.87 13.34 53.65 14.63 56.01 40.83 55.60 40.% 57.69 3.50 57.76 1.19 

10 66.34 17.88 66.42 17.84 6234 27.84 6234 27.93 61.78 2286 61.64 2294 61.69 15.94 61.78 17.33 6209 43.53 6240 43.63 66.35 7.71 66.23 539 

11 7214 24.37 71.85 24.16 69.51 3234 69.62 3262 67.69 27.04 68.16 27.57 69.37 19.07 68.87 19.80 67.10 47.47 67.84 47.21 7200 1221 71.82 9.87 

22 63.86 90.49 64.80 89.22 68.59 86.43 68.32 85.07 68.21 8299 67.10 83.40 66.17 85.00 67.52 85.45 67.24 108.49 67.07 109.07 64.44 10291 66.90 9848 

23 59.08 9276 59.05 9279 63.63 84.80 63.79 85.15 6276 84.98 6239 85.70 61.35 8656 61.10 87.92 60.87 111.15 61.00 111.32 59.84 103.71 59.82 101.55 

24 5244 94.11 53.20 94.52 58.00 87.42 58.11 87.36 57.00 8890 56.63 89.08 55.71 87.71 55.40 89.00 56.04 113.42 56.19 113.47 53.89 105.68 53.82 10553 

25 47.74 93.75 47.87 93.58 5219 87.18 5233 87.25 51.85 87.86 51.73 87.81 50.01 88.07 49.% 89.09 50.53 113.45 50.58 113.33 4779 105.14 47.82 10292 

26 41.45 91.93 41.69 91.98 47.26 84.09 47.11 83.62 45.44 86.95 45.63 87.11 44.30 86.68 44.25 87.94 45.03 111.45 45.26 111.50 41.74 10291 41.72 100.70 

27 37.33 87.83 0.00 O.OO 41.65 8213 41.65 81.61 39.43 84.71 39.78 85.58 3862 85.96 38.40 87.32 39.45 10882 39.65 1088 34.87 100.42 37.16 99.02 
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AppendixF 

Area Daia Report - I'3 
Technique A 

Tooth # Cast A CastB Cast C CastD CastE CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 7.86 7.89 4.56 5.25 4.22 6.80 0.00 0.00 10.67 10.87 5.71 6.45 
7 7.08 7.31 11.33 10.21 8.57 8.17 14.71 14.77 5.62 5.91 10.67 9.55 
8 12.30 16.29 14.31 11.58 12.44 12.10 17.35 17.43 7.71 10.52 17.92 ' 11.33 
9 9.15 9.18 13.94 11.27 18.18 16.60 13.82 13.02 12.16 11.41 17.15 15.11 
10 7.25 7.43 8.14 7.74 7.83 6.45 15.51 15.60 4.85 3.64 10.52 12.59 
11 9.46 9.41 8.20 9.20 5.48 6.16 8.97 8.95 9.75 6.42 11.76 10.06 
22 8.17 9.00 8.89 6.80 9.84 9.69 11.67 12.99 3.78 4.99 15.31 6.45 
23 8.54 7.37 4.70 3.84 5.42 7.20 7.91 5.42 4.65 5.82 6.54 6.94 
24 5.68 5.71 8.54 7.94 9.32 8.00 7.25 7.11 5.13 4.19 7.03 6.85 
25 6.02 5.39 8.03 7.57 7.60 7.57 8.69 7.20 4.85 4.93 7.71 7.60 
26 5.85 5.96 9.69 6.94 7.97 6.94 8.00 7.77 6.34 5.10 9.29 9.35 
27 6.31 8.95 12.36 11.07 2.38 9.06 4.22 4.53 7.66 8.34 5.99 7.74 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 15.83 8.83 14.48 9.84 11.76 10.12 0.00 0.00 11.90 6.19 13.94 8.17 
7 12.04 9.63 19.38 18.44 17.61 15.97 21.99 21.96 13.10 13.62 16.37 11.67 
8 19.76 15.66 23.57 23.97 19.99 21.25 27.56 26.52 19.44 16.80 21.22 19.44 
9 17.66 17.29 23.40 21.39 24.8 25.41 22.97 21.08 15.20 15.05 21.22 19.81 
10 17.52 11.41 19.04 14.85 12.62 10.41 21.02 16.95 8.26 8.52 15.71 15.20 
11 18.52 9.09 11.35 14.91 13.10 13.71 16.89 10.24 5.85 6.62 14.51 15.54 
22 9.49 10.44 24.83 6.74 7.74 8.23 9.78 5.94 11.84 8.17 6.54 6.25 
23 15.68 15.97 14.62 12.36 14.88 10.35 13.82 13.30 12.39 15.48 8.11 9.06 
24 9.63 12.76 15.25 13.65 14.08 17.81 10.44 12.82 9.98 11.76 8.97 8.89 
25 8.63 12.3 15.51 11.76 11.73 14.05 9.15 12.87 10.49 10.47 7.48 10.95 
26 10.38 13.42 13.48 7.48 12.22 13.05 13.91 12.22 10.61 12.33 10.18 10.04 
27 15.05 10.70 19.81 6.34 5.51 6.59 15.89 6.91 13.59 16.69 9.72 7.11 
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Appendix F 

Position DMA Report -1 3 
Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5277 3868 5322 38.65 5282 46.90 5288 4682 51.84 44.90 51.81 45.28 0.00 0.00 0.00 0.00 54.51 39.46 55.01 39.45 50.28 2878 50.34 28.86 

7 5867 3309 59.05 3298 60.54 4224 60.52 4228 57.73 40.71 57.88 40.75 54.33 37.68 54.21 37.82 61.03 37.64 61.41 37.60 56.71 23.41 56.79 23.41 

8 66.97 29.48 67.24 29.50 65.81 37.75 65.89 37.80 64.85 34.24 64.82 34.28 6264 3198 6262 34.15 67.21 34.02 66.71 33.80 65.06 1892 64.60 18.97 

9 7190 29.63 75.77 29.65 74.19 37.69 73.85 37.61 73.53 34.90 73.68 34.96 70.39 3100 70.52 33.15 74.36 33.47 74.25 33.51 74.70 18.74 74.73 18.73 

10 8278 33.99 8268 34.07 79.49 4245 79.47 4247 81.60 39.04 81.91 39.01 78.83 35.67 78.82 35.82 80.25 36.17 81.29 36.49 8258 2249 83.07 2297 

11 88.03 40.19 87.88 40.21 86.84 47.12 86.77 47.10 87.80 4153 87.90 43.48 86.25 38.16 85.91 38.13 86.11 39.99 8623 39.37 88.36 27.64 88.50 27.72 

22 80.93 104.99 80.73 105.11 85.20 100.34 85.16 10049 87.05 99.13 87.23 99.11 84.03 103.71 84.21 103.76 84.96 101.77 85.37 101.70 8280 115.90 8225 116.84 

23 75.59 108.81 75.70 10880 81.02 99.82 81.14 99.63 8246 101.71 8213 101.93 78.30 106.32 78.59 106.42 79.38 104.40 79.93 104.43 7621 119.35 76.16 119.33 

24 6927 110.56 69.03 110.60 75.71 10208 75.81 10209 76.45 105.15 76.65 105.18 7274 107.26 7273 107.40 74.40 10633 74.76 10628 70.33 121.23 70.39 121.23 

25 64.41 109.70 64.15 109.87 69.81 101.64 69.92 101.67 71.83 103.88 7202 10188 67.09 107.58 67.12 107.62 69.31 10633 69.74 10643 64.27 120.72 64.24 120.72 

26 57.64 107.95 57.42 108.03 65.10 99.06 65.08 99.19 65.55 10153 65.63 103.54 61.30 106.46 61.28 106.63 64.01 104.52 64.63 104.30 58.43 118.37 5842 118.36 

27 5271 104.30 5240 104.07 59.% 96.79 59.94 96.78 59.87 101.72 60.49 10203 56.08 105.84 56.24 106.21 5837 101.76 58.38 101.60 51.97 115.93 5214 115.94 

& Technic ue B 

Too* 
# 

Cast A CastB Cast C CastD Cast E Cast F 
Too* 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Too* 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.36 2280 37.10 2227 35.30 3205 33.10 3247 31.73 28.98 31.48 29.38 0.00 0.00 0.00 0.00 34.95 47.82 35.46 46.67 34.11 13.45 3163 1156 

7 4246 1687 4228 1664 4229 27.87 40.66 27.74 38.01 24.13 37.98 24.38 37.32 19.60 37.05 19.31 43.05 44.75 43.3 44.38 40.08 840 40.04 607 

8 50.55 1375 50.40 13.75 47.72 23.22 45.87 23.25 44.73 17.97 44.45 18.21 45.55 15.90 45.16 15.88 47.88 41.02 48.05 40.99 48.59 167 48.70 1.55 

9 59.41 13.72 5899 13.51 56.65 23.23 54.84 23.12 54.08 1851 53.94 18.70 53.78 14.51 54.06 14.46 56.09 40.55 56.39 40.66 57.61 3.56 57.67 1.34 

10 6644 17.61 65.94 17.85 6231 27.99 60.12 27.99 61.74 2274 6211 2283 61.47 17.12 61.79 16.95 6252 4186 6257 43.82 6660 7.54 66.27 5.36 

11 7209 24.23 7262 23.73 69.74 31.81 67.52 3281 67.97 27.23 68.14 27.69 69.33 19.88 68.76 19.62 67.45 46.32 67.93 46.24 7242 1238 7204 1026 

22 64.24 90.42 64.34 90.26 68.45 85.36 65.71 86.24 67.15 8294 67.45 8137 66.71 8617 65.79 86.13 66.99 109.05 6674 1089 65.59 101.45 66.04 99.14 

23 59.46 9284 59.49 93.00 63.60 85.46 61.70 85.23 6234 85.52 61.70 8622 61.04 87.61 61.07 87.86 61.31 111.51 61.27 111.46 59.83 103.88 59.70 101.69 

24 5285 94.54 5328 94.39 58.05 87.40 55.99 87.40 56.74 89.02 56.67 89.13 55.30 88.62 55.56 8833 56.02 11146 56.17 11152 5167 105.81 53.98 10154 

25 48.05 93.7 47.66 93.60 5211 87.11 50.32 87.14 51.82 87.67 51.70 87.89 49.97 8861 49.90 89.31' 50.70 11162 51.02 11158 47.78 105.27 47.81 103.11 

26 41.74 9203 41.66 9203 47.34 83.90 45.95 84.41 45.73 86.84 45.% 87.33 44.00 88.11 44.90 88.01 45.57 11209 44.99 111.42 4200 10295 41.88 100.79 

27 36.44 8801 3697 8a41 4207 8216 40.32 8273 39.98 85.40 40.41 85.48 38.47 87.42 39.12 87.7 40.44 109.40 39.59 10873 35.79 100.82 35.56 98.91 
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Appendix F 

Area Data Report - 1'4 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 4.96 4.96 4.85 4.85 8.32 16.92 7.11 7.74 12.16 0.60 5.51 8.00 
7 10.55 9.32 9.35 12.07 13.08 10.81 23.11 20.85 11.27 12.67 13.51 11.24 
8 22.42 21.62 12.76 12.36 17.35 17.03 23.83 24.29 13.91 8.97 19.13 16.97 
9 15.51 13.33 10.64 9.92 25.18 25.43 20.85 23.00 15.83 16.83 14.39 21.42 
10 13.91 10.92 7.91 8.00 9.69 9.84 22.77 23.83 5.39 7.97 14.82 11.93 
11 12.93 8.95 11.07 8.20 10.35 9.89 12.24 12.22 9.12 9.03 13.22 11.15 
22 7.40 13.76 7.03 2.90 8.83 8.26 8.57 7.74 6.25 7.80 7.34 8.14 
23 13.68 13.33 2.81 4.33 11.27 10.78 9.72 10.75 7.83 6.91 7.77 9.09 
24 7.66 10.29 8.89 7.48 12.65 13.30 11.87 11.35 8.69 8.57 9.49 9.26 
25 10.67 10.61 7.23 7.43 11.67 12.10 11.93 12.67 9.89 8.52 9.98 9.35 
26 10.81 10.75 6.51 8.43 10.98 8.60 13.33 11.58 7.28 7.46 11.61 7.48 
27 8.49 8.80 10.21 11.76 5.82 6.82 16.29 5.85 9.06 10.41 5.16 5.42 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 31.25 15.80 14.45 23.80 20.59 20.82 45.99 28.73 22.85 25.03 18.52 25.46 
7 24.63 13.96 22.77 25.61 20.79 19.90 29.71 20.67 19.61 26.81 19.47 23.05 
8 34.29 31.08 24.43 34.81 26.12 22.22 45.45 31.60 28.13 28.24 21.59 45.65 

9 32.11 26.12 24.26 36.82 31.37 27.33 36.85 31.23 21.53 21.48 23.43 47.11 
10 23.51 18.55 19.33 29.39 16.14 13.71 32.40 27.21 8.37 16.20 16.03 25.98 
11 13.08 20.70 24.29 21.16 23.11 17.92 23.14 23.63 11.30 26.64 17.49 24.20 
22 12.24 15.97 10.81 24.66 8.14 15.05 23.89 16.92 17.75 17.03 23.97 24.11 
23 22.68 17.20 24.40 21.08 19.93 16.97 17.52 16.83 14.71 18.98 13.05 30.22 

24 21.36 16.43 21.33 22.19 19.44 18.90 20.13 19.18 13.22 13.94 10.06 24.46 

25 19.73 13.42 21.59 20.73 15.14 14.31 18.61 19.50 12.30 13.05 12.42 22.48 
26 22.16 14.94 23.40 23.05 13.99 19.21 20.65 18.44 18.27 19.07 15.54 23.66 
27 25.75 29.56 25.09 25.46 16.37 18.98 23.28 20.10 21.10 17.78 26.35 24.92 
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Appendix F 

Position Data Report - F4 
Technic 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.11 3839 53.11 3805 5285 46.88 5285 4671 51.93 44.82 53.09 44.81 51.22 37.82 51.25 37.85 54.35 39.87 5334 40.13 49.93 2870 50.37 28.86 

7 58.12 33.28 58.60 3287 60.52 4226 59.98 4216 57.53 40.88 58.10 40.52 56.20 37.87 56.09 38.07 61.53 37.49 61.09 37.15 5658 23.35 56.56 23.60 

8 66.42 29.95 6697 29.54 66.14 37.79 66.05 37.61 65.11 34.26 64.47 34.15 64.47 34.18 64.35 34.19 66.59 33.66 65.10 33.50 64.44 18.85 64.19 19.04 

9 74.37 29.55 75.45 29.55 73.57 37.77 73.74 37.41 73.61 34.90 73.72 34.90 7252 33.11 7250 33.04 74.26 33.42 7336 33.50 74.73 ia89 74.65 18.90 

10 8214 34.23 8224 34.22 79.47 4243 79.50 4227 81.79 38.97 81.97 3R97 80.61 35.84 80.57 35.84 81.42 36.47 80.30 36.32 8242 2256 8266 2248 

11 87.64 40.51 87.85 39.75 86.48 46.99 86.84 4695 87.69 43.45 87.88 43.46 87.% 3816 87.% 38.16 86.43 40.00 85.75 39.97 8826 27.57 88.83 27.80 

22 80.07 10633 80.39 104.8 85.17 100.48 85.28 100.52 86.98 99.35 87.14 99.33 85.10 104.80 85.03 104.8 85.54 101.64 84.72 101.74 8228 116.67 8228 11676 

23 7521 109.04 75.20 108.69 80.60 99.71 80.95 99.55 8205 101.96 8234 101.92 80.38 106.34 79.85 106.52 79.63 104.40 79.28 104.35 7621 119.21 7625 119.23 

24 69.43 111.07 6897 110.52 75.63 10207 75.95 101.97 76.42 105.26 76.67 105.19 74.63 107.46 74.51 107.43 74.84 10631 74.12 10640 70.53 121.07 70.33 121.16 

25 64.18 110.12 63.68 109.67 69.94 101.72 69.72 101.56 71.64 103.95 71.86 103.90 68.90 107.64 68.% 107.65 69.64 106.37 69.28 106.53 64.34 120.60 64.24 120.65 

26 57.20 10840 57.19 10805 65.25 99.27 64.91 9878 65.09 103.2 65.79 103.55 63.11 106.60 6298 106.51 64.14 10429 63.83 104.33 5a32 118.21 5846 118.57 

27 5242 104.62 5246 10424 59.91 96.75 59.% 9664 59.94 101.81 60.24 101.90 57.54 105.26 57.68 105.55 59.02 10216 5836 10226 51.86 115.97 51.94 116.03 

Technique B 

T o o * 
# 

Cast A CastB Cast C CastD CastE CastF 
T o o * 

# 1 2 1 2 1 2 1 2 1 2 1 2 T o o * 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 3692 24.42 35.96 23.11 35.51 31.87 36.11 3222 3227 2873 3244 28.94 30.67 2251 30.45 21.06 36.18 47.15 35.% 47.40 34.06 13.41 34.14 13.91 

7 4287 17.50 4252 17.31 4225 28.25 4215 28.12 37.84 23.82 37.62 24.49 37.74 20.42 36.93 19.96 4201 45.31 41.36 43.81 39.87 a73 40.02 8.93 

8 49.74 14.32 50.34 13.34 48.06 23.30 47.30 23.79 44.59 1847 44.05 18.38 45.26 17.04 45.15 16.44 47.52 41.56 47.77 41.36 4806 3.68 48.25 4.86 

9 5883 14.42 5890 13.60 57.42 23.31 57.28 23.% 53.95 19.07 54.35 18.98 54.03 15.92 53.91 15.51 56.39 41.05 55.94 40.97 5828 3.53 58.15 4.69 

10 65.68 17.79 6602 17.69 6284 28.01 6245 2856 61.77 23.09 61.% 2298 61.68 1849 61.72 18.08 6241 43.76 61.93 44.06 6663 7.56 66.30 &19 

11 7235 24.67 71.80 24.32 69.66 3266 68.78 31.71 67.41 27.40 67.51 27.11 68.95 21.05 68.53 20.87 67.03 45.70 67.08 47.08 7265 1264 71.84 1281 

22 64.41 90.47 64.61 89.38 67.36 86.03 68.47 8605 66.19 84.83 66.68 83.96 67.19 8662 66.40 86.66 67.16 108.78 6679 10897 6608 100.60 66.25 100.18 

23 59.25 9293 58.87 9260 63.75 86.01 63.46 85.72 6229 85.22 6235 85.47 61.46 8896 61.18 88.69 61.50 111.61 61.40 111.34 59.77 103.55 59.84 10229 

24 5315 94.25 53.07 94.20 58.23 88.04 58.20 88.06 56.58 89.30 56.63 89.16 56.14 90.09 55.66 90.00 56.18 11361 56.28 113.57 53.80 105.67 53.78 104.81 

25 47.30 9374 47.48 93.51 5218 87.59 5222 87.52 51.% 87.74 51.98 87.78 50.04 90.29 49.74 90.03 50.86 11368 50.82 113.60 47.95 105.18 47.98 104.14 

26 41.53 9250 41.41 9204 46.94 85.01 47.20 84.90 45.53 87.11 45.48 87.13 44.36 89.29 44.28 8853 45.52 111.72 45.37 111.63 41.66 10276 41.92 10218 

27 3654 87.33 3615 8653 4252 8217 4218 8231 41.08 85.60 40.75 8630 38.66 88.10 38.42 88.29 39.74 108.85 39.71 109.05 35.07 9884 35.32 99.23 
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AppendixF 

Area Data Report - F 5 

Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 9.15 4.59 10.92 11.15 12.73 12.73 5.79 0.00 10.32 12.70 8.95 8.75 
7 7.17 9.58 22.16 14.80 11.27 11.87 19.07 30.8 10.15 10.55 10.95 17.03 
8 18.75 17.09 13.51 15.14 12.30 15.05 10.01 18.21 15.46 13.99 16.69 15.89 
9 15.60 12.90 13.96 14.51 21.48 22.97 20.19 20.50 21.94 13.08 15.37 14.60 
10 7.83 12.93 15.14 11.30 7.46 10.49 19.70 18.18 8.29 5.48 13.94 9.46 
11 15.23 . 10.29 13.39 12.96 11.10 9.00 14.28 11.07 8.52 9.18 13.05 30.60 
22 19.87 10.90 5.79 9.92 10.44 6.71 16.06 13.85 9.46 8.80 7.43 4.33 
23 9.43 9.66 11.41 9.58 9.58 9.92 12.50 11.93 5.28 5.25 7.86 8.34 
24 9.95 11.27 16.43 11.38 12.36 12.36 12.16 7.05 6.31 6.85 7.80 8.00 
25 9.98 11.44 12.79 10.75 9.35 8.29 12.01 12.19 6.97 7.46 8.60 9.12 
26 7.51 8.34 11.35 6.05 6.39 5.39 7.97 7.43 7.37 8.20 7.54 7.11 
27 11.64 7.00 14.82 12.01 9.03 29.82 6.14 8.72 7.17 10.44 8.14 15.14 

1 ccnnique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 20.85 26.41 21.53 14.28 17.03 21.51 18.04 17.86 24.00 20.67 18.35 15.89 
7 22.51 21.85 24.43 21.76 18.12 18.84 28.70 20.56 15.94 16.80 16.95 15.31 
8 28.16 28.44 28.24 25.23 21.68 23.34 32.49 28.19 22.19 26.32 34.49 33.09 
9 23.89 24.54 32.43 26.18 28.82 27.70 31.34 26.61 11.27 19.24 36.82 39.14 
10 29.51 22.31 25.26 19.56 14.85 15.28 25.58 23.11 11.04 12.67 22.22 24.23 
11 22.68 23.43 20.22 12.56 19.96 19.73 19.76 19.27 7.40 9.18 18.12 19.81 
22 7.11 6.62 17.03 32.75 29.88 28.04 14.28 21.02 18.87 12.62 13.71 15.34 
23 17.09 8.23 17.26 23.48 18.58 18.15 12.47 17.72 15.66 15.00 14.42 14.16 
24 3.33 13.88 14.85 23.43 18.98 17.69 16.86 17.72 12.47 12.07 13.62 12.22 
25 7.05 11.73 18.61 18.49 14.68 13.73 12.24 16.49 13.94 12.65 12.39 12.42 
26 17.69 17.29 21.30 17.61 14.82 15.77 16.09 16.72 16.92 18.70 12.62 14.19 
27 22.51 18.24 27.27 20.36 36.65 24.14 20.10 24.83 19.44 21.33 16.63 18.58 
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Appendix F 

Position D.u.i Report - 15 

Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.69 38.51 53.15 37.86 53.65 45.90 53.66 46.23 5280 44.82 5280 44.82 50.93 37.54 0.00 0.00 54.18 39.86 54.42 39.79 50.60 2887 50.08 28.87 

7 5877 3311 5854 3273 61.53 41.59 60.53 4204 57.89 40.57 57.82 40.65 55.69 37.57 54.86 38.88 61.39 37.38 61.48 37.30 56.84 23.47 56.19 24.12 

8 66.42 29.92 662 29.39 65.74 37.18 65.66 37.53 65.36 34.12 64.79 34.23 63.31 33.51 6287 34.03 66.48 33.93 6672 33.92 64.66 1886 64.19 1882 

9 74.48 29.68 74.% 29.38 73.88 37.14 73.86 37.51 73.58 34.% 73.55 35.02 7213 3278 70.87 3298 74.09 34.14 73.88 33.61 74.55 18.82 73.87 18.72 

10 8202 33.65 8204 3367 79.39 41.74 79.55 4226 81.62 39.63 81.56 39.08 80.25 35.53 79.04 35.73 80.49 36.45 80.81 36.38 8242 2271 8235 2250 

11 87.55 40.43 87.64 39.94 86.48 46.48 86.50 4680 87.13 43.32 87.63 4345 87.35 37.95 86.12 38.02 86.30 40.14 8626 40.12 8843 27.72 87.36 28.74 

22 80.05 104.62 80.41 104.87 85.19 100.11 85.19 10026 87.07 99.15 87.02 99.34 85.63 103.41 84.16 103.68 8516 101.56 84.98 101.67 8237 116.86 8210 116.99 

23 75.95 10876 7574 10&31 81.17 99.60 81.18 99.72 8205 101.98 8206 101.98 79.85 106.38 78.58 106.56 79.46 104.44 80.74 104.28 76.28 119.30 7582 119.29 

24 69.56 110.79 69.71 110.24 75.97 101.87 75.74 101.95 76.50 10516 76.50 10516 74.39 107.23 7287 107.30 74.59 10628 7459 10627 70.49 121.20 70.08 12121 

25 63.97 110.09 63.27 109.64 69.% 101.49 69.87 101.65 71.83 104.06 71.84 104.11 68.54 107.57 67.27 107.58 69.33 10629 69.34 10629 64.39 120.73 63.90 120.72 

26 57.37 10846 57.19 107.98 65.17 98.58 65.33 99.05 65.85 103.72 65.94 103.78 6240 105.95 61.48 106.15 64.14 104.22 64.12 104.25 5861 118.55 5804 118.56 

27 5232 104.26 5237 104.15 59.97 %.23 59.92 9662 60.06 101.92 60.69 100.08 57.64 105.78 56.39 106.03 58.84 10217 58.42 101.66 5215 115% 51.36 114.97 

Technic nc B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 35.25 23.72 3585 2292 34.63 33.32 34.28 33.18 31.73 29.05 31.45 29.68 30.15 20.49 30.14 20.29 35.57 47.32 3581 47.60 3518 14.12 33.73 13.41 

7 4229 17.51 4248 17.10 4206 28.09 4214 27.% 37.61 24.26 37.59 24.24 37.59 19.55 37.28 19.28 4206 44.80 4242 44.88 39.84 8.57 39.70 855 

8 49.69 13.97 5029 1346 47.38 23.52 47.49 23.38 44.17 1813 43.% 1846 45.56 1601 45.37 15.86 47.15 41.15 47.49 41.23 48.39 4.30 47.94 4.25 

9 59.13 14.55 59.15 13.78 57.17 23.73 57.22 23.41 54.56 1&92 54.05 19.09 54.15 14.87 53.94 14.64 56.53 40.38 5665 40.82 58.61 4.28 58.38 4.33 

10 66.01 1865 66.01 18.20 6247 28.28 6251 28.01 61.73 2290 61.72 23.05 61.% 17.46 61.65 17.47 6228 43.93 6230 43.99 6671 817 66.34 802 

11 71.20 24.53 71.58 24.07 69.27 3242 69.31 31.50 67.45 27.32 67.37 27.35 69.54 20.24 69.20 20.09 66.78 45.01 67.19 45.26 7237 1259 7209 1271 

22 64.58 90.97 64.52 90.20 67.98 86.44 67.60 84.64 6584 81.83 65.59 81.92 67.27 86.37 66.75 85.56 66.92 108.55 6690 109.32 6680 101.11 66.69 101.05 

23 5856 93.53 59.76 9283 63.32 85.27 63.41 8608 6222 8561 6240 8616 61.74 8840 61.25 8827 61.34 111.56 61.33 111.65 60.41 103.36 59.91 103.59 

24 5276 9568 53.10 94.77 57.76 87.52 58.16 88.11 56.56 88.90 56.69 89.11 56.48 89.44 55.79 8928 56.19 113.51 5620 113.51 54.12 105.68 53.95 10584 

25 47.04 94.77 47.44 9377 51.98 87.49 5231 87.66 51.94 87.67 51.95 87.91 49.93 89.11 49.77 89.28 50.44 113.40 50.81 11553 47.71 105.19 47.66 10518 

26 41.34 9246 41.33 9216 47.21 84.33 47.54 84.65 4571 87.12 4528 87.17 43.91 8860 44.12 8820 44.97 111.50 4515 111.42 41.47 10282 41.52 10276 

27 3592 87.42 3605 87.90 41.61 81.87 4251 8233 40.21 84.63 4236 84.54 38.18 8675 38.07 86.55 39.43 10870 39.55 10844 34.93 99.68 34.92 99.49 
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Appendix ¥ 

Area Data Report - lYi 
Technique A 

Tooth # Cast A Cast B Cast C C a s t D C a s t E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.06 2.81 4.96 5.65 5.91 5.02 0.00 0.00 2.72 2.67 6.28 5.96 
7 3.67 3.99 10.01 12.79 4.82 6.22 9.84 14.05 6.39 5.82 3.61 8.11 
8 7.66 9.92 6.62 13.48 6.22 12.76 2.12 17.06 6.97 12.73 5.71 15.23 
9 3.10 9.26 12.01 13.88 16.09 18.92 12.62 15.25 9.23 8.06 6.88 15.91 
10 3.61 7.68 7.80 7.68 3.10 9.15 2.70 16.26 3.50 2.92 4.27 10.24 
11 5.48 6.22 10.15 7.00 5.79 5.45 7.23 6.54 5.76 4.13 7.23 8.40 
22 8.34 10.44 3.47 5.79 4.13 4.62 4.19 4.62 1.41 2.81 1.75 4.27 
23 5.05 7.68 4.27 4.44 5.76 6.45 2.58 9.38 2.87 2.75 6.51 8.60 
24 5.82 6.45 3.04 10.21 9.03 9.26 5.96 6.45 4.85 4.13 6.62 7.03 
25 6.39 5.51 7.03 9.75 4.30 8.63 7.08 7.60 4.99 4.62 7.03 7.57 
26 5.53 4.44 3.53 6.08 3.18 8.92 3.90 7.97 4.87 3.61 5.62 9.09 
27 4.16 2.87 2.15 2.29 3.01 3.01 3.78 3.76 5.10 4.39 3.76 5.10 

Technique B 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 4.76 4.65 9.61 9.35 5.51 9.12 0.00 0.00 9.43 9.72 11.53 11.53 
7 9.61 12.13 21.45 17.49 12.10 13.76 21.73 22.14 20.62 10.35 17.72 12.33 
8 20.01 19.87 21.79 22.48 19.73 16.20 26.09 26.15 16.14 16.34 21.51 18.92 
9 15.43 17.23 21.25 22.08 25.92 24.23 21.79 23.05 16.34 13.94 20.01 18.95 
10 13.82 17.55 20.24 18.12 12.93 13.56 25.29 23.57 8.77 7.37 17.75 14.94 
11 8.92 8.20 14.42 14.71 11.30 9.09 12.70 9.78 3.30 3.58 15.23 14.80 
22 6.97 3.76 4.39 6.48 5.73 8.06 8.63 4.62 9.92 4.24 8.06 11.70 
23 14.60 13.91 9.46 11.70 13.91 13.71 15.25 12.76 10.58 7.83 11.27 9.86 
24 10.70 13.59 14.28 14.48 15.77 15.46 11.90 11.84 10.78 10.90 10.55 9.75 
25 11.47 11.41 12.27 14.37 14.11 12.53 12.39 11.87 12.13 10.29 12.76 12.53 
26 13.13 12.22 10.47 9.72 13.71 13.56 14.80 14.28 17.35 12.27 13.33 11.64 
27 4.10 3.27 3.27 4.01 3.47 5.16 12.93 5.48 17.38 13.36 12.16 6.94 
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AppendixF 

Position T)al;i Report - H i 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.05 37.90 5293 37.90 5286 46.87 52% 46.62 5208 44.88 5209 44.84 0.00 0.00 0.00 0.00 53.89 39.37 53.88 39.38 50.31 2888 50.31 28.80 

7 5874 3249 5850 3255 60.48 4226 60.45 4205 58.30 4022 58.29 40.27 54.38 3800 54.45 37.80 60.93 37.56 60.90 37.59 57.12 2294 56.84 2323 

8 67.28 29.29 65.87 29.16 65.15 37.49 65.68 37.53 64.90 33.90 65.28 34.25 63.46 33.55 6289 34.19 66.38 33.77 66.29 33.99 64.66 18.44 64.71 1859 

9 74.87 29.03 75.13 29.45 73.91 37.68 74.03 37.50 73.71 34.77 73.63 34.93 70.82 33.01 70.74 33.01 73.39 33.53 73.33 33.51 74.90 1&31 74.67 18.66 

10 81.94 33.10 8205 3379 79.47 4246 79.48 4230 81.55 38.60 81.79 39.08 78.28 35.27 78.99 35.84 80.61 36.40 80.53 36.36 8218 2213 8257 2246 

11 87.84 39.60 87.62 39.63 86.59 47.03 86.98 47.19 87.95 43.52 87.98 43.53 86.09 3811 86.38 38.16 85.96 40.06 85.91 39.79 89.08 27.98 88.89 2730 

22 80.41 104.88 80.22 104.8 85.18 100.73 85.21 100.33 87.17 99.27 87.18 99.27 83.16 104.82 83.36 104.82 84.58 10214 84.56 101.99 8290 116.83 8246 116.92 

23 75.46 10836 75.16 108.47 80.99 99.79 81.04 99.61 8227 101.98 82.23 101.98 78.70 106.95 78.45 106.61 78.94 104.49 79.39 104.40 76.20 119.24 7620 119.19 

24 6879 110.37 68.67 110.32 76.32 10211 75.67 10200 76.62 105.14 76-62 105.14 7267 107.45 7281 107.44 74.20 106.28 74.28 106.28 70.36 121.14 70.35 121.23 

25 63.82 109.54 63.67 109.54 69.98 101.75 69.86 101.65 7209 104.17 71.95 103.93 67.12 107.63 67.24 107.62 69.20 106.37 69.08 106.29 64.34 120.67 64.38 120.75 

26 57.05 107.77 56.72 107.68 65.59 99.38 65.38 99.07 65.03 10299 65.78 103.49 61.00 106.47 61.37 106.58 64.09 104.33 63.91 104.30 5849 118.55 5843 118.38 

27 52.42 104.16 5236 104.20 59.95 97.49 60.01 97.36 60.09 101.73 60.09 101.73 56.10 106.06 56.26 106.05 58.69 10223 58.82 10231 51.91 116.00 51.93 115.92 

Technic ue B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.48 19.16 37.06 2220 3276 30.72 3262 30.94 31.46 2882 31.51 29.25 0.00 0.00 0.00 0.00 35.03 47.78 35.17 47.81 34.23 1512 34.29 10.87 

7 4210 14.55 4246 17.05 39.97 26.59 40.29 26.43 37.99 24.54 37.88 24.47 37.39 17.68 36.91 17.70 40.45 43.26 4287 44.91 39.89 862 39.54 646 

8 50.29 10.77 50.05 13.56 45.34 21.93 45.40 21.98 44.55 18.14 45.17 1802 45.47 14.14 45.35 13.99 47.70 41.08 47.98 40.94 47.80 574 48.34 1.47 

9 59.52 10.88 59.38 13.73 54.06 21.97 54.20 2202 54.19 1878 53.99 1880 53.61 1298 53.49 1282 55.65 40.71 55.87 40.56 5807 3.39 58.05 1.26 

10 6645 15.14 66.47 17.76 60.18 26.84 59.75 26.63 61.77 2293 61.79 2299 61.76 15-81 61.69 15.68 6259 43.79 6250 4558 66.31 7.56 66.58 544 

11 7209 21.11 7224 23.89 67.11 31.81 66.64 30.79 67.88 27.00 68.02 27.58 69.04 17.94 68.90 17.92 67.61 46.34 67.72 46.52 71% 1219 7203 10.11 

22 63.95 87.52 64.34 90.19 65.31 84.59 64.83 85.18 67.31 83.12 67.18 83.13 66.11 84.78 66.03 84.60 66.60 109.29 66.43 109.56 6591 101.94 67.47 97.88 

23 59.45 89.89 59.53 9273 61.15 83.85 60.89 83.72 6236 85.65 6228 85.73 61.38 86.42 61.40 86.32 61.58 111.76 61.95 111.52 59.99 103.66 59.95 101.71 

24 5347 91.70 53.21 94.47 55.59 86.24 55.46 86-25 56.55 89.18 56.78 89.10 55.77 87.20 55.58 8722 56.09 113.74 56.22 11557 5584 105.78 53.88 10171 

25 47.88 90.75 47.83 93.64 49.83 85.97 49.64 85.97 51.89 87.81 5208 87.70 50.17 87.46 50.13 87.37 50.55 113.58 50.99 11559 47.90 10518 47.90 10117 

26 41.56 89.19 41.65 91.98 45.01 8273 44.58 8275 45.67 87.20 45.67 87.00 44.30 86.44 43.89 86.43 45.28 111.65 4563 111.55 41.92 10289 41.70 100.84 

27 37.89 85.69 37.32 89.17 40.89 8276 39.78 81.74 40.00 85.30 39.95 85.36 39.20 86.35 38.92 85.48 39.75 109.02 39.65 108.79 3585 100.59 35.74 98.73 
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Appendix F 

Area Data Report - F7 
Technique A 

T o o t h # 
C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F 

T o o t h # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 1.78 1.84 4.96 4.85 3.44 6.42 3.18 7.11 4.04 4.42 5.16 5.13 

7 3.87 4.01 8.83 5.30 4.39 4.19 3.15 3.56 5.39 5.62 10.61 6.65 

8 8.29 9.09 4.90 4.44 7.91 7.00 3.99 10.98 5.85 9.38 13.36 12.85 

9 5.62 5.79 10.81 9.61 14.14 15.48 13.73 14.60 7.68 8.83 13.99 6.22 

1 0 7.23 7.08 7.91 7.74 5.39 5.96 4.30 14.31 2.21 2.72 10.61 9.38 

11 4.76 5.16 9.95 7.08 5.28 5.79 6.22 9.09 5.30 4.27 6.39 7.57 

2 2 5.53 7.60 3.47 2.18 9.15 5.94 10.84 3.41 5.42 2.90 3.99 5.13 

2 3 6.42 6.39 4.76 3.01 5.39 5.65 5.56 4.33 2.90 2.67 6.74 5.88 

2 4 4.36 4.36 5.91 6.16 7.40 7.40 6.71 5.25 2.55 2.52 6.80 6.51 

2 5 3.35 4.70 8.20 6.02 4.22 3.90 6.08 6.97 3.53 4.01 7.11 7.05 

2 6 2.75 3.35 2.72 6.28 2.92 2.70 5.96 4.87 3.90 2.67 6.51 5.19 

2 7 1.43 2.92 2.04 11.24 2.35 2.38 3.90 3.24 6.14 5.62 6.54 5.45 

Technique B 

T o o t h # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F T o o t h # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 15.23 11.35 16.77 10.27 17.12 14.22 12.65 15.83 13.08 14.22 14.16 13.19 

7 16.95 18.06 21.48 18.75 13.30 13.79 21.02 21.62 13.59 16.32 14.19 17.03 

8 22.39 27.96 23.05 20.53 20.56 20.90 28.39 25.41 22.51 23.86 30.05 18.75 

9 17.32 20.70 22.68 20.82 29.19 26.47 23.57 23.86 22.91 21.08 29.22 21.45 

1 0 17.89 16.43 18.21 16.26 13.25 14.42 24.26 26.32 7.89 10.61 23.00 19.35 

11 10.92 9.09 17.58 10.92 15.20 14.60 14.16 15.57 13.10 13.65 16.86 12.99 

2 2 9.92 10.78 20.65 9.23 13.25 10.27 11.76 . 9.78 12.33 15.14 14.39 10.75 

2 3 12.85 12.50 21.53 12.04 10.95 13.79 15.25 12.65 15.46 14.45 13.25 12.44 

2 4 16.37 14.60 22.19 14.88 16.29 15.80 11.99 12.39 13.08 12.76 11.07 10.78 

2 5 13.85 12.07 20.44 15.37 12.96 13.59 10.01 8.86 14.74 12.39 12.87 10.81 

2 6 15.63 17.63 21.10 13.76 14.71 15.40 14.25 12.42 17.61 18.95 13.05 12.10 

2 7 9.41 11.56 25.63 11.41 7.11 18.78 16.54 13.96 12.44 20.19 15.71 11.93 
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Appendix F 

Position D.ii.i Ri-poif - 17 
Technic uc A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5283 3809 5299 38.11 5286 46.70 5285 4688 51.83 44.84 51.66 4545 51.76 37.56 51.48 37.86 53.% 39.85 53.88 40.13 50.03 29.05 50.31 28.% 

7 5835 3284 58.39 3296 60.39 4212 60.13 4222 58.09 40.26 58.29 40.24 56.37 37.53 56.17 37.47 61.01 37.67 61.20 37.64 5655 2167 56.79 2355 

8 65.74 29.27 65.87 29.27 64.83 37.26 64.84 37.42 64.28 34.25 64.03 34.03 65.11 33.73 64.35 34.06 65.53 33.66 6637 33.78 64.47 1887 64.49 18.73 

9 7537 29.56 75.11 29.58 73.73 37.47 73.69 37.61 73.62 35.03 73.66 34.78 73.30 3107 7274 33.08 73.42 33.51 73.66 33.54 74.53 1866 74.95 18.28 

10 8213 34.06 8230 34.04 79.47 4227 79.42 4242 81.68 3894 81.93 39.05 81.12 3538 81.13 35.84 80.76 36.38 81.04 36.53 8259 2273 8274 2254 

11 87.42 40.13 87.86 39.77 86.60 46.85 87.00 47.38 87.84 43.55 87.95 4352 88.92 3816 88.26 38.15 86.26 40.11 8623 39.69 89.23 27.99 88.97 27.87 

22 80.44 104.40 80.46 104.88 85.18 100.56 85.46 100.27 87.05 99.15 87.43 98.79 86.75 103.81 85.55 104.84 8561 101.49 85.26 101.69 8244 116.90 8253 116.69 

23 7517 108.67 75.36 10866 81.04 99.65 80.85 99.76 8204 10201 8227 101.98 80.94 106.45 80.74 106.47 79.90 104.25 80.41 104.11 7621 119.24 7634 119.27 

24 6845 110.52 6862 110.52 75.47 10201 76.14 10211 7648 10521 76.64 10521 75.27 107.39 75.02 107.44 74.33 10628 74.38 10625 70.32 121.13 70.47 121.14 

25 63.19 109.88 63.79 109.74 69.89 101.62 70.05 101.73 71.79 103.79 71.97 104.19 70.09 107.63 69.49 107.62 69.68 10652 69.62 10640 64.30 120.66 64.40 120.66 

26 57.29 108.38 56.80 107.79 65.10 98.23 64.76 99.06 ' 65.58 103.41 65.64 103.38 63.69 106.68 63.46 106.80 64.34 104.32 64.03 104.22 58.55 118.46 58.62 118.52 

27 5232 104.10 5232 104.34 59.93 97.30 59.95 9680 59.86 101.71 60.02 101.69 58.82 106.06 58.30 105.75 58.20 101.68 58.68 101.92 5204 115.86 5200 115.65 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.46 2268 36.65 2247 35.25 3217 35.17 31.73 31.63 29.04 31.98 28.65 29.42 20.19 29.42 20.14 35.13 46.85 34.95 47.68 34.14 1118 3191 13.16 

7 4254 17.11 4211 17.38 4201 27.88 41.76 27.8 37.87 23.88 37.82 24.54 37.08 19.35 37.40 19.12 4296 44.63 4291 44.73 39.87 834 40.02 8.44 

8 50.07 13.70 50.13 13.19 47.38 23.21 47.69 2305 44.67 1800 44.75 1822 45.35 1574 45.35 1568 47.60 41.07 47.66 41.02 47.89 4.11 47.92 151 

9 59.23 13.82 5893 1331 56.97 23.22 56.73 23.08 54.28 1885 54.08 1895 53.73 14.52 53.89 14.43 56.00 40.85 5640 40.74 58.12 181 58.47 147 

10 66.26 17.78 66.19 17.51 6251 27.85 6253 27.96 61.71 2277 61.52 2279 61.78 17.28 61.61 17.38 61.59 43.31 61.97 43.59 66.41 7.98 66.51 7.75 

11 71.43 23.97 71.87 23.51 69.54 3227 69.07 3235 67.82 27.02 67.66 27.04 69.02 19.54 68.57 19.57 66.96 45.61 67.32 45.83 7203 1230 71.71 1200 

22 64.63 90.24 64.69 89.82 67.88 86.07 67.21 85.85 66.73 8381 66.57 8577 66.45 8584 66.03 86X15 66.82 109.22 67.08 10&82 6646 101.07 65.82 101.77 

23 59.19 9285 59.38 9287 63.29 86.34 63.77 85.26 6214 8568 6226 8572 61.27 87.96 61.07 87.75 61.30 111.63 61.61 111.59 59.61 103.63 59.71 103.65 

24 53.39 94.28 53.36 94.46 58.05 88.11 57.97 87.42 56.48 89.13 56.52 89.24 55.56 8875 55.52 88.74 55.93 11142 56.03 113.39 53.89 105.75 53.82 105.75 

25 47.62 9365 47.95 9365 5214 87.64 5212 87.05 51.93 87.65 51.95 87.96 50.23 8879 49.65 88.73 50.31 11527 50.92 113.53 47.74 10517 47.49 10529 

26 41.64 9215 41.79 9212 47.51 85.02 47.46 84.11 45.55 87.09 45.35 87.10 44.32 87.94 44.18 87.81 44.85 111.41 4537 111.53 41.48 1028 41.56 10292 

27 37.18 87.80 37.24 88.26 4204 8275 4232 81.55 40.84 8562 39.26 85.46 38.59 87.49 38.24 86.70 40.20 109.46 39.58 10863 35.01 99.78 34.84 100.02 
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AppendixF 

Area Data Report - F8 
Technique A 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.67 5.79 4.65 4.96 5.91 3.76 0.00 0.00 5.68 3.18 6.31 6.54 

7 2.67 1.55 9.95 9.66 2.92 0.49 4.24 10.35 5.59 5.94 4.67 10.27 

8 1.23 3.01 4.90 7.03 8.00 5.91 3.13 2.12 6.88 6.94 3.73 9.29 

9 2.04 2.06 9.61 8.77 16.11 16.52 2.87 5.30 7.89 6.62 5.16 6.82 

10 4.62 3.70 3.18 7.91 1.81 4.99 4.22 2.64 2.52 2.44 2.47 2.87 

11 6.37 3.78 8.11 7.34 5.28 5.79 5.48 7.74 4.59 4.30 5.19 9.32 

22 3.30 2.41 1.84 2.35 3.64 4.01 4.01 4.07 1.41 2.04 1.63 16.77 

23 3.27 3.30 3.33 3.84 5.56 5.73 2.58 2.72 2.87 2.78 6.71 6.02 

24 5.05 2.47 6.42 4.99 3.13 7.37 5.71 6.37 3.04 3.13 5.91 6.57 

25 5.42 2.47 3.44 4.67 3.76 4.59 6.74 1.89 4.36 4.70 6.19 7.00 

26 3.70 3.56 0.63 0.34 1.98 2.24 4.30 5.76 2.95 3.67 1.92 1.92 

27 3.53 3.13 1.98 1.84 2.38 2.38 3.38 2.70 4.82 4.16 3.18 3.56 

Technique B 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 6.08 8.77 6.48 6.42 7.00 10.15 0.00 0.00 11.96 7.71 8.46 8.77 

7 8.09 9.38 8.86 19.18 7.20 13.05 18.58 11.04 13.76 15.20 10.52 16.95 

8 20.5 19.70 12.76 21.76 7.83 18.84 13.08 7.97 19.61 19.73 13.76 14.22 

9 15.66 15.97 14.65 21.16 19.67 24.49 21.28 15.68 17.69 17.41 14.11 12.53 

10 14.39 14.54 17.15 17.72 10.98 12.85 16.14 10.67 8.11 5.91 6.97 13.05 

11 12.73 8.77 12.22 10.06 8.43 11.27 13.59 13.71 4.59 5.22 13.53 16.54 

22 7.40 8.54 4.04' 3.33 4.96 9.23 7.28 3.50 13.62 9.12 10.58 13.08 

23 14.82 18.55 8.11 0.00 11.99 12.90 14.62 7.91 12.76 8.40 10.72 14.45 

24 10.38 14.48 12.24 12.96 14.31 15.8 9.75 2.98 11.15 10.67 11.47 11.87 

25 11.53 12.10 12.44 12.30 10.41 10.67 11.96 8.72 15.34 11.47 13.13 12.82 

26 11.58 12.36 7.05 5.30 13.30 15.25 12.13 8.54 14.37 13.10 5.73 14.34 

27 4.42 6.97 7.57 10.58 5.25 5.13 11.04 5.36 18.61 13.96 7.48 16.2 
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Appendix F 

Position Daia Rc] wrt - F 8 

Technic ue A 
Cast A CastB Cast C CastD Cast E CastF 

Tooth 
# 1 2 1 2 1 2 1 2 1 2 1 2 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.10 37.56 53.34 37.85 5283 46.89 5286 46.87 53.49 44.32 51.85 44.88 0.00 0.00 0.00 0.00 54.21 39.95 5194 39.61 50.32 28.79 50.36 28.85 

7 57.27 33.10 59.79 31.63 60.49 4225 60.52 4227 57.14 40.84 59.00 40.77 54.28 37.20 54.12 37.67 61.37 37.64 61.07 37.59 5669 23.52 56.68 23.48 

8 6523 29.55 67.95 29.27 64.83 37.43 65.19 37.50 64.44 34.02 64.70 3190 6261 3154 61.74 34.16 66.68 33.71 6635 34.09 6107 1834 64.43 18.99 

9 77.67 29.72 7282 29.04 73.70 37.60 73.59 37.58 73.06 34.% 73.52 34.85 7200 3211 71.80 3239 73.83 33.50 74.18 34.05 74.84 1818 74.90 18.31 

10 82.65 34.35 8221 33.46 79.95 4281 79.46 4245 81.08 3838 81.63 3885 78.69 3519 78.49 35.27 80.93 36.30 80.53 36.26 8281 2210 8277 2221 

11 87.78 39.31 87.95 39.40 86.82 47.11 86.89 47.14 87.33 43.55 87.78 4152 86.64 38.02 86.22 38.12 86.44 39.92 8608 39.82 89.39 27.98 88.28 27.70 

22 80.04 105.48 80.02 105.88 85.44 100.46 85.40 100.47 86.51 99.27 87.00 99.25 83.49 104.65 83.33 104.81 8509 10214 84.67 10214 8289 116.83 8271 115.77 

23 7393 109.01 73.89 109.35 80.97 99.76 80.96 99.79 81.66 101.94 8208 10200 79.04 106.78 78.85 106.94 79.50 104.40 79.10 104.50 7620 119.23 7624 119.27 

24 68.64 110.01 69.74 110.63 75.61 10225 76.23 10213 74.90 105.80 76.45 105.21 73.01 107.27 7285 107.45 74.75 10628 74.50 10628 70.40 121.15 70.39 121.13 

25 63.89 10921 6292 109.76 70.39 10233 70.13 101.75 71.39 104.21 71.87 104.14 67.43 107.45 67.26 108.05 69.69 106.35 69.30 106.32 64.28 120.68 64.31 120.68 

26 5698 107.42 57.00 107.78 66.73 100.42 66.73 100.03 65.78 104.04 66.19 10197 61.64 10671 61.19 106.76 64.10 104.20 64.43 104.41 59.97 119.08 59.97 119.08 

27 5242 103.87 5238 104.21 59.93 97.44 59.92 97.45 59.36 101.72 59.85 101.69 56.39 105.86 56.18 106.00 59.23 10226 59.00 10233 51.86 11601 51.87 115.99 

§i Technique B 
Cast A CastB Cast C CastD Cast E CastF 

Tooth 
# 1 2 1 2 1 2 1 2 1 2 1 2 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 3686 2208 36.93 2218 35.32 3239 3515 3238 31.50 29.14 31.58 29.23 0.00 0.00 0.00 0.00 35.29 47.56 34.91 47.39 33.95 11.33 33.96 11.36 

7 4275 17.12 4229 17.09 4247 27.47 4268 27.67 38.26 23.84 37.67 24.37 37.62 19.38 37.97 18.% 4266 44.86 4269 44.38 39.99 666 39.77 6.78 

8 50.12 1365 50.47 13.47 47.72 2280 48.14 23.19 46.88 1831 44.74 18.09 46.76 1521 46.98 15.98 47.55 40.99 47.51 40.94 48.16 234 49.31 1.58 

9 59.52 1370 59.52 13.78 56.08 2294 56.50 23.15 54.18 1850 53.81 1866 53.73 14.36 53.04 14.85 55.47 40.54 5539 40.50 5843 224 58.05 1.38 

10 6627 17.95 66.34 17.58 61.80 27.85 61.99 27.82 61.71 2277 61.80 2291 6216 17.66 6215 17.66 6249 41% 6278 43.76 66.08 5.33 66.15 5.40 

11 71.71 24.70 71.93 24.03 69.27 3276 69.40 3237 68.18 27.16 68.16 27.48 68.44 19.34 68.38 19.45 67.46 46.36 67.48 46.14 71.75 9.69 7226 10.56 

22 64.03 90.28 64.21 90.33 67.53 86.60 67.67 8579 67.22 8249 66.84 83.82 65.68 8618 66.34 86.34 66.43 10865 6659 108.42 6670 97.75 66.% 97.78 

23 59.45 9269 59.07 9268 63.37 84.87 0.00 0.00 6220 85.65 6206 8602 61.51 88.17 60.95 87.84 61.04 111.07 60.74 111.07 59.83 101.23 59.93 101.68 

24 5238 94.43 53.16 94.43 58.10 87.47 57.94 87.3 56.62 88.78 56.63 89.05 55.76 8876 56.17 89.11 55.45 113.41 5554 11134 54.06 103.43 54.14 101% 

25 47.73 93.63 47.67 93.66 5236 87.15 5220 87.32 5217 87.70 51.98 87.82 50.17 88.85 50.03 89.06 50.17 113.22 50.66 113.48 47.77 10272 47.85 10132 

26 41.61 9208 41.61 9206 48.14 84.85 48.09 84.84 45.66 87.09 45.52 87.13 44.24 87.88 44.70 87.97 44.62 111.11 45.27 111.01 40.61 100.31 41.69 100.88 

27 37.64 88.08 37.56 8810 4252 81.46 4217 81.45 39.86 8539 39.85 8521 39.10 8800 39.19 87.68 39.36 10843 39.23 10830 3541 9828 34.74 97.39 
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Appendix F 

Area Daia Report - SJ lllllli 
Technique A 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.38 5.28 5.42 4.96 4.62 4.44 25.58 5.28 6.59 2.35 5.88 12.53 

7 4.10 4.13 10.24 9.72 4.42 4.90 2.47 4.07 5.88 5.30 3.78 5.05 

8 4.67 3.30 4.7 7.34 9.23 5.16 0.86 3.78 7.91 4.33 10.21 4.13 

9 2.58 7.71 8.89 10.58 16.54 3.81 15.37 1.95 8.06 6.48 9.81 6.65 

10 4.50 4.50 7.05 7.68 5.45 5.05 13.76 15.97 2.38 2.35 4.36 3.21 

11 7.17 4.73 7.11 8.06 6.05 5.85 7.74 6.05 4.19 4.87 10.52 10.47 

22 2.84 4.85 15.20 3.27 3.87 4.62 3.93 3.41 1.41 3.47 5.42 14.94 

23 3.41 3.41 3.87 4.13 5.56 1.84 3.58 3.53 0.86 1.58 3.78 6.22 

24 5.13 6.05 3.61 3.33 8.97 9.03 6.05 3.99 1.63 1.55 6.65 7.05 

25 5.45 5.45 6.59 4.67 2.21 2.35 7.31 6.14 3.84 4.33 7.08 7.31 

26 1.06 3.81 1.92 2.49 3.13 3.53 3.73 3.33 1.75 4.04 4.96 5.62 

27 1.32 3.30 1.69 1.61 2.64 2.38 3.96 3.61 4.13 4.82 5.65 3.47 
liiniifll 

mSSmm Technique 1J illlii 81IIS 
Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 

1 2 1 2 1 2 1 2 1 2 1 2 

6 13.02 13.62 6.65 13.59 9.06 9.86 17.58 17.23 7.31 15.14 4.01 7.48 

7 12.93 20.10 16.17 20.24 8.52 11.15 17.89 19.47 10.49 15.17 15.23 12.07 

8 15.83 19.18 20.79 21.65 17.06 18.04 22.57 24.43 14.45 21.22 18.95 15.20 

9 15.83 15.37 21.65 22.71 22.39 23.34 15.08 19.47 14.14 20.19 16.69 15.46 

10 15.25 9.15 15.40 19.41 10.75 10.29 23.46 20.76 6.82 8.43 8.72 12.19 

11 5.68 5.85 8.32 9.63 11.93 9.89 16.11 12.62 3.04 15.89 4.42 6.28 

22 13.82 7.57 5.59 3.18 4.16 2.90 7.46 9.89 6.54 12.53 4.07 10.84 

23 16.54 16.00 10.67 14.42 13.59 12.87 13.76 13.56 8.72 13.53 9.38 11.04 

24 11.41 9.78 13.36 13.19 14.88 13.25 12.27 11.30 9.95 12.04 8.37 11.10 

25 10.61 10.32 11.38 12.22 13.28 9.41 10.06 12.65 8.86 14.37 8.46 12.07 

26 14.14 13.68 12.01 12.07 8.83 4.87 14.39 14.54 10.72 16.95 11.38 14.14 

27 12.87 14.51 8.66 19.01 3.70 2.41 17.69 20.04 12.56 15.63 5.88 12.22 
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Appendix F 

Position Data Report - SI 
Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5277 37.88 53.30 37.86 5291 46.81 52.86 47.04 51.93 44.79 51.87 44.69 51.61 39.56 51.32 37.79 54.65 38.89 53.83 39.48 50.28 2869 51.93 29.03 

7 57.85 33.02 57.99 33.18 60.47 4227 60.50 4243 58.11 40.24 58.12 40.06 59.06 38.81 55.85 37.18 61.07 37.59 60.82 37.69 57.06 2281 56.79 23.63 

8 67.27 29.27 67.78 29.95 66.53 38.10 64.86 37.66 64.60 34.28 64.73 3377 65.84 34.28 6278 33.56 66.21 33% 6661 33.74 64.60 1887 63.37 18.51 

9 74.89 29.05 74.59 29.30 73.59 37.59 73.76 37.75 73.55 34.88 74.08 34.44 73.77 33.02 74.57 31.85 74.20 33.98 74.58 33.07 74.46 1875 7515 18.30 

10 8232 34.65 8266 34.65 79.09 4228 79.46 4262 81.67 39.07 81.69 39.03 81.97 35.84 80.65 35.66 80.50 36.23 80.32 36.21 8225 2206 8297 2218 

11 87.37 39.90 87.89 39.56 86.90 47.16 86.84 47.29 87.76 4350 87.79 43.35 89.29 3812 88.08 38.00 86.08 39.83 8591 39.87 8848 27.55 88.82 27.73 

22 79.67 105.86 80.35 105.11 85.53 99.70 8521 100.87 87.01 99.25 87.01 99.11 86.37 104.82 85.04 104.68 84.75 10214 84.70 101.58 8217 116.59 8513 115.89 

23 73.68 109.21 74.02 109.21 80.96 99.78 81.00 99.% 8217 101.94 83.27 100.93 81.97 106.94 80.63 106.78 79.69 103.80 7884 104.52 7640 118.76 7649 119.35 

24 6821 110.33 68.78 110.34 76.37 10206 75.20 101.98 76.44 105.15 76.45 104.97 75.85 107.44 74.61 107.33 73.57 10604 7371 10626 70.43 120.94 70.66 121.23 

25 63.44 109.53 63.78 109.53 70.02 101.78 70.13 101.92 73.08 103.% 71.34 103.25 70.27 107.63 69.22 107.47 69.61 10650 69.19 10636 64.35 120.51 64.58 120.74 

26 5629 107.21 57.12 107.90 65.41 99.10 65.71 99.63 64.84 10294 65.93 103.61 64.51 106.32 63.20 106.11 64.84 104.55 6195 104.29 5825 117.83 5866 118.55 

27 5228 104.14 5237 104.19 59.99 97.51 59.% 97.67 59.88 101.70 59.85 101.52 59.33 106.06 57.91 105.85 58.44 10212 58.72 10226 5212 115.70 5218 116.09 

Technic u c B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 3631 23.24 3691 2232 35.45 31.07 35.21 3201 31.07 29.33 3234 2843 29.97 20.34 29.87 20.22 34.64 45.73 35.11 46.17 33.51 10.29 33.47 11.59 

7 4259 17.34 4255 17.37 41.99 27.78 4206 27.89 38.15 24.27 38.07 24.42 37.41 1899 37.54 19.02 4278 44.80 4270 44.65 39.92 622 39.91 6.48 

8 50.25 13.77 50.34 13.82 47.78 23.07 47.97 2318 44.71 17.79 44.59 1820 4565 1554 45.54 1563 47.58 40.92 47.31 41.00 4839 1.31 48.50 1.60 

9 59.37 13.77 59.06 1383 56.88 23.13 56.63 2320 53.90 1854 53.58 1877 54.10 14.03 53.16 14.71 5629 40.58 5571 40.81 57.78 1.05 58.17 1.40 

10 66.32 17.68 66.26 1819 61.98 27.98 6291 28.11 61.84 2283 61.99 2293 61.77 17.49 61.72 17.36 6248 43.63 6276 43.89 6687 505 66.50 5.58 

11 7217 23.55 71.36 24.03 69.47 33.17 69.33 3281 67.68 2686 68.07 27.49 68.86 19.64 68.28 19.42 67.45 46.16 67.84 46.25 7256 9.15 7225 9.77 

22 64.16 8842 64.34 90.38 67.60 84.% 67.74 8655 67.31 8369 67.09 83.17 65.76 8650 66.19 8680 66.75 109.49 6675 109.18 6595 100.04 65.94 100.03 

23 59.11 9272 59.24 9262 63.42 85.66 63.63 85.01 6225 85.59 6231 8580 61.36 87.96 60.89 87.73 61.30 111.69 61.13 111.49 59.71 101.58 60.06 101.87 

24 53.19 94.39 53.26 94.32 57.86 87.31 57.82 87.30 56.75 88.77 56.73 89.25 55.69 88.78 55.51 88.74 56.02 113.63 5629 11152 5188 103.51 53.89 104.08 

25 47.88 9361 47.75 93.65 51.95 87.05 5220 87.00 51.74 87.60 5206 87.95 50.24 8881 50.00 89.01 50.48 113.87 50.47 11134 47.87 103.01 47.95 10146 

26 41.32 91.98 41.49 9202 47.45 84.35 47.57 84.32 45.47 8660 45.95 87.09 44.36 87.95 44.17 88.02 45.28 11200 4500 111.46 41.77 100.61 41.68 101.10 

27 3667 8626 3634 87.03 4294 83.72 4216 8248 39.84 84.94 40.03 8525 38.42 8652 38.25 86.63 39.45 109.18 39.69 10898 34.05 97.40 35.19 98.52 
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Appendix F 

Area Daia Report - S 2 

Technique A 
Tooth # Cast A CastB Cast C C a s t D Cast E Cas tF Tooth # 

1 2 1 2 1 2 1 2 1 2 1 2 

6 7.31 4.70 4.50 6.74 5.42 4.70 10.81 11.35 5.25 6.34 7.34 10.04 

7 4.76 5.85 11.01 9.46 7.31 5.22 8.77 12.93 5.19 4.85 10.49 11.99 

8 16.09 7.20 10.52 9.26 9.26 11.01 16.75 5.62 9.09 8.23 9.81 9.20 

9 6.62 6.22 8.57 10.47 8.77 8.54 13.10 9.00 7.89 9.00 13.96 5.51 

10 7.86 5.65 8.11 7.28 5.42 6.42 10.90 7.68 2.78 2.72 8.97 7.40 

11 6.77 8.20 9.63 7.08 6.88 6.77 6.80 8.43 7.08 5.13 7.74 9.98 

22 11.04 8.00 5.96 7.89 8.49 11.15 11.41 9.92 4.39 4.62 17.35 15.54 

23 7.60 6.39 3.07 3.41 5.88 5.42 6.82 4.79 3.64 4.30 4.76 7.11 

24 3.81 4.30 7.77 7.20 7.17 7.74 5.10 3.96 2.27 2.38 6.34 4.85 

25 5.82 4.04 5.79 6.59 4.13 6.59 5.79 2.01 2.95 3.53 6.80 5.79 

26 5.10 3.90 4.42 6.59 5.65 4.62 4.27 4.50 2.67 3.73 5.48 8.72 

27 3.93 9.63 4.24 12.07 5.45 8.69 6.71 3.56 3.67 5.73 13.16 10.29 

Technique B 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 12.30 16.57 12.67 12.5 15.77 11.47 16.00 15.2 14.08 18.35 11.64 14.68 

7 14.34 16.34 19.38 21.71 14.77 13.19 22.82 19.93 22.88 14.82 15.68 13.99 

8 20.56 24.11 24.23 22.91 21.08 19.33 26.44 23.48 21.65 24.75 33.32 19.87 

9 16.66 26.32 23.51 23.60 24.00 25.35 22.91 21.08 17.66 17.46 34.58 19.35 

10 17.00 17.84 19.38 16.97 13.99 16.20 21.94 19.07 8.97 7.71 13.56 15.91 

11 12.47 11.41 19.21 16.26 9.95 8.97 15.34 12.59 17.00 14.62 13.28 14.74 

22 9.89 7.31 15.74 17.69 27.07 10.90 14.31 7.63 10.38 10.64 11.84 18.47 

23 13.76 13.71 11.24 17.81 16.09 10.06 12.24 13.05 15.94 14.91 11.96 12.76 

24 7.74 9.86 15.89 17.15 15.57 16.77 10.24 10.81 11.58 13.05 10.18 11.56 

25 9.72 10.29 12.73 16.14 13.76 11.73 11.30 13.10 11.61 15.63 9.84 12.33 

26 10.70 16.75 11.41 16.09 15.03 15.97 12.36 15.11 16.26 17.32 12.22 13.02 

27 9.35 17.55 20.59 20.07 35.56 15.20 15.80 14.37 16.86 16.95 12.42 15.89 
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Appendix F 

Position D;ii:i Iti-pnrl - S2 

Technic uc A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5279 38.94 5256 38.56 5283 46.89 5292 46.52 51.78 45.17 51.85 45-04 51.27 3829 51.37 38.32 53.80 39.89 54.41 39.36 50.17 29.69 50.03 29.80 

7 58.79 3107 5877 33.01 59.90 4227 60.62 4224 57.78 40.85 57.62 40.91 57.98 37.03 57.17 37.77 61.00 37.67 61.01 37.70 56.99 2186 56.56 24.40 

8 67.58 29.61 6605 29.41 65.83 37.80 65.31 37.65 64.78 34.15 64.77 34.28 65.71 33.95 64.82 34.03 66.18 33.78 6626 33.89 64.76 19.07 64.71 19.13 

9 75.51 29.72 76.08 29.53 73.59 37.59 73.83 37.59 73.65 34.87 73.74 34.94 73.24 3292 73.08 33.22 73.58 33.45 73.99 33.39 74.88 18.75 75.47 18.37 

10 8276 34.19 8243 33.87 79.79 4256 79.59 4242 81.80 39.04 81.71 38.96 81.74 35.70 8218 36.06 80.77 36.40 80.76 36.41 8111 2273 83.18 2266 

11 88.20 40.34 87.90 40.29 86.53 46.97 86.99 47.35 87.47 43.33 87.57 4308 89.50 3823 88.95 37.97 86.13 39.90 85.82 39.10 89.28 2803 89.06 2732 

22 80.86 105.12 8081 104.74 85.20 100.52 85.17 100.46 87.22 99.21 87.10 9834 87.11 103.68 87.01 10177 85.56 100.86 85.92 100.61 8115 115.94 8138 116.00 

23 75.87 108.79 75.98 10844 80.79 99.78 81.12 99.83 8218 101.98 8220 10204 81.52 106.36 81.63 106.23 79.70 104.33 79.57 104.31 76.66 119.47 76.80 119.37 

24 6864 110.66 6888 110.45 75.75 1021 75.79 10212 76.71 105.18 76.73 105.13 75.71 107.28 75.25 107.16 74.12 10629 74.24 106.29 70.84 121.31 71.08 121.27 

25 64.41 109.86 64.36 109.66 70.04 101.71 70.08 101.82 7217 104.12 71.94 103.92 70.29 107.5 70.27 107.47 69.44 106.39 69.65 106.51 64.74 120.83 64.89 120.86 

26 57.56 10809 57.20 107.81 65.19 98.74 65.05 99.11 65.39 103.24 65.63 103.32 64.33 106.71 64.26 106.69 63.95 104.27 64.15 104.23 5898 118.72 58.75 118.36 

27 5270 104.23 5205 103.55 59.33 96.17 60.04 96.88 59.63 100.76 60.24 101.73 58.25 104.48 59.16 105.90 5893 10231 58.27 101.63 51.95 114.84 5217 114.61 

Technic ucB 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.97 2268 36.05 2289 34.88 3243 35.11 31.97 31.88 2885 31.49 2890 29.96 1865 29.79 20.44 34.51 46.95 34.02 47.35 34.11 11.46 33.28 13.76 

7 4273 17.07 41.97 17.48 4218 27.71 41.92 27.82 37.80 24.24 37.71 24.40 37.22 1802 37.64 18.98 40.22 43.24 40.61 44.96 40.16 656 39.87 837 

8 49.66 13.66 49.86 13.59 47.68 23.24 47.57 23.17 44.50 1807 44.34 18.12 45.48 14.36 45.50 15.65 46.74 40.99 45.63 41.16 4a38 261 48.09 3.60 

9 59.46 13.65 58.60 13.68 56.95 23.24 56.76 23.25 53.58 1855 53.90 18.74 53.54 1118 53.34 14.50 55.28 40.65 54.44 40.74 57.88 238 57.63 3.20 

10 66.15 17.85 6610 17.59 6274 28.12 6271 2803 61.35 2264 61.54 2296 61.90 16.11 61.54 17.21 61.46 43.59 61.01 43.64 66.25 5.71 66.15 7.49 

11 7215 24.14 7221 2208 69.55 3248 69.35 31.92 67.81 26.60 67.92 26.74 69.14 1832 69.14 19.56 67.50 47.07 66.22 46.08 7223 10.63 7235 1228 

22 64.65 90.24 64.86 90.38 67.84 86.66 68.23 86.12 67.47 81.24 68.40 8212 66.60 84.21 66.85 86.93 66.79 109.07 65.29 109.44 66.00 99.50 66.51 100.87 

23 59.43 9273 59.54 93.03 63.81 84.93 63.37 85.66 6233 85.43 61.76 86.34 61.14 86.45 61.22 88.10 60.68 111.56 59.68 111.67 59.91 101.70 59.% 10151 

24 54.36 94.60 53.47 94.48 57.83 87.61 58.24 8800 56.57 8888 56.72 89.11 55.92 87.36 55.65 88.99 55.33 113.53 54.73 11144 5186 104.01 53.% 10581 

25 47.88 93.74 4806 93.65 5233 87.36 5246 87.52 51.88 87.58 5207 87.68 50.28 87.55 49.87 89.12 49.99 113.60 4889 1112 4807 103.29 47.94 10520 

26 41.55 9219 41.10 9245 47.61 84.3 47.43 84.55 45.66 87.17 45.73 87.21 44.53 8659 44.21 88.12 44.65 111.72 4137 111.37 41.82 101.08 41.62 10278 

27 36.10 88.39 36.05 87.43 4219 8207 4213 8240 40.77 83.20 40.11 8613 38.95 86.52 38.74 87.82 39.00 109.09 3811 10884 35.31 9865 35.58 100.06 
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Appendix F 

Area Data Report - S3 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.95 2.67 4.99 5.22 7.23 5.96 0.00 0.00 5.96 6.39 5.96 7.14 

7 5.94 5.28 12.44 12.39 5.48 8.80 14.74 15.20 5.82 5.65 9.49 8.92 

8 8.92 12.13 12.99 13.48 11.81 12.30 17.95 17.95 12.44 11.01 13.48 12.30 

9 8.57 8.75 13.51 14.22 17.43 16.72 16.46 15.43 13.08 10.98 13.08 13.88 

10 8.20 9.29 8.06 8.03 8.20 8.00 15.74 16.23 3.21 3.30 9.81 10.52 

11 7.17 6.59 7.34 8.20 6.34 5.65 5.96 7.20 4.90 4.90 8.37 7.48 

22 10.41 8.75 4.82 4.47 4.44 4.65 12.33 4.82 5.39 3.87 5.85 5.71 

23 7.77 8.03 4.42 4.90 6.65 6.14 6.22 6.28 3.76 2.98 7.00 6.71 

24 6.57 7.03 8.54 7.71 9.06 9.09 7.48 7.51 3.61 4.16 6.91 7.00 

25 5.79 5.91 7.40 7.05 8.26 8.06 7.68 7.97 4.50 5.16 7.54 7.60 

26 6.77 6.02 6.19 5.33 6.02 7.17 8.66 8.86 4.16 4.13 6.91 7.05 

27 4.96 4.36 6.71 7.17 2.61 8.06 4.36 8.09 7.97 4.87 6.08 7.08 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 8.95 15.20 8.00 14.82 13.59 12.76 13.88 17.84 9.98 14.91 11.33 18.01 

7 12.67 13.85 18.06 19.99 13.28 14.74 21.51 24.66 13.68 12.10 17.06 17.26 

8 20.04 19.76 21.51 22.16 17.92 20.30 25.86 26.52 16.17 17.69 18.35 18.41 

9 15.71 15.89 20.82 22.51 25.29 26.90 22.45 22.39 13.79 15.25 18.32 18.12 

10 13.59 14.05 15.43 17.55 12.44 13.19 23.83 23.46 7.25 9.55 15.94 14.62 

11 7.25 12.59 10.32 14.14 15.28 14.28 17.52 18.06 7.31 10.81 14.60 14.14 

22 5.79 15.05 5.62 21.39 13.68 11.41 12.16 19.21 16.26 12.70 17.98 7.40 

23 12.53 14.82 8.20 12.22 12.36 12.07 13.65 14.68 10.72 8.75 12.50 10.09 

24 11.35 12.47 13.53 13.88 14.37 14.48 12.76 11.56 11.10 10.78 10.81 9.75 

25 11.15 12.30 12.90 12.90 8.46 8.60 12.65 12.22 9.89 9.69 11.70 9.95 

26 13.56 13.28 11.56 9.46 13.05 11.47 14.28 13.68 13.71 11.47 11.87 10.87 

27 9.92 16.83 5.68 15.40 15.71 13.71 12.96 20.93 15.80 15.14 16.63 8.20 
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Appendix F 

Position Data Report - S3 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

. X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.11 37.88 53.10 38.07 5286 46.86 5288 4683 51.92 4514 5210 44.86 0.00 0.00 0.00 0.00 54.25 39.86 54.26 39.8 50.31 28.80 50.43 2881 

7 58.28 3285 5842 3298 60.47 4222 60.53 4222 58.28 40.20 57.89 40.72 54.55 37.86 54.65 37.76 61.41 37.59 61.36 37.67 5678 2130 56.81 2327 

8 66.63 29.37 66.24 29.45 66.16 37.81 66.04 37.78 64.99 34.21 64.99 34.23 6298 34.17 6278 34.15 66.67 33.90 6667 33.85 64.49 18.66 64.18 18.63 

9 75.27 29.39 75.48 29.63 74.28 37.66 74.30 37.69 73.69 34.91 73.76 34.83 71.00 33.05 70.72 33.02 73.91 33.75 74.36 33.42 74.55 18.47 74.50 18.50 

10 8224 3185 8217 34.01 79.48 4246 79.49 4246 81.79 39.03 81.80 39.05 79.14 3584 78.96 3583 81.04 36.35 81.04 36.36 8261 2245 8258 2249 

11 87.71 39.90 87.77 39.86 86.89 47.14 86.84 47.12 87.89 4147 87.98 4153 86.58 38.17 86.26 38.12 86.42 39.90 8641 39.71 8889 27.80 89.03 2758 

22 80.39 104.79 80.40 105.01 85.20 100.58 85.16 100.65 87.17 99.30 87.18 99.28 84.40 103.86 83.35 104.85 8542 101.43 8525 101.82 8230 11684 8231 116.84 

23 75.28 10844 75.23 10869 81.05 99.78 81.03 99.81 8226 101.96 8221 10200 79.12 106.65 78.98 106.70 80.09 104.31 79.50 104.47 7623 119.33 76.21 119.34 

24 69.13 110.34 69.01 110.47 75.71 10208 75.77 10205 76.62 10514 76.61 105.14 7290 107.41 7291 107.42 74.8 10629 74.77 10628 70.36 121.23 70.34 121.23 

25 6387 109.55 6178 109.70 69.99 101.77 69.98 101.76 71.99 10192 71.91 103.87 67.39 107.63 67.23 107.64 69.76 10638 69.64 10638 64.34 120.75 64.34 120.74 

26 57.40 107.91 57.16 107.97 65.24 98.88 65.64 99.25 65.64 103.4 65.55 103.37 61.59 106.57 61.42 106.59 64.53 104.32 64.58 104.34 58.50 118.60 58.48 118.53 

27 5229 10174 5239 104.31 59.61 96.38 59.72 9654 60.04 101.69 60.24 101.89 56.43 106.03 56.19 105.97 58.52 101.58 59.31 10233 51.92 11590 5204 115.93 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E Cast F 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.34 19.39 3614 2115 35.10 31.10 35.35 30.92 31.52 29.12 3231 28.60 30.82 17.99 30.39 19.88 34.46 47.53 3529 47.47 34.12 11.13 33.46 1152 

7 4229 14.72 4233 1721 4276 26.47 4222 26.54 37.93 24.45 37.88 24.43 37.43 17.81 37.36 19.31 4248 44.51 4112 44.60 39.80 660 39.73 679 

8 50.06 11.16 50.07 13.69 47.68 21.94 47.77 21.97 44.71 17.85 44.98 18.16 45.62 14.31 45.50 1574 47.15 41.00 47.72 40.98 48.06 1.46 48.18 1.46 

9 59.52 11.20 59.59 1172 56.49 21.92 56.73 21.99 53.79 1857 53.96 1890 53.68 13.12 53.46 14.55 5519 40.47 55.57 40.61 57.80 1.19 58.04 1.20 

10 66.30 15.24 6630 17.78 61.97 26.63 6215 26.76 61.63 2267 61.68 2290 61.75 1601 61.60 1729 61.99 43.68 6243 43.70 6634 543 66.37 541 

11 7217 21.22 71.97 24.26 69.39 31.56 69.32 31.48 68.16 27.40 68.21 27.61 68.90 1842 68.86 19.87 67.17 47.01 67.64 46.07 7200 10.14 71.81 1021 

22 64.05 87.59 64.57 89.05 67.67 85.24 68.03 84.04 67.58 8267 67.42 8269 66.34 84.49 67.05 8511 66.81 108.39 67.40 107.98 6650 98.49 65.64 99.36 

23 59.45 90.16 59.39 9279 63.71 83.72 63.42 8182 6252 8557 6242 8573 61.32 8654 61.20 87.90 60.80 111.43 61.52 110.49 60.02 101.48 59.79 101.68 

24 53.15 91.91 5132 94.52 57.92 86.12 57.97 8619 56.66 88.75 56.70 8895 55.76 87.49 55.59 88.73 5546 11356 5645 11163 5582 10165 53.90 10172 

25 47.68 91.00 47.62 93.64 5213 85.85 5221 8596 5205 87.88 5219 8804 50.19 87.66 49.91 88.98 50.37 113.65 51.10 11177 47.79 103.04 47.83 10122 

26 41.45 89.58 41.46 9201 47.36 8279 47.73 8113 45.40 8687 45.47 87.04 44.29 8662 44.05 88.01 44.82 111.40 4554 111.46 41.60 100.79 41.88 100.92 

27 37.23 84.38 35.95 87.34 4223 81.45 4230 81.06 39.73 8501 39.80 8524 38.65 8596 38.24 86.63 38.92 108.78 39.64 10868 34.86 97.44 35.80 98.52 
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Appendix F 

Area Data Repori - S4 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 ' 2 1 2 1 2 1 2 1 2 

6 2.49 2.67 5.30 4.85 4.39 5.16 2.98 4.04 5.68 5.71 6.02 5.82 

7 3.99 4.16 9.72 8.09 4.93 4.90 4.01 4.59 5.62 5.53 9.52 7.97 

8 4.19 4.39 12.79 8.03 12.42 7.74 17.06 16.54 5.73 6.37 15.80 10.78 

9 3.33 8.80 13.53 11.73 16.75 16.54 12.93 14.82 8.00 7.89 9.78 9.43 

10 4.53 8.06 5.94 7.83 5.48 5.39 14.68 9.72 2.47 3.10 5.25 4.96 

11 6.08 7.11 8.20 8.83 5.13 5.79 7.14 11.15 4.10 4.76 11.47 6.80 

22 3.44 3.44 8.03 4.65 3.73 3.93 4.56 3.87 2.95 3.58 3.93 16.77 

23 7.08 6.25 4.76 3.64 6.22 5.76 5.76 5.94 3.04 2.09 6.91 6.88 

24 5.08 5.76 8.60 6.91 8.97 7.91 6.37 5.25 2.55 2.95 7.00 6.71 

25 5.53 5.45 7.66 6.88 6.39 4.47 7.31 7.28 4.24 3.93 7.60 7.34 

26 3.53 3.87 9.61 6.11 5.71 3.07 7.66 7.71 3.81 2.98 7.80 4.76 

27 3.50 3.07 11.87 9.81 2.95 2.61 2.98 4.13 5.39 5.30 3.44 3.56 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 4.01 10.92 14.54 7.46 8.72 7.08 6.08 0.00 7.48 0.00 10.18 7.83 

7 11.47 14.37 17.35 18.15 12.96 11.67 20.44 22.22 13.59 12.85 16.46 18.01 

8 17.69 18.67 18.35 23.43 19.53 17.75 27.41 25.32 17.89 17.32 18.32 17.58 

9 16.66 20.24 20.19 21.88 25.06 22.68 22.51 23.28 17.09 15.68 18.61 18.58 

10 15.31 13.65 17.18 17.03 11.61 10.87 22.37 23.11 8.09 7.23 17.15 18.24 

11 7.74 11.96 10.32 10.52 8.43 9.98 15.43 15.05 7.46 6.42 15.43 14.65 

22 5.88 11.07 6.91 3.56 5.19 6.31 4.85 6.62 16.89 18.75 13.28 9.63 

23 14.62 14.14 10.06 8.72 14.74 13.65 12.85 16.32 16.00 15.74 11.21 10.52 

24 12.59 11.90 10.21 14.14 16.00 15.71 11.87 13.28 12.24 11.90 10.06 11.07 

25 11.73 10.98 11.04 13.16 12.87 12.76 12.27 13.45 13.42 11.15 12.16 11.30 

26 14.48 10.29 9.75 12.22 13.33 13.16 13.62 14.71 16.69 14.88 12.44 11.56 

27 11.24 14.60 13.82 6.42 2.95 3.96 12.85 13.30 16.86 16.72 9.86 8.23 
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AppendixF 

Position Diiui Report - S4 
Technique A 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5292 38.11 5293 37.90 5289 46.82 5285 46.71 51.86 44.87 51.49 45.59 51.02 37.88 51.13 37.84 54.21 39.95 54.03 39.% 50.30 2870 50.28 28.68 

7 58.12 33.08 57.68 3319 60.50 4226 60.36 4211 58.11 40.22 58.29 40.23 54.85 37.63 54.93 37.68 61.37 37.64 61.20 37.65 56.80 23.24 56.76 23.17 

8 66.56 29.44 65.36 29.37 65.99 37.73 65.36 37.39 64.71 34.31 64.93 34.03 64.18 34.15 64.38 34.17 66.69 33.67 66.48 33.68 64.67 1876 64.48 18-83 

9 74.89 29.03 75.06 29.43 74.28 37.66 73.90 37.49 73.57 34.83 73.69 34.87 7232 33.00 7231 33.00 73.83 33.51 73-66 33.50 74.59 1888 74.38 18.72 

10 8264 34.61 8208 33.89 79.62 4259 79.47 4228 81.65 38.94 81.65 39.21 80.31 35.84 80.03 35.74 80.90 36.28 80.89 36.36 8269 2219 8270 2229 

11 87.81 39.63 8752 39.97 86.84 47.12 86.50 46.97 87.85 43.56 87.95 43.52 88.09 3847 87.54 38.18 86.42 39.78 86.25 39.92 8836 27.56 89.16 27.81 

22 80.04 105.83 79.87 105.83 85.17 100.45 85.14 100.48 87.01 99.28 87.17 99.25 84.72 104.82 84.85 104.81 85.58 101.58 85-89 100.46 8245 116.85 8271 115.61 

23 75.48 10834 75.31 10832 81.06 99.81 80.97 99.60 8208 101.97 8227 101.98 80.20 106.49 79.90 106.56 80.24 104.29 79.83 104.37 76.24 119.16 76.21 119.06 

24 6865 110.31 6873 110.38 75.70 10208 75.68 10206 76.50 105.12 76.66 105.18 74.20 107.45 74.49 107.40 74.65 106.29 74.58 106.29 70.35 121.06 70.39 120.% 

25 63.85 109.54 63.59 109.53 69.98 101.71 69.91 101.55 71.78 103.94 7208 104.15 68.58 10763 68.75 107.63 69.70 106.36 69.80 106.51 64.33 120.58 64.32 120.49 

26 56.98 107.8 5694 107.88 65.15 99.08 65.13 99.06 65.74 103.44 66.16 103.83 6281 106.64 63.03 106.63 64.62 104.34 63.91 104.19 5820 11822 5832 117.86 

27 5242 104.21 5230 104.28 59.95 96.81 59.91 96.59 59.92 101.72 60.04 101.69 57.59 106.04 57.86 106.12 5881 101.89 5881 10205 51.88 115.92 51.87 115.82 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.33 2230 36.42 24.18 36.08 31.54 35.24 3236 31.84 29.03 31.71 29.39 3260 19.19 0.00 0.00 34.99 47.70 0.00 0.00 34.09 13.29 33.94 13.50 

7 4235 17.41 4222 17.27 4260 27.68 4237 27.80 37.97 24.37 38.00 24.69 37.48 19.12 37.15 19.27 43.20 44.33 43.37 44.42 39.78 857 39.71 874 

8 5024 13.68 50.25 13.67 48.10 23.2 47.89 23.21 44.56 17.98 44.94 1802 45.50 15.67 45.44 15.73 47.81 40.99 4822 41.05 4825 3.47 48.18 3.45 

9 59.45 13.78 5899 14.18 56.63 23.11 56.56 23.18 53.73 18.62 53.58 1856 53.64 14.53 53.43 14.58 55.51 40.72 55.66 40.69 5802 3.30 57.87 3.29 

10 66.36 17.91 66.44 17.99 6226 27.86 6240 27.88 61.64 2265 61.93 2291 61.88 17.34 61.70 17.35 6259 43.83 6248 43.66 66.53 7.63 66.36 7.66 

11 7207 24.05 71.76 24.90 69.53 3235 69.47 3276 68.04 27.42 67.99 27.53 68.63 19.52 68.43 19.50 67.70 47.19 67.90 47.00 71.83 1209 71.93 1208 

22 63.98 90.42 64.73 89.90 68.67 85.31 67.86 86.33 67.21 8290 67.07 83.23 66.31 86.82 65.83 86.50 67.38 10829 67.42 10801 66.25 100.54 66.52 100.13 

23 59.33 9280 59.51 9280 63.78 85.61 63.56 85.00 6229 85.63 6221 85.64 61.62 8812 61.22 88.17 61.11 111.50 61.00 111.58 59.94 103.64 5976 103-72 

24 53.28 94.36 53.34 94.37 58.39 87.64 57.89 87.37 56.74 89.05 56.71 89.15 55.72 88.86 55.45 88.96 56.01 113.52 56.08 113.51 53.75 105.72 53.87 105.75 

25 47.82 93.64 47.82 9353 5246 87.55 5218 87.16 51.90 87.54 51.90 87.71 50.12 89.06 50.01 89.11 50.33 113.34 50.85 113.46 47.85 105.17 47.92 105-19 

26 41.46 9205 41.37 9201 47.70 84.99 47.44 84.16 45.59 86.86 45.54 87.03 44.51 87.94 44.20 88.11 45.00 111.54 45.08 111.19 41.58 10286 41.90 10284 

27 36.01 87.86 36.81 85.85 4243 8268 4288 83.27 40.00 85.20 39.99 85.34 39.25 87.80 39.04 88.08 39.50 1089 39.34 10880 35.50 100.60 35.61 100.50 
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Appendix F 

Area Data Report - S 5 
Technique A 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.29 2.84 4.99 5.42 6.54 7.37 0.00 0.00 6.42 5.33 10.92 7.23 

7 4.36 3.15 9.81 7.63 5.94 5.42 4.70 14.94 6.11 5.82 9.78 9.38 

8 5.82 8.75 10.29 8.11 12.67 12.24 16.83 17.09 11.90 6.62 17.78 14.85 

9 6.85 4.27 12.42 13.56 18.01 18.18 15.43 16.46 15.63 9.98 16.83 15.54 

10 4.39 4.13 8.32 8.29 8.57 7.51 16.34 15.40 4.36 3.44 5.68 12.19 

11 8.34 8.46 9.15 7.25 5.13 5.85 11.01 11.15 5.91 4.47 11.90 12.04 

2 2 3.24 3.04 3.24 3.27 4.10 4.01 4.10 11.15 3.38 3.64 5.56 8.03 

2 3 8.34 8.06 2.92 4.13 5.30 6.45 3.61 9.38 5.42 3.01 6.91 6.74 

2 4 5.82 6.08 6.37 6.97 7.63 10.06 8.14 7.71 4.73 '3.70 6.74 6.65 

2 5 5.94 5.73 4.67 6.94 4.44 8.17 7.40 7.68 4.65 5.05 7.48 7.08 

2 6 4.16 4.07 2.98 3.13 3.81 7.05 8.69 8.09 5.65 3.78 9.03 5.82 

2 7 4.36 4.59 3.24 3.76 2.98 7.51 5.42 8.00 8.00 4.65 6.54 6.88 

Technique B 

Tooth # C a s t A C a s t B C a s t C C a s t D C a s t E C a s t F Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 8.72 9.15 6.22 6.45 14.74 6.45 0.00 0.00 5.48 8.29 5.85 5.71 

7 10.95 13.10 19.33 16.83 13.19 16.83 21.62 25.29 10.55 12.10 10.47 6.59 

8 18.29 17.15 21.05 18.72 20.07 18.72 26.95 25.20 11.93 16.17 18.95 8.23 

9 16.52 12.04 22.77 20.90 23.11 20.90 22.91 22.80 15.28 15.37 18.67 10.70 

10 14.19 14.65 19.78 14.34 12.99 14.42 19.84 22.91 9.55 8.46 12.79 7.68 

11 8.49 10.61 8.43 10.72 12.82 10.72 13.45 12.93 7.05 8.57 12.62 11.93 

2 2 6.57 6.65 3.87 7.57 6.22 7.57 16.03 6.34 12.47 9.26 7.97 1.92 

2 3 14.31 14.91 10.78 10.29 13.82 10.21 12.22 12.04 12.82 11.70 9.58 7.43 

2 4 15.20 13.45 14.16 14.65 15.51 14.8 12.79 12.10 11.35 10.92 10.78 8.63 

2 5 10.98 9.61 13.08 13.05 12.62 13.02 13.48 12.07 10.44 11.44 11.47 10.75 

2 6 14.02 11.78 11.61 4.76 13.25 4.76 14.57 14.71 16.52 13.56 12.22 10.24 

2 7 5.10 5.39 13.85 7.48 3.93 7.48 11.15 9.38 15.54 15.97 5.82 6.57 
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Appendix F 

Position D.U.i Repoil - S 3 

Technique A 

Toodi 
# 

Cast A CastB Cast C CastD Cast E CastF 
Toodi 

# 1 2 1 2 1 2 1 2 1 2 1 2 Toodi 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 53.05 37.91 5110 37.89 5286 46.86 5291 4681 51.68 4540 51.90 45.18 0.00 0.00 0.00 0.00 54.20 39.47 54.13 39.69 51.10 2888 50.41 28.98 

7 58.59 3265 58.84 3239 60.51 4226 60.36 4226 58.23 40.45 58.36 40.10 53.89 37.37 54.25 37.84 61.10 37.56 61.24 37.59 57.07 23.47 56.78 23.62 

8 65.66 29.30 6602 29.28 65.66 37.64 65.50 37.61 6512 34.26 64.94 34.27 6270 34.18 6267 34.15 66.40 33.93 66.65 33.75 6530 19.08 64.54 18.89 

9 75.25 29.32 74.91 29.10 74.15 37.63 74.12 37.67 7570 34.89 73.72 34.90 70.55 3102 70.66 33.06 73.92 33.84 74.08 33.41 74.88 1886 74.62 18.79 

10 8203 33.22 8201 3120 79.50 4245 79.50 4245 81.80 39.08 81.79 39.02 78.80 3584 78.80 35.87 80.00 36.07 81.00 36.43 8297 2245 8242 2274 

11 87.62 40.04 87.60 40.07 86.93 47.33 86.% 47.29 88.02 4156 87.% 4152 85.88 38.19 85.84 38.18 86.27 40.50 8624 39.92 8870 27.78 88.37 27.78 

22 80.05 10580 80.02 10586 85.15 100.82 85.23 100.77 87.15 99.30 87.17 99.25 83.16 104.80 84.00 103.89 84.86 101.88 8517 101.74 8265 116.93 8295 115.81 

23 75.22 10851 7529 10849 80.83 99.76 81.00 99.79 8214 10208 8228 101.94 78.69 106.92 78.30 106.62 79.58 104.50 79.30 104.50 7651 119.40 7621 119.40 

24 6876 110.36 68.80 110.32 76.04 10217 76.05 10220 76.67 10520 76.61 105.24 7268 107.43 7265 107.41 74.46 106.37 74.63 10628 70.73 121.30 70.34 121.31 

25 63.87 109.51 63.79 109.55 70.13 101.75 69.99 101.90 7224 104.14 71.94 103.89 67.05 107.63 67.06 107.63 69.30 10633 69.53 10640 64.63 120.84 64.32 120.83 

26 57.19 107.95 57.20 107.97 65.41 99.26 65.54 99.34 65.88 10160 65.51 10135 61.25 106.57 61.27 106.62 64.24 104.48 64.47 104.36 5873 118.50 5849 118.69 

27 5239 104.14 5238 104.15 59.64 %.88 59.38 %.37 60.19 101.91 60.23 101.89 56.38 106.31 56.03 105.97 58.22 101.61 59.22 10234 5231 116.03 5208 116.05 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.20 2210 37.58 2272 35.17 3261 35.46 3264 31.46 29.23 35.46 3264 0.00 0.00 0.00 0.00 35.47 47.95 35.13 47.75 3193 1146 33.67 1357 

7 4262 17.12 4214 17.28 4256 27.72 4294 27.76 38.18 24.32 4294 27.76 37.51 19.96 37.10 20.21 4295 45.24 4295 4506 40.62 7.79 40.47 7.50 

8 50.23 1557 50.25 1184 48.04 23.11 48.49 2111 44.24 1820 48.49 2111 45.44 16.49 45.45 1636 48.45 41.44 48.10 41.23 47.96 3.54 48.21 292 

9 59.42 1582 59.58 14.17 56.% 23.19 56.93 2111 53.78 I860 56.93 23.11 53.73 1530 53.43 15.17 55.89 40.87 55.73 40.75 5821 136 58.14 284 

10 6637 17.90 6588 17.72 6242 27.99 6229 28.04 61.71 2299 6229 28.03 6210 1830 61.61 18.04 6257 43.83 6271 43.% 6662 7.34 66.43 694 

11 71.98 24.00 7205 24.36 69.60 3251 69.65 3295 68.09 27.28 69.65 3295 68.62 20.16 68.49 20.07 67.64 47.34 67.78 47.52 7234 1213 71.94 1244 

22 64.37 90.42 64.33 90.38 68.10 86.56 67.41 86.66 67.15 8137 67.41 8666 66.76 86.24 66.03 87.63 67.07 10&74 67.09 109.60 67.08 100.33 66.13 10159 

23 59.39 9277 59.64 9275 63.33 85.29 63.57 8503 6212 8567 6160 8502 61.23 8876 61.54 88.74 61.24 111.83 61.56 111.65 60.07 103.59 60.06 10189 

24 5321 94.28 5127 94.51 58.15 87.50 58.28 87.37 5681 89.19 58.24 87.38 55.70 89.75 55.73 89.68 56.13 11174 56.34 11173 5181 105.73 53.86 10573 

25 47.79 9162 47.72 9165 5226 86.92 5248 87.16 5205 87.79 5247 87.15 50.18 90.00 49.93" 89.89 51.03 11190 50.95 11385 47.74 105.25 48.00 10512 

26 41.66 9207 41.33 91.95 47.52 84.17 48.24 84.86 45.27 8690 48.24 84.86 44.47 88.96 4427 88.67 45.55 111.29 45.60 11214 41.73 10282 41.87 10295 

27 37.55 88.17 37.60 87.78 4257 81.% 41.% 8213 40.00 8583 41.% 8213 39.32 8885 39.22 8821 39.49 10890 39.79 109.27 3602 100.82 35.47 100.70 
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Appendix F 

Area Data Report - S6 
Technique A 

Tooth # 
Cast A CastB Cast C C a s t D Cast E Cas tF 

Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 2.67 2.38 5.45 4.96 4.85 4.01 4.04 2.32 5.30 4.47 5.42 6.51 

7 4.13 3.99 8.09 10.58 4.39 4.59 4.53 4.85 5.62 5.39 3.61 3.87 

8 3.13 5.96 6.82 5.42 6.51 8.72 3.99 3.30 7.00 6.08 5.36 4.82 

9 4.36 5.45 • 8.57 10.04 16.34 16.54 4.87 3.15 9.12 8.40 6.42 6.65 

10 2.92 3.87 7.68 7.89 4.99 5.65 3.07 5.05 2.52 3.10 5.85 5.88 

11 6.08 8.43 7.34 5.94 5.13 5.79 7.03 7.20 4.10 4.76 11.78 10.49 

22 3.04 2.98 16.32 4.56 3.93 3.73 3.93 4.27 5.22 4.33 3.87 9.06 

23 4.56 6.71 4.96 2.92 4.93 5.76 2.70 3.87 2.12 2.90 6.16 6.28 

24 3.35 6.05 3.21 7.28 8.95 8.00 4.65 5.76 3.47 3.44 6.57 7.03 

25 3.53 5.68 7.08 7.03 4.19 4.85 2.70 5.51 4.79 4.79 7.08 7.51 

26 3.38 3.87 9.15 3.47 2.15 3.50 3.73 5.08 3.41 3.50 5.73 5.36 

27 2.27 2.81 11.35 4.01 2.95 2.35 4.07 4.33 4.79 5.36 6.71 6.28 

Technique FJ 

Tooth # Cast A CastB Cast C C a s t D Cast E Cas tF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 26.70 23.97 15.23 15.20 17.15 17.09 28.56 26.64 17.52 18.24 11.38 15.71 

7 14.54 18.06 21.99 22.51 13.22 16.32 22.37 25.00 18.44 18.15 18.55 19.96 

8 21.13 21.42 24.09 25.58 20.10 22.48 26.44 27.41 21.88 21.94 20.39 22.39 

9 17.61 16.60 23.28 23.71 27.90 26.09 23.77 24.80 20.27 18.12 17.38 22.77 

10 15.57 15.57 20.04 18.81 13.22 13.96 23.48 25.81 9.26 8.43 18.01 17.06 

11 12.73 18.90 17.92 17.18 13.91 12.73 18.01 18.15 25.26 21.53 15.37 14.97 

22 12.70 5.96 26.87 19.18 16.66 14.60 26.04 10.06 19.35 13.51 19.10 11.18 

23 14.42 16.57 17.66 18.21 14.71 15.60 14.68 15.31 17.38 16.14 10.75 10.81 

24 13.53 12.04 14.42 14.19 16.54 17.38 12.22 12.99 12.96 12.67 11.21 10.55 

25 12.39 11.44 14.05 15.86 13.48 14.25 13.48 12.85 14.57 13.45 12.04 12.10 

26 13.02 11.99 17.15 16.34 14.39 15.17 13.76 15.28 17.75 18.01 13.76 13.30 

27 12.87 8.77 18.64 19.33 17.63 15.91 21.25 12.59 16.49 17.78 17.12 10.27 
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Appendix F 

Position Data Report - S 6 

1eel ink 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5293 37.90 53.11 37.88 5291 46.81 5286 46.87 5208 44.82 51.87 44.88 51.14 3803 50.89 37.74 53.97 39.69 53.83 40.22 50.18 2893 50.35 28.85 

7 57.82 33.18 5867 3255 60.36 4228 60.52 4226 58.28 40.24 58.08 40.25 55.63 37.53 55.98 36.91 61.03 37.64 61.18 37.67 57.12 2294 57.07 2299 

8 67.80 29.27 65.87 29.32 65.19 37.49 65.12 37.54 64.86 33.91 65.04 34.10 64.10 33.90 63.55 33.55 66.50 33.76 66.85 33.80 64.67 1843 64.49 18.38 

9 74.76 29.11 75.74 29.41 73.58 37.59 73.74 37.58 73.72 34.79 73.55 34.87 73.45 3251 73.05 3211 73.54 33.53 73-60 33.52 74.77 1827 74.82 1850 

10 81.39 3262 81.82 3294 79.46 4245 79.46 4244 81.81 3885 81.66 3893 79.90 35.42 79.71 35.21 80.59 36.30 80.89 36.36 8277 2243 8271 2241 

11 87.64 39.63 87.63 40.03 86.89 47.14 86.84 46.% 88.02 43.56 87.78 43.52 87.84 3830 87.45 37.95 86.08 39.78 86.25 39.92 8831 27.68 88.47 27.73 

22 79.85 105.86 80.03 105.84 85.55 99.66 85.16 100.64 87.17 99.25 87.01 99.28 84.85 104.98 84.51 104.65 85.51 100.79 85.81 100.57 8248 116.92 8276 115.91 

23 75.74 108.20 75.26 10851 81.12 99.81 80.86 99.75 8229 101.96 8210 101.98 80.40 107.12 80.16 106.73 79.70 104.35 79-34 104.49 76.23 119.27 76.18 119.34 

24 6801 110.34 6889 110.38 76.37 10209 76.00 10214 76.62 105.14 76.48 105.18 74.34 107.62 74.01 107.26 74.39 106.28 74.27 10617 70.38 121.13 70.35 121.23 

25 64.32 109.47 63.90 109.54 69.90 101.66 69.97 101.79 7205 104.18 7201 104.10 68.49 107.82 6872 107.43 69.40 106.43 69.53 106.39 64.36 120.68 64.36 120.74 

26 57.11 10806 57.11 107.88 65.13 99.04 65.60 99.38 66.37 103.99 65.34 103.37 6299 106.49 6256 106.67 64.60 104.46 63.94 104.17 5848 118.49 5850 11862 

27 5242 104.20 5242 103.85 59.94 96.79 59.77 %95 60.09 101.72 59.86 101.71 57.83 106.23 57.52 105.87 5863 10202 5879 10204 5205 115.87 5205 115.94 

Technique B 

Tooth 
# 

Last A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 36.21 24.35 36.42 23.71 3232 31.33 35.28 3214 31.68 29.05 31.53 29.29 30.10 19.72 29.98 21.10 35.28 47.32 35.72 47.10 3287 14.23 33.97 13.27 

7 4227 17.45 4259 17.32 39.59 26.72 4203 27.95 37.73 24.56 37.87 24.56 37.36 17.95 37.23 19.40 4255 44.44 4273 44.47 39.87 876 40.00 867 

8 50.26 1362 50.09 13.66 44.95 2211 47.37 23.37 44.60 18.00 44.50 1837 45.45 14.33 45.37 15.71 47.46 41.07 47.78 41.02 4826 3.61 4849 577 

9 59.58 13.76 59.56 13.80 54.34 2206 56.95 23.29 54.08 1865 53.87 1883 53.68 1322 53.60 14.63 55.48 40.88 56.02 40.69 5817 123 57.60 551 

10 66.30 17.69 66.35 17.86 60.00 26.75 6249 27.93 61.84 2280 61.65 2289 61.74 1601 61.59 17.40 6226 43.69 6262 43.78 66.12 7.53 66.35 7.55 

11 71.79 2294 71.40 23.68 67.17 31.31 69.66 3236 68.21 27.25 67.80 27.02 69.35 1863 69.00 19.91 66.67 46.69 66.56 46.34 71.88 1212 7202 1225 

22 64.84 89.93 63.91 90.46 65.83 84.23 68.06' 86.28 67.69 8270 66.60 83.18 67.52 84.23 65.85 8628 67.42 108.13 66.91 109.00 6669 100.39 6599 101.57 

23 59.32 9286 59.18 9282 61.00 84.34 63.46 85.59 6233 85.46 6233 85.54 61.34 8664 61.15 87.95 61.01 111.42 61.25 111.48 60.01 10168 60.03 10570 

24 53.51 94.43 53.22 94.47 55.49 86.22 57.% 87.37 56.66 8893 56.69 89.12 55.69 87.43 55.45 88.83 55.% 113.42 56.28 113.49 54.02 105.68 53.90 10574 

25 47.76 93.51 47.76 93.62 49.73 85.98 5232 87.23 51.88 87.62 5200 87.71 50.21 87.6 50.09 89.01 50.27 113.27 50.67 11144 47.99 105.18 47.97 10519 

26 41.42 91.87 41.41 91.87 44.85 83.22 47.39 84.40 45.52 86.84 45.57 87.10 44.35 86.66 44.15 8803 44.73 111.39 4521 111.48 41.88 10278 41.65 10275 

27 36.32 8812 37.17 87.23 39.74 81.12 4211 8216 40.20 85.93 41.00 85.37 38.45 85.66 39.15 88.11 39.36 10&81 39.63 ioa78 34-80 99.34 3543 100.53 
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Appendix F 

Area Daia Report - S7 
Technique A 

Tooth # 
Cast A CastB Cast C C a s t D Cast E Cas tF 

Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 5.19 2.55 4.50 4.85 , 5.36 6.08 0.00 0.00 5.10 5.71 6.02 7.60 

7 3.18 4.50 10.90 11.27 4.73 4.36 10.06 12.99 5.19 6.74 3.35 8.83 

8 9.18 8.63 7.08 8.26 11.38 6.54 15.34 10.18 6.31 6.74 5.51 12.10 

9 5.68 5.45 12.90 10.58 15.28 5.65 14.65 11.78 7.80 8.95 6.82 6.65 

10 5.65 5.94 8.23 7.89 5.39 5.73 15.91 4.67 2.87 3.33 8.75 5.73 

11 5.51 5.39 9.49 9.98 5.48 5.08 6.94 7.37 4.67 3.99 10.81 5.08 

22 7.48 2.35 2.21 2.44 3.93 4.65 12.19 11.53 4.59 3.64 15.48 3.76 

23 6.31 6.97 3.13 4.42 5.62 6.02 7.20 8.17 3.53 3.18 6.85 6.82 

24 5.36 3.67 8.26 7.23 6.80 8.00 6.65 6.82 3.84 2.70 6.77 6.51 

25 5.13 4.27 7.28 7.00 3.84 4.04 7.51 7.74 4.30 4.53 7.46 7.05 

26 3.53 2.58 5.88 2.61 3.58 2.47 7.94 8.43 3.07 3.64 5.68 5.79 

27 3.99 2.29 2.41 2.09 3.27 2.95 8.80 3.78 6.85 6.39 9.29 6.34 

Technique B 

Tooth # Cast A Cas tB Cast C C a s t D Cast E Cas tF 
Tooth # 

1 2 1 2 1 2 1 2 1 2 1 2 

6 16.34 14.14 14.94 15.25 19.35 17.49 0.00 22.88 15.46 17.46 10.87 16.32 

7 16.29 14.48 17.46 18.98 15.40 14.31 21.05 27.07 14.19 9.29 15.11 18.09 

8 22.77 18.75 22.28 21.99 23.31 20.99 26.24 23.51 18.12 19.04 18.78 19.61 

9 18.18 17.20 22.16 22.48 29.56 26.41 21.96 23.54 16.09 16.32 18.01 19.35 

10 15.00 16.14 17.18 17.75 14.42 12.01 23.25 17.78 7.48 8.46 17.95 17.43 

11 8.32 11.93 16.06 14.82 17.95 16.32 16.77 13.51 14.14 16.63 15.20 15.60 

22 12.33 8.40 8.46 11.56 20.10 9.95 9.92 13.85 17.26 16.63 14.02 18.81 

23 15.37 14.14 9.78 10.41 17.98 12.73 14.54 11,27 11.18 14.22 9.72 11.96 

24 14.54 12.96 9.15 14.11 17.63 15.86 8.80 12.50 11.15 12.01 10.49 10.21 

25 12.16 9.98 12.50 13.91 14.22 13.48 11.30 13.88 12.99 14.34 11.73 12.13 

26 17.00 12.73 11.90 15.77 16.29 11.99 12.99 20.65 15.28 17.81 12.36 13.45 

27 14.14 10.84 20.13 15.74 15.37 10.78 20.99 22.88 16.80 16.46 15.48 14.11 
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Appendix F 

Position KYpori - S7 

Technique A 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5228 3852 5276 38.29 5283 46.89 5268 47.22 51.69 4529 51.87 4514 0.00 0.00 0.00 0.00 53.96 39.74 54.26 39.83 50.30 28.87 50.52 28.83 

7 58.15 33.21 5834 3289 60.58 4219 60.39 4257 58.28 40.24 58.28 40.23 54.23 37.93 54.32 37.78 61.00 37.67 61.45 37.52 57.16 2292 56.80 23.35 

8 66.24 29.18 6625 29.36 65.09 37.47 65.33 37.94 65.00 34.20 64.88 33.91 6289 34.02 63.07 34.22 66.48 33.76 6674 33.73 64.63 1844 64.37 18.80 

9 75.96 29.41 75.66 29.58 74.05 37.68 73.59 37.92 73.66 34.99 73.29 34.26 70.22 3294 70.27 33.07 73.42 33.51 73.87 33.54 74.90 1831 74.82 1830 

10 8239 33.61 8211 33.86 79.57 4243 79.30 4278 81.85 38.91 81.89 39.05 78.62 35.65 79.14 35.54 80.82 36.47 81.20 36.45 8264 2246 8274 2241 

11 8800 39.64 87.68 39.76 86.62 47.00 86.43 47.36 87.97 4353 88.04 4358 86.37 38.27 86.17 37.% 86.06 39.70 8642 39.76 88.43 27.74 89.41 28.06 

22 80.59 104.74 80.07 105.90 85.37 100.55 8521 100.84 87.17 99.25 87.20 99.34 83.93 103.66 84.23 103.69 8590 100.43 8535 101.62 8279 11593 8251 116.92 

23 75.42 10854 75.24 10859 80.87 99.77 80.88 100.12 8218 10204 8220 10201 78.40 106.39 78.49 106.30 79.82 104.27 80.33 104.27 7623 119.34 7622 119.23 

24 69.00 110.38 68.32 110.46 75.66 10210 75.84 10248 76.57 10527 76.65 105.18 7249 107.27 7281 107.28 74.31 10622 74.65 10618 70.39 121.24 70.42 121.13 

25 63.99 109.54 63.68 109.72 69.92 101.74 69.79 10212 7212 104.21 7208 104.19 66.92 107.46 67.22 107.46 69.40 10639 69.66 10634 64.34 120.75 64.34 120.68 

26 57.17 107.78 5667 107.86 65.28 98.92 65.02 99.34 66.10 103.77 66.28 103.91 61.07 106.45 61.49 106.43 64.50 104.42 64.76 104.39 5841 118.55 5850 118.54 

27 5248 103.87 5212 104.10 59.71 97.14 59.79 97.83 60.13 101.79 60.09 101.72 55.43 105.18 56.27 10589 5838 101.73 5875 101.76 51.28 114.94 5202 11584 

Technic u c B 

Tooth 
# 

Cast A CastB Cast C CastD Cast E CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 3625 23.19 36.33 2280 34.82 3251 34.86 3254 31.68 29.26 31.66 29.31 0.00 0.00 37.07 19.36 35.03 47.67 35.21 47.87 33.1 11.56 33.24 1226 

7 4244 17.28 4250 17.17 4263 27.69 4258 27.71 37.91 24.27 37.84 24.54 37.43 17.85 45.34 15.67 43.13 44.46 4293 44.93 39.95 633 40.08 680 

8 49.85 1364 50.24 1365 47.82 23.14 47.79 2515 44.43 1822 44.55 1822 45.55 14.32 53.44 14.61 48.05 41.05 4806 41.04 4810 1.47 48.29 1.85 

9 59.46 13.73 59.54 13.73 56.74 23.17 56.66 2518 54.33 1886 53.75 1875 5569 1318 61.61 17.33 55.40 40.63 55.68 40.74 57.95 1.18 57.75 1.52 

10 6629 17.83 6651 17.75 6207 27.78 6211 27.82 61.70 2283 61.64 2288 61.86 1593 69.02 19.92 6255 43.64 6255 43.67 6620 548 66.46 591 

11 7221 23.69 7218 23.70 69.60 3248 69.36 3247 67.75 27.13 68.30 27.85 69.32 18.52 66.35 85.54 68.18 46.92 68.18 46.85 7271 10.47 71.91 10.46 

22 64.83 89.93 64.95 90.01 68.45 85.42 68.19 8560 67.66 8270 67.50 8295 66.71 8429 60.99 87.85 67.21 10&46 67.33 10856 6671 9882 66.72 98.87 

23 59.55 9269 59.45 9281 63.35 84.75 63.2 84.91 6230 8542 62.17 8573 61.57 8668 55.43 88.67 61.50 111.58 61.43 111.68 59.79 101.7 59.75 101.94 

24 53.20 94.57 5327 94.39 57.82 87.02 57.84 87.37 56.71 88.89 56.78 89.12 55.88 87.16 50.02 88.99 56.08 11555 56.18 11348 5398 103.65 53.81 104.02 

25 47.89 93.46 47.82 9366 5220 86.83 5216 87.12 5200 87.59 51.95 87.76 50.17 87.54 44.34 87.89 50.64 1154 50.53 113.33 47.95 103.18 47.% 103.45 

26 41.64 9212 41.71 9219 47.51 83.94 47.32 84.30 45.55 8692 45.82 87.14 44.60 8653 38.43 87.14 44.98 111.21 44.95 111.41 41.62 100.68 41.78 101.02 

27 3685 87.63 3658 87.49 41.% 8205 4227 8239 40.24 8578 39.73 84.67 38.61 8588 37.07 19.36 39.48 10892 39.48 10878 34.88 97.63 3529 98.14 
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Appendix F 

Area Data Report - S8 
Technique A 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 8.26 8.11 10.09 11.76 11.47 10.78 0.00 0.00 8.80 10.58 9.84 11.76 

7 7.66 8.69 12.65 14.37 9.43 9.12 15.05 15.40 5.79 5.62 9.09 9.46 

8 14.11 13.79 14.88 14.71 12.99 12.53 17.23 17.75 12.04 12.56 14.39 18.35 

9 9.29 9.72 14.91 13.65 18.92 18.78 14.62 16.63 12.13 14.11 14.77 16.11 

10 8.77 8.75 9.69 9.63 8.09 8.77 14.68 16.17 4.07 4.13 9.81 10.64 

11 11.01 10.27 11.81 13.39 15.57 11.78 14.42 13.91 9.15 11.35 15.28 13.39 

22 9.00 8.89 3.18 11.04 9.84 9.86 12.30 13.08 8.60 7.71 13.82 16.11 

23 8.23 8.23 5.62 10.24 8.23 8.14 8.72 9.69 5.73 5.71 8.83 9.00 

24 6.25 7.00 8.86 9.20 9.41 9.12 7.03 7.94 4.30 4.59 8.20 7.37 

25 6.19 5.62 9.29 8.34 8.26 8.14 7.66 8.09 4.70 4.76 7.34 8.43 

26 5.85 6.11 9.43 9.09 8.34 8.26 6.94 9.00 6.51 5.51 9.09 9.23 

27 9.95 6.14 11.76 10.29 7.57 10.41 9.35 9.49 7.63 8.32 13.39 11.87 

Technique B 

Tooth # Cast A CastB Cast C CastD Cast E CastF Tooth # 
1 2 1 2 1 2 1 2 1 2 1 2 

6 12.53 11.67 13.59 12.19 12.30 15.91 12.30 0.00 13.28 9.95 12.65 16.06 

7 13.19 11.87 17.66 17.15 13.05 13.33 19.21 19.73 12.56 11.33 15.89 13.76 

8 20.87 20.19 19.56 21.36 19.04 19.13 26.38 25.66 18.87 13.68 17.52 17.72 

9 15.77 15.83 21.91 21.45 23.83 24.37 21.82 20.93 15.14 12.04 18.41 17.46 

10 13.91 14.25 17.03 18.92 14.65 13.56 22.82 23.43 8.40 8.49 15.97 16.63 

11 12.67 12.87 11.76 10.06 16.54 15.28 17.58 15.60 20.27 12.33 10.32 14.60 

22 11.01 8.17 11.90 8.57 10.84 9.18 12.33 10.29 12.62 12.30 9.03 7.97 

23 12.99 13.48 10.87 10.55 15.34 11.58 14.74 13.82 11.76 10.58 10.18 9.78 

24 11.76 10.98 13.16 12.85 15.68 13.62 11.96 11.61 11.35 7.31 10.09 9.46 

25 10.67 10.75 13.08 12.24 13.96 11.10 11.30 12.30 10.47 9.18 12.24 11.33 

26 12.70 11.90 6.65 6.85 14.22 1244 14.45 13.99 12.85 9.18 12.50 11.64 

27 15.51 10.70 9.18 9.15 11.18 9.15 10.35 7.83 16.60 12.93 9.95 8.43 
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Appendix F 

rWi . ,11 Usu.1 Report-SS 

Technic ue A 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 Tooth 
# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 5268 3848 527 3812 53.88 46.02 53.84 46.44 5291 44.76 5266 44.90 0.00 0.00 0.00 0.00 54.12 39.52 54.52 39.47 50.65 2858 50.82 2882 

7 5894 3275 5860 3266 60.07 41.98 60.27 4212 57.98 40.64 57.93 40.68 54.07 37.82 54.05 37.83 60.92 37.61 60.87 37.64 56.43 2130 56.74 23.39 

8 66.46 29.39 66.14 29.00 65.72 37.42 65.86 37.58 64.94 34.27 65.01 34.24 6248 34.17 6247 34.17 66.13 33.86 66.27 33.92 64.11 1871 64.95 19.03 

9 75.43 29.42 75.66 29.12 74.27 37.39 74.26 37.51 73.71 34.94 73.69 34.96 70.44 33.00 70.50 33.07 73.84 33.50 73,30 33.89 74.15 1856 74.52 18.79 

10 8262 33.92 8246 33.49 79.92 4222 79.% 4226 81.72 3898 81.78 39.06 78.62 35.84 78.63 35.83 80.79 36.60 80.93 36.71 8221 2246 8253 2261 

11 87.76 40.00 87.84 39.67 86.42 46.67 86.28 46.61 86.65 4329 86.95 43.14 86.04 3878 86.03 38.70 85.71 39.59 86.03 39.94 8818 27.92 88.59 28.00 

22 80.73 104.81 80.73 104.44 85.28 100.31 85.48 99.% 87.22 99.11 87.22 99.30 83.90 103.86 83.78 103.93 85.50 101.29 85.30 100.78 8244 115.84 8268 115.92 

23 75.53 10851 75.56 10817 81.25 99.27 81.33 99.80 8217 101.85 8214 10204 7822 106.48 78.05 106.57 79.44 104.15 79.79 104.10 7S89 119.14 76.17 119.17 

24 69.19 110.36 69.43 109.99 75.64 101.78 75.82 101.89 76.66 105.13 76.61 105.14 7242 107.42 7250 107.4 74.09 106.18 74.14 106.30 70.10 121.10 70.43 121.17 

25 64.12 109.52 64.13 109.21 69.96 101.58 69.94 101.48 71.92 103.88 71.95 103.89 66.90 107.62 66.90 107.62 69.13 106.32 69.13 106.33 6195 12074 64.35 120.70 

26 57.47 107.77 57.41 107.35 65.13 98.73 65.35 98.76 65.62 103.32 65.88 103.46 60.99 106.75 61.13 106.57 64.11 104.13 63.89 104.17 5806 118.37 5836 118.39 

27 5218 103.53 5297 103.56 59.96 96.47 60.10 96.60 60.24 101.90 60.22 101.70 55.65 105.56 55.66 105.56 5801 101.56 57.94 101.47 51.30 114.94 51.45 114.67 

Technique B 

Tooth 
# 

Cast A CastB Cast C CastD CastE CastF 
Tooth 

# 1 2 1 2 1 2 1 2 1 2 1 2 
Tooth 

# 

X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y X Y 

6 37.30 1885 36.48 2255 34.73 31.56 34.76 3241 3208 2822 31.81 29.02 30.61 1801 0.00 0.00 35.15 47.02 35.56 46.48 3148 1133 33.35 11.75 

7 4284 14.23 4244 17.25 4266 26.49 4243 27.76 38.15 24.10 38.00 24.54 37.36 17.95 37.69 19.04 4273 44.79 43.10 44.53 4028 825 40.50 6.01 

8 50.10 10.94 50.13 13.63 48.09 2204 47.95 23.15 44.90 17.93 44.72 18.10 45.61 14.36 45.42 15.61 47.83 41.03 47.68 40.88 4803 3.44 48.05 1.42 

9 59.15 11.05 59.40 13.72 56.73 21.98 56.71 23.14 53.71 1845 53.86 1878 53.68 13.17 53.63 14.39 55.33 40.69 56.16 40.39 57.87 115 57.97 1.16 

10 66.35 15.24 66.35 17.92 6210 26.60 6219 27.% 61.70 2285 61.65 2294 61.73 16.10 61.77 17.42 6216 43.50 6257 43.67 66.59 7.57 66.44 5.57 

11 71.96 21.45 7200 23.74 69.80 30.73 70.05 31.% 67.73 27.02 67.% 2735 69.22 1856 69.15 19.82 65.90 46.20 6807 46.19 7239 11.83 73.29 10% 

22 64.83 87.37 64.80 90.48 69.01 85.17 68.43 86.82 6833 83.03 67.92 84.15 67.76 85.17 67.79 86.60 67.31 10851 67.61 ioao5 66.49 101.33 66.13 99.71 

23 59.55 90.07 59.49 9273 63.63 83.87 63.76 85.18 6221 85.44 6217 85.79 61.53 86.71 61.31 88.00 61.32 111.45 61.63 111.40 59.86 103.73 59.90 101.66 

24 53.22 91.89 53.09 94.63 58.04 86.40 58.01 87.35 56.77 8879 56.64 89.01 55.82 87.47 55.40 88.76 55.95 113.54 56.34 11159 5189 105.70 53.74 10170 

25 47.82 91.09 47.89 93.68 5221 86.17 5227 87.31 51.95 87.61 51.90 87.92 50.12 87.6 49.97 89.16 50.89 113.72 51.01 113.68 47.83 105.18 47.79 103.25 

26 41.36 89.34 41.37 9207 48.31 83.71 48.24 84.77 45.16 86.55 45.46 8714 44.09 86.64 44.28 88.20 45.55 111.61 45.51 111.37 41.60 10283 41.76 100.84 

27 35.79 84.800 36.10 88.46 4217 81.99 41.33 8270 39.06 85.79 39.53 8629 38.64 86.33 38.91 88.46 39.58 108.90 39.53 10867 35.10 100.41 35.06 98.51 
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